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RMS Report Writing

Examples for designing custom report in RMS

by RMS Support Center

RMS uses the Report Builder report writing tool to allow
users to design customized Reports using RMS data. This
banded report writing tool is flexible and powerful, but
requires patience and skill.

This document contains many examples of reports that
illustrate interesting and powerful ways to access and
display RMS data using the report writer. Step through the
example one by one in order to get the most out of this
document
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1.2

Example 1 - RMS Program Type

Overview

This report is designed to be very simple. It is an introductory report to show how easy it is to build a
simple single table report in Report Builder. It shows how to use some of the basic report designer

tools. If you've never used the RMS report designer before, this is the place to start.

- RMS Program Types

8/4/2007

CIV-CiEhd
CON-GEN
DERP
EXEMPT
FC&CE
FUSRAP
IRAG
HAIL- b
Rl COR
MRET
SFO
WFO
AMA
ARP
CERP
BMICHP
GWOT
UZAID

Skills shown:

Civil-Cperation and Maintenance

Civil-Construction General

Defenze Environmertal Restoration Program

Exempt

Civil-Flood Control and Coastal Emeraencies
Civil-Formerly Ltilized Sites Remedial Action Prodram
Irad Reconstruction Activitiss

tilitary-Cnerstion and Mairtenance

tdilitary Construction

Civil-Miszsissioni River and Tributaries

Suppart for Cthers

Work for Cthers

Afohan Mational Army

Afohan MNational Police

Cammanders Emergency Response Procramm

Border Manacement Intistive/Counter Marcotics Proaram
Global War on Terror

LS Aid

- Report Builder basics

- Single table query

- How to use the designer

Step 1 - Add the Report

From RMS select File > Utilities > Custom Report Designer - RMS

You should see the RMS Report explorer screen similar to what is shown below:

= - E o E
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RMS Report Explorer [ DC_RMS.WORLD: ]
File Wiew Help

= i EE Launch ISGL x
All Folders Contents of L1COHEGHReport Class |n Progress ,
—1-42% Al Folders Contract Data Sheet
—-42% L1COHEGH 5
b | i eport Clazs In Progr
[ ReportClazs
ﬁ} Recycle Bin .p‘
|
=
Tl g m— ’
"m__.*

A few points to be made about the report explorer. By default, you will be working in your own folder
indicated by your login ID. Nobody else (other than systems people) has access to your folder so you
can design reports and keep them for your own use. If you have a report that you want to publish to
everyone, either, move it, or copy it into the root folder "All Folders" and it will show up on the report
menu in RMS. Once its in the "ALL Folders" folder, RMS users can easily run the report without
knowing anything about the report designer itself.

To add a report, right click on the right hand window pane of the report explorer and select New
Report. The report designer will load with an empty report - ready for you to start your design.
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10 RMS Report Writing
L

RMS Report Designer [ DC_RMS.WORLD ]: New: F@_\ort
File Edit Wiew Report Help

Data I Calc: Design | Previewl (
h  AlEnEEte| a0 | ARERERe™ 8003

| | [ =i X Bzu (=EEE- [A-4-| @

-f-==|BE =@ 88 or BPed Ted wd | WME DSH D&
L T S A S A N A
Before you do anything else, select File > Save As and give your report an appropriate name - In this
case, use "RMS Program Types"

1.3 Step 2 - Create the Query

The hardest part of creating most reports will be getting the data and structuring it just right for the
report you want to create. Every report will have at least one query, but may have many queries that
can be linked together in master-detail fashion. Each query may itself, be a join of many underlying
tables in the RMS database. For this report we will be keeping it very simple and we will create one,
single table query to get the data we want.

All of your query work will be done on the data tab in the designer. From the report designer, switch to
the "Data" tab

USACE
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RMS Program Types: RMS Program Types

Diata ]Calc: ] Design] Preview]

‘.__'J .
P

Now, select File > New and you will see that you have two options:

o ;

(e

Designer /

. n

"‘u_"-'h‘_-

The query wizard is a simple way to create a query, but it is limited in its options. The query designer
takes you straight into the screens that will allow you to build your query. For all remaining examples,
we will use the query designer, but for this simple report, select the Query Wizard and click Ok. You
will see a list of all available tables in the RMS database. Scroll down and select PROGRAM_TYPE,
then click on the right facing arrow to move the PROGRAM_TYPE table into the Selected Tables list,
then click Next.
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Query Wizard

Select the tables that pou want to query.
/

Available Tables Selected Tables
PLACEMEMT_SCHEDULE_BAK. A

FRALC M

FPRIME_KTRS

PROGRAK_FUNDING g
PROGRAK_FUNDIMG_SCHEDLUILE g

PROGRAM TvPE

FROJ —
FROJECT_DELIWERY_TEAM

(& DELETELOG
(as_CURREMT_REQUEST

LATEST

QC_REQUIREMEMTS 3 |
Cancel Memxt »

For this report, we want all of the fields from the table so select
All Fields and click Next.
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Example 1 - RMS Program Type 13

Query Wizard

Select the fields for the querny.

v Al Fields (" Choose Fields

Cancel < Back Finizh

We don't need calculations, grouping or special ordering for now, so just hit next until you get to the
last screen of the wizard, then click Finish.

USACE



14 RMS Report Writing
Query Wizard k
Y'ou have finighed defining pour query.
i Please enter a dezcription of your quer.
M arne
FROGRAM_TYFE
Do wou want ko preview your guery or modify your queny's
design’?
f* Return to data workspace
™ Preview the query
(" Maodify the quen's design
< Back Finizh
When the wizard finishes, you will be returned to the Data tab - Click on the preview button of the
guery to see what data your query returns
RMS Program Types: RMS Program Types
File
Data lEaIc ]E)gsign_]_Prevm]
" Preview Button —
PROGHE - —
(& meE s
Marmne | Type | Size
[[J DESCRIPTION Sting 100
[f] FROG_TYFE  Sting 8
[f] SHOW_RECOR Sting 1
1.4  Step 3 - Design the Report Header

Switch back to the Design Tab. Notice that the report is divided up into three sections

Header
Detail
Footer

USACE



Example 1 - RMS Program Type 15

These are called bands. The report builder tool is a "Banded" report writer and it uses bands to control
the design of the report. In this step, we will be working on the title of our report so we will use the
Header band

RMS Program, Types: RMS Program Types
File Edit Yiew Repart Help

Data I Cale  Design | Previewl
h | ABEuEE| A5 | ARERTRG® (B0 @
[ || [aial ~|fE x| B 1 U |

.......... B =mm | B8 | ow|Ea&S | Tl | o

- A-s- 9B n
Dl mESE | $E

et

e

Lets try to make our header look like a standard RMS report with the USACE castle and report title. To
insert the castle, select the image button from the toolbar

RMS Program, Types: RMS Program Types
File Edit Yiew Repart Help

Data I Cale  Design | Previewl
h [ AEEueatel aon  ATTELRR® | E0R B
~Im < mzu

|
& & | W ool | oo &
. N

- A-s- 9B n
Dl mESE | $E

ol

e

" Faater

Now, click in the header band and an image item will be inserted. Right click on the image and select
Picture from the menu and then find your favorite version of the USACE castle to insert.
(Get a castle here)

USACE
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RMS Report Writing

RMS Program, Types: RMS Program Types
File Edit Yiew Repart Help

Data I Cale  Design | Previewl

h | ABEuEE| A5 | ARERTRG® (B0 @

| ~JiE Z|Bru === |A-2- | 9H| T
S-S == 2 | el | mSk | %E
S L B A

o e

_EEEEE.ZZZZ:]ZZZZZZZZZZZZZZZZ

ptHeader

B

:E‘:F:D:Dt.e[ ........................................................................................

Size and Position your image

RMS Program Types: RMS Program Types
Fle Edit Yew Report Help

Data IEaIc DESiinF’reviewl
h  ABZneEt|l a0 AEERTELD® | EERE
x| B I O

|
B &S | Wbl | oo

- 10o | bl

= A-2-13vHE | B

ME Dl m&k | &8
U P

* Detail
o)

" Faater

Next, we will add a title and a line underneath it. Select the Text button (The letter A) from the toolbar
and then click in the header band. Click in the text box and change the text to say RMS Program
Types.
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Example 1 - RMS Program Type 17

RMS Program, Types: RMS Program Types

File Edit Yiew Repart Help

Data ICalc DJTextButton

b | A meate 5 REINL0%% 00QO

e i E[E Zipzy EE=- [A-2- 0@ |0
— — na»ug'“l%-$-?=.||ﬁnﬂ-nﬂ_l|m.,§,|IHDIE“D@‘E|“§&|%E

|4 I I

" Faater

Click on the line button and then click on the header band and a line object will be inserted - size it
and position it in the header band

RMS Program, Types: RMS Program Types

File Edit Yiew Repart Help

Data IEaIc DESiinF’reviewl /;
h | AEEuEE | G0 | ARERTRG® (B0 @
-l mzu A-2- | vHE |
& & | W oo | o 2 el | mSk | %E

et

Line Buttan

Finally, lets insert the date as part of the header. To do that, click on the System Variables tool and
then click in the header band. The System Variables allow you to get to things like the date, time,
document name and so on. It defaults to the date so just size and position your object on the right side
of the header band.

USACE



18

RMS Report Writing

1.5

RMS Program, Types: RMS Program Types
File Edit Yiew Repart Help ,W

Data I Cale  Design | F'rewewl
PN EE T 1 ae E|I§|l§%@%%|laa|
<l Bzu | == A-2- 9@ |G

B & S | ookl | ote 2 | Jul

" Faater

We could make the header a little more elaborate, but we will leave it as is because in the next
example, we will learn how to use some pre built templates that already have the header bands built
for both portrait and landscape reports. At this point, the header band is complete. You can click on
the Preview tab and look at your report.

Step 4 - Design the Detail Band

Now we'll connect our query to our detail report and start printing some actual data.

Put three DBText objects in the detail band and set the table name and fieldname to the three
available fields from our query. Also, position the DBText objects, size them, and set the font as you
like. Resize the detail band by dragging it upward to make it smaller.

RMS Program Types: RMS Program Types
Fle Edit Yew Report Help

Data IEa|C DESiinF'reviewl JDBTB”“
b ABEnEEte |l aom AT iR Ea® ™ EDS B
|PF|DG TYPE v ||PROGR&M_TYFE J“|Ana| ~IE j BzuU

|
<D & mrﬂl_rmtl“m T e o |nuo§ |.,u| HD@E
—_— ——

Save the report and then preview it and you should see all of the available program types from the
RMS database.
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1.6

Summary

This report is not very polished and we did it the hard way by making the header from scratch.
However, it is a good example of how to get started with the report designer and how easy it is to build
a simple report. Now that you have built the report, you can run it directly from the explorer without
having to go into the designer. To change the design, right click on the report in the explorer and
select design, to run it without the designer, double click on it in the designer
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2.1

Example 2 - Standard Templates

Standard Templates Provided

We have provided several standard template files to make building reports easier and more uniform
for you. Use these templates whenever possible to save time and give your reports a standard look.

You can load these up in an empty report and see what they look like. This is what the standard
Portrait template looks like:

RMS Report Designer, [ de_rms.world ]: NewRe pEx4
File Edit Yiew Report Help

™ Detail

" Footer

Data I Cale  Design | Previewl

h | AEEnBEt |l AE |AREREGRe®  EOR @

| | [aia a2 dlmzu | =s=== |A-2-| 308 |
H.d-m=BE =@E &8 o Eésd Toeo | e WE DSH DSR
Bo ' TR ' R R 't S e T

Left: 0 Top: 0 [width: 0 Height: 0

Ready,

A

Basic Templates

RMSPortraitTemplate.rtm
Generic portrait report with no dataviews loaded

RMSLandscapeTemplate.rtm
Generic landscape report with no dataviews loaded

Templates with a Contract DataView

RMSPortraitTemplateWithContractQuery.rtm
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Portrait template with a contract query selecting basic fields and sorting by
FMT_CONTRACT_DELIVERY

RMSLandscapeTemplateWithContractQuery.rtm
Landscape template with a contract query selecting basic fields and sorting by
FMT_CONTRACT_DELIVERY
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RMS Report Writing

3.1

3.2

Example 3 - RMS Program Types (redone)

Overview

In this report we will create a list of program types from RMS just as in example 1, but we will use a
pre built template to make things easier and more standardized. Also, we will add a few minor
embellishments like interpreting a field value of Y or N to display Yes or No and add some dynamic
coloring as well. We will also sort our data in the query designer. Finally, we will use this report to
demonstrate many of the shortcuts that the designer has to make sizing, positioning and aligning
controls easier and more uniform.

il
U8 Aoy Corpo RMS Program Types 04 Aug-07
of Englneers.

Program o Included in

Type Description Lookup

A4, Afghan Mational Lemy Yes
AP Atfghan Mational Police Yes
BMICHP Border Management Initistive/Zourter Marcotics Program Yes
CERP Commanders Emergency Response Program Yes
CIV-03M Civil-Operation and Maintenance Yes
COMN-GEN Civil-Construction General Wes
DERP Defenze Environmental Restoration Program Yes
EXEMPT Exempt Yes
FC&RCE Civil-Floodd Cortrol and Cosstal Emergencies Yes
FUSFAP Civil-Formerly |tilized Sites Remedial &ction Program Yes
GWOT Global War on Terror es
IRAG Irag Reconstruction Activities Mo
Il -Cr&h ilitary-Cperation and Maintenance Yes
MILCOM Military Construction Yes
MRET Civil-Mizzizsippi River and Tributaries Yes
SFO Support for Cthers YYes
US4 S L YWes
WFO Wark for Cthers ills}

Skills shown:

- How to Load a Template from a file

- Using the query designer

- Using the designer to help with object positioning, alignment and sizing

Step 1 - Load up the Standard Portrait Template

In example 1, we started with an empty report and created a header on our own, This time, we'll get
smart and load our basic report format from an existing file that contains all of the essentials for
building a new report.

Create a new report and save it using Save As - Give it a name of "RMS Program Type Listing"
Once the designer comes up, make sure you are on the design tab and then select File > Load From

File and then find the RMSPortraitTemplate.rtm file. When the file loads your designer should have an
empty report with a standard header and footer.
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3.3

RMS Program Type Listing: RMS Program Type Listing
File Edit Wiew Report Help

Data I Calz  Design | Previewl
h | AfEuaatl aon| A8 EBund® | 003
I EARVE

& & | Wl | oo

This is much smarter than starting from scratch every time and it helps to give the reports a common
look. The only change we need to make this time is to change the report title. Click on the text object
for the title and change it to "RMS Program Types". Save the report.

RMS Program Type Listing: RMS Program Type Listing
File Edit Wiew Report Help

Data I Calz  Design | Previewl

b ABEn@EE| dor| | ATEBE0R® | Aa0RE

RMS Program Types ._4’“9@ L”‘IB ;I|,?I u |§§E§ |évé’v ‘ £ [ | ﬁ!i|
B.d-m= 0§ | @ et Eaa | Tew g | dE

15 | - S S - S [ L

= U ArmyCetps  BonosismeooeeSTag o )LAugdl
[ of Englneers::

Step 2 - Create the Query

Click on the Data tab and then select File > New from the drop down menu. Select Query Designer
and click Ok

The query designer will be displayed and will show a list of all available tables in the RMS database.
Scroll down and select the PROGRAM_TYPE table and move it into the selected table list
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R Query Designer |:”E”X|
Tables | Fields I Cale:s | Gru:uupl Searchl Sart I SOL I
Awailable Tables

Table | Table Hame | |
PC_PHASE PC_PHASE

PHASE PHASE

PLACEMEMT_SCHEDULE PLACEMEMT_SCHE

FRALC FRALC

FRIME_KTRS FRIME_K.TRS

PROGRAM_FUNDING FROGRAM_FUNDI
PROGRAM_FUMDING_SCIPROGRAM_FUMNDII

FROGRAM_TvPE FROGRAM_TYPE

FROJ FROJ

FPROJECT_DELMWERY_TELPROJECT _DELIVEF

LA _DELETELOG GA_DELETELOG 3
QA5_CURREWT_REGUES QAS_CURRENT_R 3
GLATEST LATEST

QC_REGQUIREMEMNTS QC_REQUIREMEN

GLCC_DELETELOG GCC_DELETELOG

LICC_SETTIMNGS LICC_SETTINGS

LC_ACTMITY_DESC GHCI_ACTIVITY_DE!
QC_ACTMTY_PAY_HISTIGCI_ACTIVITY_Pasy

QCL_ACTITY QA QCL_ACTIVITY QA

QCL_ACTIITY _SCHEDULEQC_ACTITY _SCH

QC_EID QC_EID

QCI_CONTRACT QC_CONTRACT 3
Selected T ables [ Distinct
Table | Table Mame | 50U Alias ' Join Type

FROGRAM_TYPE PROGRAM_TY.. FROGRAM_TY..

0K I Cancel

Click on the Fields tab and move all three of the available fields into the Selected Fields list.
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R Query Designer.

=1ES

Tables Fields ]Edcs] Gmup] Semchl Sart ] SAL ]
[Al Awvailable Fields
Field Alias | Field SOL Alias | Table SOL Alias |
Selected Figlds [v All Fields
Field Aliaz Field SOL Aliaz Table SOL Aliaz
DESCRIPTION FROGRAM_TY... PROGRAM_TY...
PROG_TYFE PROGRAM_TY... PROGRAKM_TY .. -
SHOW_RECORD PROGRAM_TY.. PROGRAM_TY..
i
0K, | Cancel |

We wont do any calcs, grouping or searching, but lets sort the data by the code used for each
program type. Click on the Sort tab and move the PROG_TYPE field to the Selected Fields list
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3.4

R Query Designer. E|r>__(|
Tal:ules] Fields ] Calzs ] Gru:uup] Search  Sort ISDL ]

21 Awailable Fields
Field Alias | Field SOL Alias | Table SOL Alias |

DESCRIPTION ~ PROGRAM_TY..  PROGRAM_TY...
‘SHOW _RECORD | PROGRAM_TY.. PROGRAM_TY...

Sort Fields [ Matural Order

Field Alias Field SCL Alias Table SOL Alias Dezc(z > a)
FROG_TYPE FROGRAM_TY... PROGRAM_TY...

|
=

0K, | Cancel |

Now we have our query with all of the data we need and it will be sorted by code. Click Ok to close the
query designer

Step 3 - Add DBText controls to the Detail Band

Switch back to the detail band and put three DBText controls in the detail band. Connect each one to
the appropriate fields using the Table and Field drop downs.

DON'T SIZE AND POSITION THE CONTROLS YET - WE WILL SHOW SOME SHORTCUTS ON
HOW TO MAKE IT EASIER
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3.5

RMS Program Type Listing: RMS Program Type Listing
File Edit Wiew Report Help

Data IEaIc DESiinF'reviewl
h | AdduEatl g oA ERune® |00
] [PROGRaM_TYFE RIEE EIE = | B

2 | wewm ol | i E |
e o

SO~

[ R PR e

oD o T Pt BESCRIETION ‘ .................................................................

1

* Header

L SetDBText 1 field
et ext 1 field ta gt
L FROG_TYPE Page {

* Footer

Object: DEText3 Left: 2,1979 Top: 0.0104 ‘Width: 0,6771 Height: 0,2125 A

Step 4 - Multi-Selecting and changing properties

The DBText objects that we inserted for our data probably defaulted to the font that we used for the
report title. Obviously we want a smaller font. Rather than selecting each object and changing its font,
you can select all three and then change the fonts all in one step.

To start off with nothing selected, click on the background of on of the bands so that nothing is
selected.

Ways to multi-select:

1) Hold down the Shift key and click each control one at a time.

2) Lasso all three of the controls by left clicking with the mouse and then dragging to form an
enclosing lasso around the three DBText items.

Once all three of the objects are selected, change the font to arial 8 and get rid of the bolding. You will
see the actions work on all of the items selected.

While you have the items still selected as a group, move them around by clicking on one of them and
dragging them - they will all move as a group.
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3.6

RMS Program Type Listing: RMS Program Type Listing |:||E|EJ
File Edit Wiew Report Help

Data I Cale Design | Previewl

h | AdduEatl g o/ A8ERR0e® |00

[ HPM| ~fa - Bzru | ==
& - == 8 | @w||Bsa | ol | wed ||

4 5 & 1
o PR RO MO [P B M B O

_ . U8 Army Cor|
- -of Englneers.

Page 1

Objects: 3 Left: 05937 Top: 0.0417 ‘Width: 2.5833 Height: 0.1563 A

Step 5 - Micro moving and Micro Sizing using the Keyboard and
Mouse
You can fine tune the position of the controls by using the ctrl key and the arrows on the keyboard. To

do that, make sure you have the appropriate controls selected and then hold down your control key
and move them around with the arrows on the keyboard.

Note that if you hold down the shift key instead of the control key, then the arrows will change the
SIZE of the selected objects - You can increase or decreases the hight and width of controls this way.
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3.7

RMS Program Type Listing: RMS Program Type Listing
File Edit Wiew Report Help

31

Data I Cale  Design | Previewl
h | AdduEatl g o/ A8ERR0e® |00
= S Bru

Page 1

Objects: 3 Left: 05937 Top: 0.0417 ‘Width: 2.5833 Height: 0.1563 A

You can also use the Nudge buttons to control the micro positioning of the controls. With some objects

selected, just click on the appropriate Nudge button on the toolbar.

The nudge controls are on the toolbar:

Step 6 - Aligning Objects

When you put objects inside of a band, you usually want to align them in some way. For our example,
we want our DBText objects to be aligned so that the print on the same row across the page. You can
align them manually using the mouse or keyboard, but the better way is to use the alignment buttons

on the toolbar.

B & & | T o 0 |

These allow you to quickly and accurately align items. With your 3 DBText items selected, click on the
Align Bottom button and your objects will be perfectly aligned. Some other interesting options are

center in band and evenly space. Experiment with those options.
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3.8

3.9

RMS Program Type Listing: RMS Program Type Listing
File Edit ‘iew Report Help

Data IEaIc DESiinF'reviewl
h | AdduEatl g o/ A8ERR0e® |00

S| BzU [==== A -2- @ | W%
& 5 | oo = = I v = =

Objects: 3 Left: 0,4687 Top: 0.0208 ‘Width: 2.6456 Height: 0.1354 A

Step 7 - Size and Position the DBText Items

Use the designer features to size and position the DBText objects as shown below:

RMS Program Type Listing: RMS Program Type Listing
File Edit ‘iew Repart Help

Data I Calc  Desian | Previewl
h | AHEuBEt|l Ao AT R LR ® |08 @
[ || [ ~IE ~ | Bz U |
H.-S-=m= A Z@|u8  ow|Esa Taod  wed
EIP R T R IR

i

= US Ariny Cofps T
T - ofEnglneers.. - - - T

_D
w
.

* Header
S0 BROGLTYPE - BERCRIPTION. - o Lol liiiiliiliiiliiiiiiioliioiooli._.d- BHOW RECCE -
* Detail

* Faoter

Left: 0 Top: 0 wWidth: 0 Height: 0 )

Save your report and preview it to see how the data looks.
Step 8 - Add Column Titles

On the design tab, click the Text button and add a new text object in the header section. Set the text to
"Program Type", right click on the text object, and turn on Word Wrap. Set the font to Bold and select
the Centered Text option from the toolbar.
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3.10

RMS Program Type Listing: RMS Program Type Listing
File Edit Wiew Report Help

Data IEaIc DESiinF'reviewl
h | AdduEatl g o/ A8ERR0e® |00
IF‘rogramType ;I | ’?1 u

|
& & | MW o4l | e g

Qo
* Program

A |

eader

S0 BROGLTYPE - DERCRIPTION - L L L LiiLlLiiillLiliiliL_ll. BHOW RECCER -
* Detail

0

(s
~H

* Footer

Object: Labell

Add column headers for the other two columns. You can use Copy (Ctrl+C) and Paste (Ctrl-V) to
make things easier

RMS Program Type Listing: RMS Program Type Listing
File Edit ‘iew FReport Help

Data I Cale  Design | Previewl
b AEBEuEEte |l A5 AREERRD® (B0 @
| = ~IF “mzsu

& 3 | Wl | e

|
£

0 BROGLTYPE - DERCRIPTION . - L L Ll
* Detail
0

* Footer

Save the report and preview it.

Step 9 - Embellishments for the Y/N column - RAP code

The report is pretty good, but lets add some polish. Instead of just priting Y or N, lets make it print Yes
or No and while we are at it, lets color the No records red so they stand out more. Report Builder
makes this possible by allowing us to write RAP code for events as they happen when the report is
running. This is called event driven programming. All we do is find the appropriate event to use and
then write our rap code.

Click on the Calc tab of the designer. There you will see a tree diagram of your report and its objects.
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On the right hand side is a list of events for the selected object.

RMS Program Type Listing: RMS Program Type Listing

File Edit View Help

Data  Cale lDesign] Preview}

EBEX

B Swstermivanabls2

Fieport Objects Events
= Report [ AftertutaSearchDislogCreate -
= fmd Header [ after0penD ataFipelines
A LfabeIS D AfterPrint
l Lined R DBeforeAuloSealchDiangEreate
%;l lSr::tgzn;Vanable'l D Before0penD ataFipelines
&, D BeforePrint
LB Shapel
A Labell D OnézsignPreviewF omS ettings
A Label? D OndutoSearchDialogClose
A Label D OnCancel
2 Detail D OnCanceDialogClose
TR DBETextl [ OrCanceDiglagCreats ]
X DBText2 [ OrEndColumn
X DBText3 [ OrEndFirstPass
=i Footer D OnEndFage
{il Shapez [ OnEndSecondPass

D OnGetdutoSearchy alues
D OnlnitializeP arameters
D OnMalata

Code Toolbox Data
FPROGRAM_TVPE

\[Diata f0bjects fLanguage

Highlight the DBText3 item in the tree on the left. That's the one for our Y/N column. Next, right click
on the OnGetText event in the Events pane and select New to create an OnGetText event. You
should see a new programming block created where we can now write our event handler.
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RMS Program Type Listing: RMS Program Type Listing
File Edit WView Help

FBX

Data  Calo ] Desian | Freview |
Repart Objects Ewents for DEText3

=[5 Feport [ OnbirawComnmandClick,
- = H)iﬁdffb o [ onDrawCommandCreate
abel i i
| Lined EDnF’nnt
Ba Systerivariablel
= Image2
El Shapel
A Labell
A Label2
A Label3
=) f i Dl
A DBText!
A DBTewt2
»A DBTew3
=J- =i Footer
El Shape2
HE Sustervaniable?

procedure DEText3iOnGetText (var Text: String):; Code Toolbox: Data
begin PROGRAM_TYPE

Text :=

end;

\Data {0bjects fLanguage /

What is happening here is that every time DBText is rendered in the report, this event is fired giving us
a chance to set the text and manipulate the object. To set the text and handle the color, insert this
code into the on get text event.

begi n
i f PROGRAM TYPE[' SHOW RECORD ] ='Y' then
begi n
DBText 3. Font . Col or: =cl Bl ack;
Text :="'Yes'
end
el se
begi n
DBText 3. Font . Col or: =cl Red;
Text := '"No';
end;

end;

Then, right click on the editing window and select Compile. If you did it perfectly, you should see 0
errors.
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3.11

RMS Program Type Listing: RMS Program Types

File Edit WView Help

Data  Calo ]Design]F’review]

Repart Objects

Events for DBText3

FBX

=3 Repor

= == Header
A Labeld
| Lined
Ba Systerivariablel
[ Imags2
El Shapel
A Labell
A Label3
A Labeld

=) f i Dehail
X DBTest

# | 3 OnDrawCommandCiick
D OnDrawCommandCreate

D OnPrint

~

begin

begin

Text = 'Tes'
end
else
begin

Text := 'MNo';
end;
end.

procedure DEText3OnGetText (var Text: String):

if PROGRANM TYPE['SHOW RECORD']='Y' then

DEText3.Font.Color:=clElack;

DEText3.Font.Color:=clRed;

PROGRAM_TYPE

Compile Completed: 0 Errors

\Data {0bjects fLanguage /

Now, preview your report and you should see the Yes No in place of the Y/N and the No records

should all be Red.

Summary

This is a much more polished version of the Program Types report. It was also simpler and it showed

how to use some of the more advanced features of the report writer in simple ways to make a

professional looking report.
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4.1

4.2

4.3

Example 4 - Interest Payments

Overview

This report is pretty straightforward, but does illustrate how to use 2 pass and lookahead for showing
totals in headers before the details are printed. It prints out the interest payments for all contracts and
totals the interest at the contract level and for the entire report.

Al
VS g Cotps Interest Payments 1T-Aug-o7
of Englneers:
Location Current Contract Irvoice Check Nao Check Date Days Late Interast Amount
\ W91238-04-C0030 Site 56.7 Lt, RM 56.7 to 57.1, Sac River $613.04 \
Sacrarnento County, California $8,649 808.18 1 5200170429 1115,2004 3 5513.04
[ W9128A06-C 0005 FY06 OMA Pkg-027 Eleven {11) COF/Arms Rm $590.36 |
Schofield Barracks, Oahu, Hawaii $14,642,231.00 4 4100052575 1/£3/2007 1 $261.90
Schofield Barracks, Oahu, Hawaii $14,642,231.00 4 4100052576 /372007 1 $328.46
[ Wa12DW-04-C0001 Replace Capehart Fam. Housing TITAN Ph 3 §159.04 |
Malrnstrorn AFB, MT $5,191 579.00 15 3400116431 4/4/2008 5 $159.04
[ W912DW-04-C0003 HHD FPF Cofferdam/Exc §5 56,50 |
Howard Hanson Darn, King County WA §22571,821.00 8 3400096545 1A9/2005 23 $2,149.99
Howard Hanson Dam, King County YWA $22 B71,821.00 9 3400097479 2/2/2005 =] $6/6.59
Howard Hanson Darn, King County Wi $22 571,821.00 10 3400095275 3410/2005 8 $352.04
Howard Hanson Darn, King County Y& $22,671,821.00 11 3400100218 44472005 13 $1,4593.00

Skills shown:

- Sub totalling and Grand totalling
- 2 pass logic and lookahead

- Group Headers

- Adding a Summary Band

Step 1 - Load the Landscape Template and Set the Basic Design

Load the standard landscape template. Change the title and add column labels as shown

L UB Ay Corps. | |
of Englneers:

Step 2 - Create the Query
On the data tab, select File > New > Query Designer and click Ok.

Select the CONTRACT table and then the RECEIPT_VOUCHER table from the list. When you select
the RECEIPT_VOUCHER table, you will see the join dialog. Set the options as shown here:
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RECEIPT_WOUCHER.CONTRACT_IDD = COMTRACT.COMTRACT_ID

Bl e et b 0t et e #"’h"‘"‘“’*n. _

On the fields tab select the following fields.

Join Type Join RECEIPT_WOUCHER T able with
| [nner ﬂ ] hC
RECEIPT_WOUCHER Fields COMTRACT Fields
BASE_AMT F ACO_AGENT_CODE -
CERT_PAYMEMT_DATE 3 ACTMWITY YARIAMCE =
CHECE_DATE — ACT_PER
CHECEK_MNUMBER ACT_PER_LESS_STORED
CHECK_PROCESS_IND ACT_PLCMT
COMTRACT_ID ACT_TOT
CURREMCY_CODE AE_ADDRESST
Day'S_LATE AE_ADDRESSZ
DAYS PAID b AE ADDRESS3 s
Joined Fields
RECEIPT_“OUCHER Field Operatar COMTRALCT Field
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R Query Designer |-;||'E|E‘
Tables Fields ]Ealcs ] Grnup} Search] Sort 1 s0L ]
[l Available Fields
Field &lias [ Field SAL &lias [ Table SOL Alias | ~
ACO_AGEMNT_CODE CONTRACT.AC.. COMTRALCT W
ACTITY_WARIAMCE CONTRACT.AC COMTRACT
ACT_PER CONTRACT.AC.. CONTRALCT
ACT_PER_LESS_STORED CONTRACT.AC COMTRACT
ACT_PLCMT CONTRACT.AC.. CONTRALCT
ACT_TOT COWNTRACT.AC.. COMTRACT
AE_ADDRESST CONTRACT.AE.. CONTRALCT
AE_ADDRESS2 COWMTRACT.AE.. COMTRACT
AE_ADDRESSS CONTRACT.AE.. CONTRALCT
AE_EVAL_ACT CONTRACT.AE.. COMTRALCT
AE_EVAL RO CONTRACT.AE.. COMTRALCT
AF FWaAl SCH CNNTRACT AF CANTRACT b
Selected Fields [ AllFields
Field Alias Fiegld 501 Alias Table 50L Aliaz
FMT_COMTRACT_DELIVERY COMTRACT.FMT_COMTRACT _DELIVERY CONTRACT
PROJ_NAME COMTRACT.PROJ_MAME CONTRACT
CURREMT_COMTRACT COMTRACT.CURRENT _COMTRALT CONTRACT
PROJ_ENGR COMTRACT.PROJ_ENGR CONTRACT
LOCATION COMTRACT.LOCATION CONTRACT
I _MO RECEIPT_VOUCHER.INY_NO RECEIPT_“OUCHER
RECEIPT_VOUCHER.DAYS_LATE RECEIPT_YOUCHER
CHECK_DATE RECEIPT_VOUCHER.CHECK_DATE RECEIPT_“OUCHER
CHECK_MUMBER RECEIPT_YOUCHER.CHECK_MUMBER RECEIPT_YOUCHER ﬂ
INTEREST_AMT RECEIPT_VOUCHER.IMTEREST _aMT RECEIPT_“OUCHER
=

po PR B alLR oL
;-J'H*'#F'”J‘r‘r e P ,...._.f"'P J’_..?"-* Moy 4 ) “_rf-—‘.
"l

On the search tab, set the following filter:
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R Query Designer
Tahlas] Figlds ] Calcs ] Group  Search I Sort 1 s0L ]
O Available Fields

[(=1E

Field &lias [ Field SAL &lias [ Table SOL Alias |

F P et L
"-J"—"'*""-t-v-._.rhi"‘uf“a-ui"% I‘”-J"r"’ ‘1*:‘\“_’_,,‘

"

And finally, on the sort tab, set the sort as shown:

A
ACO_AGENT_C.. COMTRACTAC.. CONTRACT

ACTRATY_WaR|.. CONTRACT.AL COMTRACT =
ACT_PER CONTRACT.AC.. COMTRALCT

ACT_PER_LESS.. CONTRACT.AL. COMTRACT

ACT_PLEMT CONTRACT.AC.. COMTRALCT

ACT_TOT COWNTRACT.AC.. COMTRACT

AE_ADDRESS1  CONTRACTAE.. CONTRACT

AE_ADDRESS2  CONTRACT.AE.. COMTRACT

AE_ADDRESS3  CONTRACT.AE.. CONTRACT

AE_EWAL_ACT CONTRACT.AE.. COMTRALCT

AE_EVAL_RQ CONTRACT.AE.. CONTRACT

AE_EWAL_SCH CONTRACT.AE.. COMTRALCT

AE_TITLE COWNTRACT AE COMTRACT

ALT_REP CONTRACT.AL.. COMTRALCT

ALT_REP2 COWNTRACT.AL COMTRACT

ALT_REP3 CONTRACT.AL.. COMTRALCT

AwARD_AE_DE CONTRACT.A.. COMTRACT

AwidRD_ALLOC.. CONTRACT.A..  CONTRACT

AWARD_APPR.. CONTRACT.A.. COMTRACT

AwitRD_AUTH... CONTRACTA..  CONTRACT

AwidRD_BID_0.. COMTRACTA..  COMTRACT

AwiRD_BID_T.. COWTRACTA..  CONTRACT

AwidRD_BID V.. CONTRACTA..  CONTRACT

Aw/ARD_COMTI.. CONTRACT.A COMTRACT

AwidRD_COMTIL.. COMTRACT.A..  CONTRACT

AWARD_CONT CONTRACT A COMTRACT

AwiRAD_CONT... CONTRACTA..  CONTRACT 3
ANADI P COMTOACT A FOMTOART bt
Criteria

Field Operator alue AutoSearch | Mandatorn Shaow All

RECEIPT_WOUCHER.INTEREST_AMT < 0
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R Query Designer E”Elg‘
Tahlas] Figlds ] Calcs ] Grnup} Search  Sort ]SDL ]
21 Available Fields

Field &lias [ Field SAL &lias [ Table SOL Alias | ~
ACT_AGENT_C.. CONTRACTAC.. COMTRACT
ACTMITY VAR CONTRACTAC.. COMTRACT -
ACT_PER CONTRACTAC.. COMTRACT
ACT_PER_LESS.. CONTRACTAC.. COMTRACT
ACT_PLCMT CONTRACTAC.. COMTRACT
ACT_TOT CONTRACTAC.. COMTRACT
4E_ADDRESST  CONTRACTAE.. COMTRACT
AE_ADDRESSZ  CONTRACTAE.. COMTRACT
AE_ADDRESS3  CONTRACTAE.. COMTRACT
AE_EVAL_ACT  CONTRACTAE.. COMTRACT
AE_EWAL_RO CONTRACT.AE.. COMTRACT
AE_EVAL_SCH  CONTRACTAE.. COMTRACT

AE_TITLE CONTRACT.AE COMTRALCT
ALT_REP COWTRACT.AL.. CONTRACT
ALT_REFZ CONTRACT.AL COMTRALCT
ALT_REP3 CONTRACT.AL.. CONTRACT

AwaRD_AE DE CONTRACT.A..  COMTRACT
AwARD_ALLOC.. CONTRACTA..  CONTRALCT
AwWARD_APPR.. CONTRACT.A..  COMTRALCT
AwARD_AUTH... CONTRACTA..  CONTRALCT
AwARD_BID_O.. CONTRACT.A..  COMTRALCT
AwARD_BID_T.. CONTRACTA..  CONTRALCT
AwARD_BID V.. CONTRACTA..  CONTRALCT
AwARD_CONTI.. CONTRACT.A. COMTRACT
AwARD_CONTI.. CONTRACTA..  CONTRALCT
AwWARD_CONT... CONTRACT.A. COMTRACT
AwARD_CONT... CONTRACTA..  CONTRALCT

ANIADD PiE FOMTOACT 4 COMTOART bt
Sort Fields [~ Matural Order
Field Alias Field SOL Alias Table SOL Aliss Desc(z > a

FMT_CONTRACT_DELIVERY COMTRACT.FMT_COMTRACT_DELIVERY CONTRACT

CHECK_DATE RECEIPT _WOUCHER.CHECK_DATE RECEIPT_“OUCHER ﬂ

ﬂ."}."._,‘..,r- ,‘__,___.’._‘-'&—1'_’—"‘.?._‘_*"# er-P-‘ *-l.-t-y‘ r_,__“ -
R -

'

4.4  Step 3 - Design the Detail Band

Switch to the design tab and add DBText objects and position them as shown here:

_ . UE Army Corps.
- - -of Englneers.- -

45  Step 4 - Add a Group

Click on Report > Groups form the pull down menu.

Add a group for the contract_delivery with settings as shown here:
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COMTRACT.FMT_COMTRACT _DELMERY
Group(QECOMTRACT FMT COMTREACT DELIMERY

Inzert

Delete

[l

Break On
f« [ata Field " Cugtom Field

On Group Change
[ Start new page

=

Mew page when lezs than ICI

[v K.eep group together

[v Reprint group headers on subzequent pages

“ Header

[ FMT_CONTRACT_DELIVERY

" Group Headei[0} FMT_CONTRACT_DELIVERY
o LOCATION. oo URRENT CONTRAD

* Detail

o Grnun Eante 0L EMT GOMTAACT DELIVERY,  petom 5 — e i o

—_"‘-——__f'

The INTEREST_AMT object is a DBCalc. Once you have it positioned, right click on it and select
calculations and set it as follows:

Calculations

Calc Type
hd
Rezet Group

|Group [0} FMT_COMTRACT_D |
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46  Step 5-Add a Summary Band
Select Report>Summary. A new summary band will open. Set the layout as shown below using a label
and another DBCalc. The DBCalc should be set to use the INTEREST_AMT field and to never reset.
RMS Report Designer [ de_rms.world ]: Test Report 9 g@@
File Edit Yiew Report Help
Data | Calc  Desian | Previen |
I ABBnm@Epl agon|AEaune® BERDE
[ [l |10 | Bru | === A-2.  $H T
H.d.-=m= IH | =@ LS fF | BEadg Wod w2 HE DSH LDESE | 2@
e L e |n
" Header
.o [FMT_CONTRACT DELIVERY : |
 Gioup Header0]: FMT_CONTRACT_DELIMERY
: g:ﬂ Foote{0} FMT_COMTRACT_DELIVERY
* Foater
- Total Interest for ALL Contracts - SuriHTEREET AN
™ Summary
Ready. Left: 0 Top: 0 width: 0 Height: 0
4.7  Step 6 - Set 2 pass and lookahead options

If you run the report a is, you will probably see that the total in the header band is not correct. That's
because the header gets rendered before the detail data gets printed. At that time, it does not know
the total for the entire group. To fix this, we will use 2 pass and lookahead.

Select Report > Pass Setting and make sure Two Pass is checked. This will cause the report engine
to make two passes over the data so that our header will know what the total of the detail band is

when it gets rendered on the second pass.
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RMS Report Designer [ de_rms.world ]: Ex3
File Edit Wigw N Help

45

Data ] Calc Data. ..
NN ® = |AE
W Summary
Arial
v Header
B - -1, Footer B2 & it [O°
E I:l 1 1 1 I 1 Page St':lllle 1 1 1 | 1 1 1 I 1 1
O
[ ::. Groups. . ChrHG
N & Outline Settings... Ttﬁ _': """"""
- 'Msg,,:‘[',fu Find Text Settings.,,  So——
[ Portrat e
K Lol v Landscape Current
i Header Cache Pages
Pass Setking One Pass @E_ -
- v Two Pass
GroupHe e ’ Sl (R
S0 LA e . URRENT €
* Detail

" Group Footer[0]: FMT_COMTRACT_DELIMERY

Now, we have to tell the report engine that we want out group header total to have the total by setting
it to use lookahead. Right click on the INTEREST_AMT dbcalc in the header band and Make sure
Lookahead is selected.

= —_———— e r—T |3
M Bring ko Fronk

— Send ko Back,

AukaSize
BlankWwhenZera
Calculations, ..

im(INTE DisplayFormat, .,
v Lookahead
Pasitian...
ReprintOnCwerFlow
ReprintOnsubsequent
ResebGroup, ..
SuppressRepeatedyvalues
Ti v Transparent Height: 1
w Yisible _—
WiardvWrap
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4.8

Now, the total in the header will be the total for the detail rows within its section.

Summary

This simple report showed how to use group headers and how to enable 2 pass and lookahead to

include totals in the header band.
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5 Example 5 - AutoSearch
5.1 Overview
The query designer will let you specify all kinds of search/filter conditions. But what if you want to let
your user decide what conditions to use. That's where autosearch comes in. Report builder lets you
tag search conditions as autosearch and then it will prompt the user for values when the report runs.
This simple listing of contracts is just designed to show how to use some of the different Autosearch
features and how to display the selected options in the actual report.
“ Contract List
US Army Corps 15-Aug-07
of Englnoers.
dward Prograim Contract
DACASS-03-C-0014 Fy 03 MCABUP, WEBR Ph 34, Ren Quad C 9M172003 RAILZON $57 953615870
DACASS-03-D-0005 0005 Hyhbrid PhotovottaicDiesel Energy System Q3072004 ML $994 99900
DACAES-05-0-0016 0003 Modify Diezel Fuel System 3212005 MILCCON $452,054 .00
DACASS-03-D-0016 0004 F 05 MCA PR 50927, Fire Station V262005 RAILZON ¥5.103,789.00
Showr all data where the AWD_ACT is between 01/01/2003 010152007
and the PROGRAM_TYFE matches one of the walues inthis list MILCON IRACG
and the CONTRACT_DELIWERY begins with DACASE
=nd the CURRENT_COMTRACT is greater than 100000
Note the selection criteria displayed in the Summary section above.
Skills shown:
- Autosearch Basics
- Mandatory AutoSearch
- Getting a description of the Autosearch selections
5.2 Step 1-Load the Standard Portrait Template

Switch to the Design tab and load up the standard Portrait Template
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5.3

RMS Report Designer [ de_rms.world ]: Ex9
File Edit View Report Help

49

Data | Cale  Design | Preview |

h | ABEneai aeos | ARERa0e® 0B EH

e

" Header

T Detai
)

My Recent
Documents

T Footer

My Network
Places

BT

e

[r

Looki: [ RTMFies

- ~®merE-

| [l - Sl esru s==— | A-2- | 30| QR
BE |or BEad Tan mg | WE DSEH mSR 4 @6

[ contractbatashest.rtm RMSOfficeOrgChart rtm

[ contractvalusHistary.rtm

= Equist rtm RMSProgramTypes.rtm

= Ex08.rtm
ExampleDl rkm
ExampIeDZ‘rtm
ExampleD}rtm

=] Examplea4.rtm

e Exampleag.rtm

e Examplea7.rtm

= Examplegs.rm

| Example0g.rm

= overduemiestanes.rtm
= PoTTEST MEM

[ RM5LandscapeTemplate.rtm

i

File name: [AMSPortaiT emplate.tm

=l Open |

Files of type: |Report e .rtm)

LI Cancel

Step 2 - Set the Report Title and Column Headings

Change the report title to Contract List and add three Labels for column headings as shown here:
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5.4

RMS Report Designer [ de_rms.world J: Ex9

File Edit View Report Help

Data | Cale  Design | Preview |

h | ABEneai aeos | ARERa0e® 0B EH
T | | [l - B | ge=== | A-# |¢D\ﬂ‘i|
-4 ==|BE 2o 88 o Pad | Tan g WE DSH DER 2G|

5 L S R . le Iz [

8 Army Cotps. . 19-Aug 01
Enginoers.. . . NS -

* Header
~ Detail

“ Foater

Step 3 - Create the Query

Our query will be extremely simple. We will just use the contract table and a few selected fields and
we will sort it by FMT_CONTRACT_DELIVERY as usual. The interesting part of this example will be
the Search conditions.

Switch to the data tab and select File > New > Query Designer and click Ok

Select the contract table from the list
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R Query Designer

Fields ] Calcs ] Groupl Search] Sart ] sS0L ]
Available Tables

Table Table Name 2
ACCIDENT ACCIDENT

ACTMTY_DESC  ACTMTY_DESC =
ACTMTY_PAY_HISACTITY_Pay_HIE

ACTMTY_QA ACTIATY_O&

ACTMTY_SCHEDUACTITY_SCHEDL

AGENCY AGENCY

AGENT AGENT

AHA_HAZARD AHA_HAZARD

AHA_STEP “HA_STEP

ANT_WEATHER  ANT_WEATHER

APPYU_COMTRACTAPPYU_CONTRAL

APPYU_COMTRACTAPPYU_CONTRAL

APPYU_COMTRACTAPPYU_CONTRAL

BASELINE_LIBRAR BASELINE_LIERAR

BASELINE_OFFICE BASELINE_OFFICE

BID BID

BID_CHANGE BID_CHAMGE

BID_CHANGE_OBLIBID_CHAMGE_OBL

BID_OBLI BID_OBLI

CALENDAR CALEMNDAR

CATEGORIES CATEGORIES

CATEGORY CATEGORY v
Selected Tables [~ Distinct
Table Table Mame SOL Alias Join Type:

CONTRACT CONTRACT COMTRACT

Cancel

Switch to the fields tab and select the fields as shown

R Query Designer

Tables Fields ]Calcs | Group | Search| sot | saL |
[A] Available Fields
Field Alias | Fied SOL &fias | Table SOL Alias | ~
ACO_AGENT_C.. COMTRACT.AC.. COMTRACT E
ACTIVITY_VARL.. COMTRACT.AC.. COMTRACT
ACT_PER COMTRACT.AC.. COMTRACT
ACT_PER_LESS.. COMTRACT.AC.. COMTRACT
ACT_PLCMT COMTRACT.AC.. COMTRACT
ACT_TOT COMTRACT.AC.. COMTRACT
AE_ADDRESST COMTRACT.AE... COMTRACT
AE_ADDRESSZ  COMTRACT.AE.. COMTRACT
AE_ADDRESS3  COMTRACT.AE.. COMTRACT
AE_EVAL_ACT COMTRACT.AE... COMTRACT
AE_EVAL RO COMTRACT.AE... COMTRACT
AE_EVAL_SCH COMTRACT.AE... COMTRACT
AE_TITLE COMTRACT.AE... COMTRACT
ALT_REP COMTRACT.AL.. COMTRACT
ALT_REPZ2 COMTRACT.AL.. COMTRACT
ALT_REP3 COMTRACT.AL.. COMTRACT
AWARD_AE_DE  COMTRACT.A.. COMTRACT
AWARD_ALLOC.. COMTRACT.A.. COMTRACT
AWARD_APPR... COMTRACT.A.. COMTRACT
AWARD_AUTH COMTRACT A, COMTRACT 2
Selected Fields [~ AllFields
Field Alias Field SOL Alias Table SOL Alias
FMT_CONTRACT_DELIVERY COMTRACT.FMT_CONTRACT_DELNVE.. COMTRACT
PROJ_MAME COMTRACT.PROJ_NAME COMTRACT
AWD_ACT COMTRACT. AwWD_ACT COMTRACT ﬂ
PROGRAM_TYPE COMTRACT.PROGRAM_TYPE COMTRACT
CURREMT_COMTRACT COMTRACT.CURREMT_COMTRACT COMTRACT
|
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5.5

Finally, switch to the sort tab and select the FMT_CONTRACT_DELIVERY field to sort by

R Query Designer

Tables] Figlds ] Calcs ] Group I Gearch ot ] S6L ]

81 mvasilable Fields

Field Alias | Fied SOL &fias | Table SOL Alias | ~

ACO_AGENT_C.. COMTRACT.AC.. COMTRACT

ACTIVITY_VARL.. COMTRACT.AC.. COMTRACT

ACT_PER COMTRACT.AC.. COMTRACT

ACT_PER_LESS.. COMTRACT.AC.. COMTRACT

ACT_PLCMT COMTRACT.AC.. COMTRACT

ACT_TOT COMTRACT.AC.. COMTRACT

AE_ADDRESST COMTRACT.AE... COMTRACT

AE_ADDRESSZ  COMTRACT.AE.. COMTRACT

AE_ADDRESS3  COMTRACT.AE.. COMTRACT

AE_EVAL_ACT COMTRACT.AE... COMTRACT

AE_EVAL RO COMTRACT.AE... COMTRACT

AE_EVAL_SCH COMTRACT.AE... COMTRACT

AE_TITLE COMTRACT.AE... COMTRACT

ALT_REP COMTRACT.AL.. COMTRACT

ALT_REPZ2 COMTRACT.AL.. COMTRACT

ALT_REP3 COMTRACT.AL.. COMTRACT

AWARD_AE_DE  COMTRACT.A.. COMTRACT

AWARD_ALLOC.. COMTRACT.A.. COMTRACT

AWARD_APPR COMTRACT A, COMTRACT

AWARD_AUTH COMTRACT A, COMTRACT

AWARD_BID_O.. COMTRACT.A COMTRACT

AWARD_BID_T.. COMTRACT.A COMTRACT -

Sort Fields [~ Matural Order

Field Aliaz Field SOL Alias Table SGL Alias Desc(z> a

FMT_CONTRACT_DELIVERY COMTRACT.FMT_CONTRACT_DELIVERY CONTRALCT
|
|

Cancel

Step 4 - Add a Between Autosearch

Autosearch lets you give the user control over what records are included in the report when it prints.
There are several different types of autosearches including between, in list, less than, greater than,
blank and so on.

Lets start by adding a between condition on the award date so the user can filter down to just
contracts awarded for a certain period of time.

Switch to the Search tab and select the AWD_ACT field from the list. Set the operator to Between and
leave the value blank. Set autosearch to Yes
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5.6

R Query Designer

Tablesl Fields I Calcs I Group Search |Sort I sS0L I
Q Avvailable Fields
Field Alias | FieldSOL Aas | Table SOLAkas | ~

ACO_AGENT_C.. CONTRACTAC. CONTRACT
ACTIMITY_WARIL.. CONTRACTAC. CONTRACT

ACT_PER COWTRACT.AC..  CONTRACT
ACT_PER_LESS.. CONTRACTAC. CONTRACT
ACT_PLCMT COWTRACT.AC..  CONTRACT
ACT_TOT COWTRACT.AC..  CONTRACT

AE_ADDRESST  CONTRACTAE.. COWTRACT
AE_ADDRESSZ  CONTRACTAE..  COWTRACT
AE_ADDRESS3  CONTRACTAE..  CONTRACT
AE_EVAL ACT COWTRACT.AE..  CONTRALCT
AE_EVAL RO COWTRACT.AE..  CONTRALCT
AE_EVAL SCH COWTRACT.AE..  CONTRALCT

AE_TITLE COWTRACT.AE..  CONTRALCT
ALT_REP COWTRACT.AL..  CONTRACT
ALT_REPZ COWTRACT.AL..  CONTRACT
ALT_REP3 COWTRACT.AL..  CONTRACT

AwBRD_AE_DE  CONTRACT.A..  CONTRACT
AwBRD_ALLOC.. CONTRACT.A..  CONTRACT
AwBRD_APFR..  CONTRACTA..  CONTRACT
AwBRD_ALTH.. CONTRACTA..  CONTRACT
Aw/BRD_BID_O.. CONTRACT.A..  CONTRACT
Aw/BRD_BID_T.. CONTRACT.A..  COMTRACT

M
Criteria
Field | Operatar | Walue | AutaSearch | Mandatary | Show &l |
COMTRACT &wD_alT Between Yes
|
|

Cancel |

When the report runs, the user will be prompted to enter a from / thru date for the award.

Step 5 - Add an In List Autosearch

An In List search allows the user to add as many entries as they choose to a list. If the record matches
any item in the list, then it gets included in the report.

Lets add an In List on Program Type:

Select the PROGRAM_TYPE field from the list and set the options as shown here. Also, check the
Mandatory block. That will make it so that the user has to make an entry before the report runs.
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5.7

R Query Designer

Tables] Fields ] Calcs ] Group Search ]Sort ] sS0L ]
Q Avvailable Fields
Field Alias | Field SOL &as | Table SAL Alias | -

ACO_AGENT_C.. CONTRACTAC. CONTRACT
ACTIMITY_WARIL.. CONTRACTAC. CONTRACT

ACT_PER COWTRACT.AC..  CONTRACT
ACT_PER_LESS.. CONTRACTAC. CONTRACT
ACT_PLCMT COWTRACT.AC..  CONTRACT
ACT_TOT COWTRACT.AC..  CONTRACT

AE_ADDRESST  CONTRACTAE.. COWTRACT
AE_ADDRESSZ  CONTRACTAE..  COWTRACT
AE_ADDRESS3  CONTRACTAE..  CONTRACT
AE_EVAL ACT COWTRACT.AE..  CONTRALCT
AE_EVAL RO COWTRACT.AE..  CONTRALCT
AE_EVAL SCH COWTRACT.AE..  CONTRALCT

AE_TITLE COWTRACT.AE..  CONTRALCT
ALT_REP COWTRACT.AL..  CONTRACT
ALT_REPZ COWTRACT.AL..  CONTRACT
ALT_REP3 COWTRACT.AL..  CONTRACT

AwBRD_AE_DE  CONTRACT.A..  CONTRACT
AwBRD_ALLOC.. CONTRACT.A..  CONTRACT
AwBRD_APFR..  CONTRACTA..  CONTRACT
AwBRD_ALTH.. CONTRACTA..  CONTRACT
Aw/BRD_BID_O.. CONTRACT.A..  CONTRACT
Aw/BRD_BID_T.. CONTRACT.A..  COMTRACT

v
Criteria
Field Operator Walue AutoSearch | Mandatary Shaow &l
COMTRACT &wD_alT Between es ﬂ
CONTRACT.PROGRAM_TYPE In List es Yes
|

Cancel

Step 6 - Add a Like Autosearch

A like autosearch does partial pattern matching. It lets the user search for matches where the
beginning of the field matches some value. We will do a Like on the contract number so the user can
type in DACA83 or something of that sort to match certain contracts.

Select the CONTRACT_DELIVERY field from the list and set the options as shown here
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R Query Designer

Tablesl Fields I Calcs I Group Search |Sort I sS0L I

Q Avvailable Fields

Field Alias | FieldSOL Aas | Table SOLAkas | ~

ACO_AGENT_C.. CONTRACTAC.. CONTRACT =

ACTMITY_WARIL.. CONTRACTAC.. CONTRACT D |

ACT_PER COMTRACT.AC..  CONTRACT

ACT_PER_LESS.. CONTRACT.AC.. CONTRACT

ACT_PLCMT COMTRACT.AC..  CONTRACT

ACT_TOT COMTRACT.AC..  CONTRACT

AE_ADDRESS1  CONTRACT.AE.. CONTRACT

AE_ADDRESSZ  CONTRACT.AE.. CONTRACT

AE_ADDRESS3  CONTRACT.AE.. CONTRACT

AE_EVAL ACT COMTRACT.AE..  CONTRACT

AE_EVAL RO COMTRACT.AE..  CONTRACT

AE_EVAL_SCH COMTRACT.AE..  CONTRACT

AE_TITLE COMTRACT.AE..  CONTRACT

ALT_REP COMTRACT.AL..  CONTRACT

ALT_REP2 COMTRACT.AL..  CONTRACT

ALT_REP3 COMTRACT.AL..  CONTRACT

AwARD_AE_DE  CONTRACT.A..  CONTRACT

AwARD_ALLOC.. CONTRACT.A..  CONTRACT

AwARD_APPR.. CONTRACT.A..  CONTRACT

AwARD_AUTH.. CONTRACT.A..  CONTRACT

AwARD_BID_0.. CONTRACT.A..  CONTRACT

AwARD_BID_T.. CONTRACT.A..  CONTRACT v

Criteria

Field | Operator | Walue | AutoSearch ‘ M andatary | Shaow All |

COMTRACT &wD_alT Between res LI

CONTRACT.PROGRAM_TYPE In List ‘es

CONTRACT.CONTRACT_DELIMERY Like ‘es LI
Cancel |

5.8 Step 7 - Add a Greater Than Autosearch

Finally, lets let the user filter to only contracts greater than a certain amount. Select the
CURRENT_CONTRACT field from the list and enter the options as shown below.

Note that 100000 is entered as the value. That will become a default value when the user runs the
report.
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5.9

R Query Designer

Tables] Fields ] Calcs ] Group Search ]Sort ] sS0L ]
Q Avvailable Fields

Field Alias | Field SOL &as | Table SAL Alias |

A
ACO_AGENT_C.. CONTRACTAC.. CONTRACT

ACTMITY_WARIL.. CONTRACTAC.. CONTRACT

ACT_PER COMTRACT.AC..  CONTRACT

ACT_PER_LESS.. CONTRACT.AC.. CONTRACT

ACT_PLCMT COMTRACT.AC..  CONTRACT

ACT_TOT COMTRACT.AC..  CONTRACT

AE_ADDRESS1  CONTRACT.AE.. CONTRACT

AE_ADDRESSZ  CONTRACT.AE.. CONTRACT

AE_ADDRESS3  CONTRACT.AE.. CONTRACT

AE_EVAL ACT COMTRACT.AE..  CONTRACT

AE_EVAL RO COWTRACT.AE..  CONTRALCT

AE_EVAL_SCH COMTRACT.AE..  CONTRACT

AE_TITLE COMTRACT.AE..  CONTRACT

ALT_REP COMTRACT.AL..  CONTRACT

ALT_REP2 COMTRACT.AL..  CONTRACT

ALT_REP3 COMTRACT.AL..  CONTRACT

AwARD_AE_DE  CONTRACT.A..  CONTRACT

AwARD_ALLOC.. CONTRACT.A..  CONTRACT

AwARD_APPR.. CONTRACT.A..  CONTRACT

AwARD_AUTH.. CONTRACT.A..  CONTRACT

AwARD_BID_0.. CONTRACT.A..  CONTRACT

AwARD_BID_T.. CONTRACT.A..  CONTRACT v
Criteria

Field Operator Walue AutoSearch | Mandatary Shaow &ll

COMTRACT &wD_alT Between es ﬂ
CONTRACT.PROGRAM_TYPE I List es ‘Yes

CONTRACT.CONTRACT_DELIMERY Like es

CONTRACT.CURRENT_CONTRACT > 100000 Yes ﬂ

Cancel

Step 8 - Build the Detail Band

Lets throw some fields into the detail band so we can see how our autosearch is working for us. Drag
a region from the toolbar and set it to parentheight/parentwidth and then put 4 DBText objects into the
region setting up the fields and positions as shown here.
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5.10

RMS Report Designer [ de_rms.world J: Ex9

File Edit View Report Help

Data | Calc  Design | Preview |

h | ABEnEEk G ATERTD®E AMRE
| [Aral e
W E EaS Tad we: | WE

SO e e

JErd-

| 0
b

v

US Army Corps
o ofEnglnoors.

* Detail

“ Faoter

Ready.

Left: 0 Top: O Width: 0 Height: 0 Y

Step 9 - Test The AutoSearch

Save the report and close down the designer. Then. run the report by double clicking on it in the

explorer and you should see this screen. Note the default value kicked in and the PROGRAM_TYPE
entry is mandatory.

Enter some values to see what results you get on your report.

USACE




58

RMS Report Writing

5.11

Show all data where the &0 _ACT iz between | and
[ Show all values of the &w/D_ACT field.

and the PROGRAM_TYPE matches one aof the values in thig list:

Add to list

Remove from ligt

Search value muzt be entered.

and the COMTRACT_DELIVERY begins with |
[ Show all values of the CONTRACT_DELIVERY field.

and the CURREMNT_COMTRACT iz greater than |'IEIEIEIEIEI
[ Show all values of the CURRENT_COMTRACT field.

* indicates that this search value must be entered. Cancel

Step 10 - Add the Search Text to the Report

We have one glaring problem remaining. When you run the report, nothing prints on the actual report
showing the user what the conditions are. Lets fix that with some RAP code that fills a memo with the
search text.

Return to the designer. From the Design tab, select Report and then select Summary to add a
summary section band. Add a regular Memo to the summary band as shown. Right click on the memo
and make sure Stretch is selected so that the memo will grow as needed.
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RMS Report Designer [ de_rms.world ]: Ex9

File Edit View Report Help

Data | Calc  Design | Preview |

h | ABEnEEk G ATERTD®E AMRE

[Memot | | [Aral e
o F w8 | oE BaS Tow | | lE |
[EN ' N N R L

Footer

" Summary

Object: Memol

Left: 0.1667 Top: 0.052 Width: 7.6771 Height: 0, 1875 Y

Now, lets add the RAP code. Click on the Calc tab. Highlight the report object and add a BeforePrint
event with this code

Report. Get Aut oSear chDescri pti onLi nes(Menpl. Li nes);
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5.12

RMS Report Designer [ de_rms.world J: Ex9
File Edit View Help

Data  Cale IDas\gn]Plavlew}

[ AnRatbtnG aamkvales

Report Objects Evenls
=+ 8 Report [ AltesbuosearchDidogCreate —
=) Header [ AtterD perDataPipeiines
A Labels [ AterPrint
| Linct [1 BeforebutoSearchDialogCreate
%z' fm*'::e";\’a”ah"” [ Befors0penD ataFipslines
£m Shape1 Bl BeforePrint
A Labell [ OndssignPreviewFomSettings
A Label2 [ OndutoSearchDislogClose
A Label2 [ OnCancel
- Dietail [ OnCancelDialogClase
s Footer [ OnCanceiDislogCraate
- Summary (11 OrErdCalurn
[ OnEndFirstPass
[ OnEndPage
[ OrErdsecondPass L

procedure ReportBeforePrint:
begin

riptionLine

Compils Completed: 0 Enors

Code: Toolbox: Data
ET CONTRACT

Data f0bjects 4Language

3 52

This will fill the memo with a description of all of the options selected in autosearch.

Summary

This report showed some important steps in allowing the user to set filter criteria and in showing that

criteria on a report.
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6.1

6.2

Example 6 - Special AutoSearchs (Contract and Office)

Overview

In the previous example, we showed how autosearch works. In this example, we show 2 special cases
for the autosearch. One for contracts and one for offices.

Because contracts and offices are so integral to RMS, we have built in special autosearches for them

allowing the user to pick form a list

Contract List

18-Aug-07

UE Army Corps
of Engl S

Awvared

Program Contract
DACAS3-03-C-0014 F¥03 MCABUP, 'WBR Ph 34, Ren Guad C 911/2003 RAILCON $57.985618.70
DACASR3-03-D-0005 0005 Hyhrid Photovoltaic/Diesel Energy System 91302004 MILCOM $994 993900
DACAR3-03-D-0016 0003 Madify Diesel Fusl System 32142005 RAILCOM 452,084 .00
DACAB3-03-D-0016 0004 F05 MCA PH 50927, Fire Station 712612005 RAILCON $5.103.785.00

Showr all data where the AWO_ACT is between 01/01/2003 01012007

and the CONTRACT_DELIWERY begins with DACASS
=nd the CURRENT_CONTRACT is greater than 100000

Skills shown:
- Special Autosearches for Contract and Office

Step 1 - Load the existing Report

and the PROGRAM_TYFPE matches one of the walues inthis list MILCON, IRAG

We are just demonstrating some additional search features so we will use an existing report. Load the

report from Example 5.
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6.3

USACE

RMS Report Designer [ de_rms.world J: Ex9

File Edit View Report Help
Data | Calc  Design | Preview |
b [ Addw@Eis 6o AEURLDSE BDAE
Iz ~Ip
IEEE TS
o

IO TR IO M e

|WE D&M

| 0
b

v

US Army Corps
o ofEnglnoors.

Ready.

Left: 0 Top: O Width: 0 Height: 0 Y

Step 2 - Configure Contract AutoSearch
Switch to the data tab in the designer and open the query designer.

Switch to the search tab and remove all of the existing searches.
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R Query Designer
Tables] Fields ] Calcs ] Group Search ]Sort ] sS0L ]
Q Avvailable Fields

Field Alias | FieldSOL Alias [ Table SAL Alias

A

ACO_AGENT_C.. CONTRACTAC.. CONTRACT

ACTMITY_WARIL.. CONTRACTAC.. CONTRACT 1

ACT_PER COMTRACT.AC..  CONTRACT

ACT_PER_LESS.. CONTRACT.AC.. CONTRACT

ACT_PLCMT COMTRACT.AC..  CONTRACT

ACT_TOT COMTRACT.AC..  CONTRACT

AE_ADDRESS1  CONTRACT.AE.. CONTRACT

AE_ADDRESSZ  CONTRACT.AE.. CONTRACT

AE_ADDRESS3  CONTRACT.AE.. CONTRACT

AE_EVAL ACT COMTRACT.AE..  CONTRACT

AE_EVAL RO COWTRACT.AE..  CONTRALCT

AE_EVAL_SCH COMTRACT.AE..  CONTRACT

AE_TITLE COMTRACT.AE..  CONTRACT

ALT_REP COMTRACT.AL..  CONTRACT

ALT_REP2 COMTRACT.AL..  CONTRACT

ALT_REP3 COMTRACT.AL..  CONTRACT

AwARD_AE_DE  CONTRACT.A..  CONTRACT

AwARD_ALLOC.. CONTRACT.A..  CONTRACT

AwARD_APPR.. CONTRACT.A..  CONTRACT

AwARD_AUTH.. CONTRACT.A..  CONTRACT

AwARD_BID_0.. CONTRACT.A..  CONTRACT

AwARD_BID_T.. CONTRACT.A..  CONTRACT v

Criteria

Field Operatar Yalue AutaSearch | Mandatary Show &l J
|

Cancel

To configure the special contract autosearch, select contract_id from the list, set the operator to In List
and set AutoSearch to yes. These setting will cause the special contract selection screen to appear

when the user runs the report.
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R Query Designer

Tablesl Fields I Calcs I Group Search |Sort I sS0L I

Q Avvailable Fields

Field Alias | Ficld GAL Alias | Table SOL Alas | A

CG_TOTAL4 COMTRACT.CG... COMTRACT

CG_TOTALS COMTRACT.CG... COMTRACT

CG_TOTALE COMTRACT.CG... COMTRACT

CG_UNCONTROLLABLES COMTRACT.CG... COMTRACT =

CG_UNCONTROLLABLES COMTRACT.CG... COMTRACT b |

CG_UNCONTROLLABLEE COMTRACT.CG... COMTRACT

COMMENT_DATE COMTRACT.CO... COMTRACT

COMP_ACT COMTRACT.CO... COMTRACT

COMP_SCH COMTRACT.CO... COMTRACT

COMSTRUCTIONDAYS COMTRACT.CO... COMTRACT

COMST_COMP_ACT COMTRACT.CO... COMTRACT

COMST_COMP_SCH COMTRACT.CO... COMTRACT

COMST_NTP_ALCT COMTRACT.CO... COMTRACT

COMST_NTP_SCH COMTRACT.CO... COMTRACT

COMST_START_ACT COMTRACT.CO... COMTRACT

COMST_START_SCH COMTRACT.CO... COMTRACT

COMTINGEMCY_THRESHOLD COMTRACT.CO... COMTRACT

COMTRACT_DELWERY COMTRACT.CO... COMTRACT

COMTRACT_FLAGS COMTRACT.CO... COMTRACT

COMTRACT_ID COMTRACT.CO... COMTRACT

COMTROLLABLE_MOD456_a&MT  CONTRACT.CO.. COMTRACT

COMTROLLABLE_MOD456_TIME  CONTRACT.CO.. COMTRACT v

Criteria

Field | Operatar ‘ Walue | AutoSearch | Mandatary | Shaow &l ‘

CONTRACT.CONTRACT (D [inList = w r r |

=

Cancel |

6.4  Step 3 - Test the Contract AutoSearch

Save the report and close the designer. Run the report from the explorer and you will see the special
option allowing the user to pick from a list of contracts.
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6.5

Select Contract

| Search | | Filter | | Clear Filker |
ETTITITITITITITITIL
it
Contract [0 |F'ru:uieu:t M ame Contract Mo, A
L J3000E06 A/C Equiprent Perfarmance Upgrades, MCBH DACAST-96-D-0031 06M
_|J3000347 4/C Equiprment Perfomance Upgrades, MCEH DACARY-96-0-0031 0006
_|J3000830 Ahateddsbestos & Lead Containing Paint W31280-06-F-0010 MA
(M A/C Improvementz-Hangar 103, KMCEH DACASY-96-D-0031 0002
_|J3000346 Energy EFff Lighting Upgrades, MCEH DACASY-96-D-0021 0005
_|J3000587 Energy EFff Lighting Upgrades, MCEH DACASY-96-0-0021 0501
_|J3000353 DG - LYZ, Inc. DACAS3-03-D-0015 M
_|J/3000350 IDIQ - Goto Construction, [ne. DACASZ-03-D-0013 M
J3000343 IDI - Alan Shintani, Ihe, DACASZ-03-D-0012 M
— w
£ >
Clear Selected Contracts |
Selected Contracts
Contract 1D |F'ru:uieu:t M ame Contract Mo, ~
4
w
£ >
Finished | | Cancel
Contract Record Count: 346 You have selected O contract(z].  Search Text:

Step 4 - Configure Office AutoSearch

Go back to the designer and as with the contract search we did before, lets configure office
autosearch.

Clear out the existing search and set up the search as follows:
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R Query Designer E]@@

Tables] Fields ] Calcs ] Group Search ]Sort ] sS0L ]

Q Avvailable Fields

Field Alias | Field 5GL Allas | Table SGL Alias -

ACO_AGENT_CODE COWNTRACT.AC.. CONTRACT

ACTIVMITY_WARIANCE COWNTRACT.AC.. CONTRACT

ACT_PER COWNTRACT.AC.. CONTRACT

ACT_PER_LESS_STORED COWNTRACT.AC.. CONTRACT

ACT_PLCMT COWNTRACT.AC.. CONTRACT

ACT_TOT COWNTRACT.AC.. CONTRACT

AE_ADDRESST COWNTRACT.AE.. CONTRALCT

AE_ADDRESSZ COWNTRACT.AE.. CONTRALCT

AE_ADDRESSE COWNTRACT.AE.. CONTRALCT

AE_EVAL ACT COWNTRACT.AE.. CONTRALCT

AE_EVAL RO COWNTRACT.AE.. CONTRALCT

AE_EVAL SCH COWNTRACT.AE.. CONTRALCT

AE_TITLE COWNTRACT.AE.. CONTRALCT

ALT_REP COWNTRACT.AL..  CONTRACT

ALT_REPZ COWNTRACT.AL..  CONTRACT

ALT_REP3 COWNTRACT.AL..  CONTRACT

AwBRD_AE_DE CONTRACT.A. CONTRALCT

A BRD_ALLOCATED CONTRACT.A. CONTRALCT

AwBRD_APFROVED CONTRACT.A. CONTRALCT

A BRD_AUTHORIZED_AMT CONTRACT.A. CONTRALCT

Aw/sRD_BID_OBLI CONTRACT.A. CONTRALCT

Aw/sRD_BID_TOT CONTRACT.A. CONTRALCT v

Criteria

Field Operator Walue AutoSearch | Mandatory Shaw All

CONTRACT. DFFICE_SYMBOL In List Yes |
|

Cancel

This will cause the special office lookup to be available to the user.

Before closing the query designer, switch back to the Fields tab and add OFFICE_SYMBOL to the list
of selected fields:
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R Query Designer

Tables Fields ]Calcs ] Groupl Search] Sart ] sS0L ]
[A Available Fields

Field Alias | Field SOL &lias | Table SQL Alias ~
MODS_SUPFORTING_CONTRA... CONTRACTMO.. CONTRACT
MODS_WOS4 CONTRACT.MO.. COMTRACT
MULTIPLE_TERMS CONTRACT.MU.. COMTRACT
NTP_ACT CONTRACT.NT.. COMTRACT
NTF_SCH CONTRACT.NT.. COMTRACT
DBLIBIDYAR CONTRACT.0B.. COMTRACT
DBLIGATED_CONTRACT_&MT  CONTRACT.OB.. COMTRACT
DBLIGATED_S&_AMT CONTRACT.0B.. COMTRACT
OBLI_TOT CONTRACT.0B.. COMTRACT

E COWTRACT.OF.. CONTRACT

H | COMTRACT.ON... CONTRACT

ORIGINAL_COMPLETION COMTRACT.OR... CONTRACT

OTHER_PROJECTED_COMTRA... COMTRACT.OT.. CONTRACT

O_BASIC COMTRACT.O_.. CONTRACT

P2_DOwMNLOAD_DATE COMTRACT.P2.. CONTRACT

P2_FISCAL_COMP_ACT COMTRACT.P2.. CONTRACT

P2_FISCAL_COMP_SCH COMTRACT.P2.. CONTRACT

P2_FUND_TYPE COMTRACT.P2.. CONTRACT

P&YMETHOD COMTRACT.PA..  CONTRACT 2

Selected Fields [~ AllFields

Field Alias Figld SOL Alias Table SGL Alias

FMT_CONTRAC... CONTRACT.FM.. CONTRACT

PROJ_NAME COMTRACT.PR... CONTRACT

AwD_aCT COMTRACT.A..  CONTRACT ﬂ

PROGRAM_TYPE COMTRACT.PH.. CONTRACT

CURREMT_CON... CONTRACT.CU... CONTRACT

OFFICE_SYMBOL COMTRACT.OF.. CONTRACT J
*

Cancel

6.6 Step 5 - Test the Office AutoSearch

Switch to the design tab and add the office_symbol to the detail band as shown here so that we can
properly test the office lookup.
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RMS Report Designer [ de_rms.world J: Ex9

File Edit View Report Help

Data | Calc  Design | Preview |

h | ABEnEak G ATERTD®E AMRE
|OFRICE_SvMBOL _x|[CONTRACT EIES] R

cw EBad | T D= H

N TERNE R s 8

W oo g | il E
[ N

B US Army Corps
. ofEngineers. ..

* Summary

Left: 3.6042 Top: 0.0625 Width: 0.6771 Height: 0,1275 Y

Object: DEText6

SPECIAL NOTE ON OFFICE_SYMBOL FIELD: The OFFICE_SYMBOL field is NOT the correct field
to use in an actual report. It is an internal code used to link to the offices table. To get the correct field
for a report, you have to do a join to the OFFICES table and use the OFFICES.DISPLAY_SYMBOL

field instead. (See the example report on doing this simple join)

Save the report and exit the designer. Run it from the explorer and play around with the office lookup:
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Select Contract

Search | | Filter | | Clzar Filker |

Select Office

Office Symbol IEIffiu:e Y ET Office Type e
L;‘l'-.E SUPPORT AE Support for Submittal Revie PROJECT -
_|CEPOH-EC-DA, Architectural/Specs Section FROJECT ;
_|CEPOH-PP-C Civil % Public ‘works Branch Dhigtrict
_|CEPOHECT Civil "Works Technical Branch PROJECT
_|CEPOH-ECDC Civil/Struct/Geaotech Section FROJECT
_|CEPOH-ECC Construction Branch Dhigtrict
_|CEFDH-EC-CC Conztruction Services Section Dhigkrict
_|CEPOH-CT-C Construction/a-E Contracting FROJECT
_|CEPOH-CT Contracting Division AREL

CEPOH-EC-5 Cost Engineering Branch AREA

ol
| T e R e e e e e e A e P A e S AT - |
Clear Selected Offices |
Selected Offices

Office Symbal | Office Name | Dffice Type | A

4
~
Finished | | Cancel

Office Record Count: 34 You have selected 0 office(z).
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7.1

7.2

Example 7 - Office Symbol Join

Overview

In an earlier example we used CONTRACT.OFFICE_SYMBOL in our report but mentioned that it was

a mistake to do so. This short example shows why.

=

UL Army Cerpe

Contract List

19-Aug-07

Skills shown:

- Basic Join to get the correct Office Symbol for a Contract

Step 1 - Load the existing report

Load the report from the example 5

of Englhoers.
Award Pragram Cortract
DACAD-02-C-0077 0001 Test Contract CEPOH-EC-CI  9ME£2005 $0.00
DACADS-01-C-0015 Ajr Traffic Cortrol Tower CEPOH-EC-C 853152001 F0.00
DACADI-97-C-0052 Landfill Expansion CEPOH-EC-C F2.000,000.00
DACAS3-00-C-0033 TEST PROJECT CEPOH-EC-Cr 87252001 IR&G $2.2558.573.00
DACAS3-01-C-0015 F+00 MCA PH 46902 WBR Ph I CEPOH-EC-C: 80142001 ML $0.00
DACAS3-01-0-0001 0004 F00 OhA Phg 4-9, G1C Boiler  CEPOH-EC-CI 1502001 IL-Codehd $0.00
DACASS-01-0-0001 0015 FY02 DHP Pka T-12, Deliv Rmto  CEPOH-EC-CI 9/30/2002 $0.00
[, A LA A IR LA R AR L s e e ARUmASRARA LA e [y ———
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7.3

RMS Report Designer [ de_rms.world J: Ex9

File Edit View Report Help

Data | Calc  Design | Preview |

h | ABEnEEk G ATERTD®E AMRE

I | | [Aral R [ Bru ||gE=E=
b5 == B8 |or Esd Taew o | WE ODSEH OSSR

Ho R B A B A B AU R A 8

3

Ready.

Left: 0 Top: O Width: 0 Height: 0 Y

Step 2 - Join to the Office Table

The reason that we don't want to use the CONTRACT.OFFICE_SYMBOL field is that it is just an
identifier used to link to the OFFICES table. It cannot be relied on to be an accurate actual office
symbol which can be used in reports. The reason for this is related to the recent change that allows
RMS users to change the office symbol for an office. While it may look like you can use this field, trust
me, it will be wrong in some cases. For any offices that are added after we made this change to RMS,
the CONTRACT.OFFICE_SYMBOL will just be a meaningless number.

Here is a list from SAS - Notice the K6 id's at the end of the list. If you use
CONTRACT.OFFICE_SYMBOL, that is what you are going to get.
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FLSYMBOL | »

|

BOGUS

CESAS
_|CESASCD
CESAS-CD-BE
CESAS-CD-BR
CESAS-CD-ERE
_|CESAS-CD-EBRC
CESAS-CD-GO
_|CESAS-CD-GOY
_[CESAS-CD-PS
CESAS-CD-PS
CESAS-CD-PSP
CESAS-CD-PSS
CESAS-CD-RO
CESAS-CD-ROM
_|CESAS-CD-ROO
_[CESAS-CD-5T
CESAS-CD-STH
CESAS-CO-STHM]
CESAS-CD-STS
_|CESASLCT
CESAS-OP
_|CESAS-OPH
_[CESAS-OPN
CESAS-OP-MNM
_[CESAS-OPR
_|CESAS-OPT
kE000001
kE000002
kE000003
_|KEQ00004
k.E000005
_[KEO0O00E
_[KBO0OO0Y
|_|Ke00000s

To fix this, you need to do a simple (but irritating) join to the office table anytime you want the office
symbol for a report. ALWAYS use OFFICES.DISPLAY_SYMBOL to display in the report and use
CONTRACT.OFFICE_SYMBOL = OFFICES.FLSYMBOL as the join condition.

To illustrate, switch back to the data tab and open the query designer. Add OFFICES to the list of
tables along with CONTRACT. When the join dialog poops up, you will have to manually set the join
condition as shown below.
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Join Table %
{7 T Join OFFICES Table with
[ Inner -l |COMTRACT |
OFFICES Fields COMTRACT Fields
EATCH_PZ DAY a NTP_ACT a
BATCH_PZ_MONTH - NTF_SCH r
CEFMS_ORG_CODE OBLIBIDVAR
DATYLIGHT SAWINGS OBLIGATED CONTRALCT AMT
DISPLAY SYMEOL 3 OBLIGATED_SA_aAMT ~
Fa OBLI_TOT
FLMAME OFFICE_ROUTE
FLEYMEOL OFFICE_SYMEOL
FL CODE v OMSITE COR o4
Joined Fields
OFFICES Field Operator COMTRACT Field
OFFICES. FLSYMEOL = COMTRACT OFFICE_SYMEOL

] | Cancel

7.4  Step 3 - Add the DISPLAY_SYMBOL field

On the fields list, add the DISPLAY_SYMBOL field
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R Query Designer

[A Available Fields

Tables Fields ]Calcs ] Groupl Search] Sart ] sS0L ]

Field Alias | Field 5QL lias | Table SAL Alas ~
BATCH_CEFMS_DATE DFFICES.BATC..  OFFICES
BATCH_CEFMS Dy DFFICES.BATC..  OFFICES
BATCH_CEFMS_MONTH DFFICES.BATC..  OFFICES
BATCH_F2_AFTER DFFICES.BATC..  OFFICES
BATCH_F2_DATE DFFICES.BATC..  OFFICES
BATCH_P2_Dii DFFICES.BATC..  OFFICES
BATCH_P2_MONTH DFFICES.BATC..  OFFICES
CEFMS_ORG_CODE DFFICES.CEFM... OFFICES
DAYLIGHTSAVINGS DFFICES.DAYLL.. OFFICES
DFFICES. OFFICES
FLN&ME DFFICES.FLNA..  OFFICES
FLSYMBOL DFFICES.FLSY..  OFFICES
FL_CODE DFFICES.FL_C..  OFFICES
MOD_PREFIX DFFICES.MOD_.. OFFICES
OFFICE_FLAGS DFFICES.OFFIC..  OFFICES
OFFICE_MANAGER DFFICES.OFFIC..  OFFICES
OFFICE_SEQUENCE DFFICES.OFFIC..  OFFICES
P2_DOWNLOAD_DATE DFFICES.P2_D..  OFFICES i
PARENTSYMBOL DFFICES.PARE.. OFFICES -
Selected Fields [~ AllFields
Field Alias Field SOL Alias Table SGOL Aliaz
FMT_CONTRAC . CONTRACTFM_ COMTRACT
PRO_NAME CONTRACT PR COMTRACT
AwD_ACT COMTRACTA . COMTRACT o
PROGRAM_TYPE CONTRACTPR.  COMTRACT
CURRENT_CON . CONTRACT O COMTRACT
DISPLAY_SYME_ DFFICES DISPL . OFFICES =
*

Cancel

Then, in the designer, add a DBText and set it to DISPLAY_SYMBOL
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RMS Report Designer [ de_rms.world J: Ex9

File Edit View Report Help

Data | Calc DES‘Q“lPlavlewl

h | ABEnEak G ATERTD®E AMRE

| DISPLAY_SYMBOL _v|[conTRacT j‘“mm R R ]

> .5 B8 |or Esd Taw wg | WE |
' ' e ' | L |;‘ e R B e

3

* Detail

* Faoter
0.

* ‘Summary

Object: DEText6

Left: 3.4063 Top: 0.0313 Width: 0.9687 Height: 01771 Y

7.5 Summary

This quick example shows how to properly join the contract table to the offices table to get the
DISPLAY_SYMBOL field for showing in reports
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8.1

Example 8 - EQuipment List

Overview

This report will list out the equipment for a selected contract. This will be a landscape report and will
involve columns with more than one data item. It will also show how to handle a memo text item where
the amount of text entered is unlimited. Also, getting the data for this report will involve querying
multiple tables and using some SQL expressions to get some of the values needed for the report.

|—| Equipment List
US Anmy Corps quip 11-Aug 07
of Englneers.
Egupment Makedodel Equipment Description Safe 7 First Day on ‘ Hours
D Serial Mo. Nates Last Inspected  Last Day on Site ‘ Authorized Run Remaining

W9128A-04-D0005 0002 AM 057421 FY05 & FY06, Veh Maint Fac

master sht mtl scissor lift master sht mtl scissor lift Tes 0BM5/2007

00000192 master sht mtl scissor lift QBMs/2007 QBMs2007 1} 95 0
v & ¢ scissor lift v & ¢ scissor lift Yes 0BMB/2007

00000193 v & ¢ scissor |ift 05/08/2007 05/08/2007 i] 72 0
swanson scissor lift swanson scissor lift Yes 06242007

000007194 swanson scissor lift 051272007 05122007 a 68 0
W & C drywall forklift W & C drywall forklift Ves 06/12/2007

00000195 B036 forklift 061272007 06/12/2007 0 ) 0

W9128A04-D.0013 0001 FY05 MCA PN 57422, Multi Deploy Fac

Skytrak 4290H

Skytrak Forklift-ret 4/11/06

Yes

12/30/2008

00000001 14861 Eguipment hours cummulative from 12621105 thraugh 1 2/30/05 (5 days x 6 (04/10/2006 (04/10/2006 40 64 i]
hrsiday).
JD310 310% Backhoe S/M TO3103G923743 Ves (01/09/2006
00000002 #5544 dawn 2.5 hours repair - right side outrigger does nat lft up. 01/23/2006 01/23/2006 il 1208 0

Eguipment pullsd ot of jobisits on 1101106

Returned to jobsite 1/407

Skills shown:

- Building Landscape Reports

- Using SQL expressions (Case, NVL, and Decode)
- Correlated Subqueries

- Formatting Fields

- Stretching Memos

- Using Regions

- Using Search Criteria to Contract(s)

- Grouping Data By Contract

- Simple Table Join

- Using a Shape as a Group Header Background
- Send to Front/Send to Back

8.2  Step 1- Planning the queries and Finding the Data

Your hardest task at times will be finding the data that you want in the RMS database. For this report,
we want data on equipment and its operated hours. In this case, the table name where the data is
located is rather deceiving. The table name is actually SAFE_CK. There are a few ways you can try to
find the data you are looking for. First, you should print out the RMS data dictionary. You can find it in
RMS under Reports>Library>Data Dictionary. Another thing you can try is to go into RMS to the
screens where the data you want is located. Select one of the fields and then Ctrl Right Click on it.

Here is the screen that comes up for the hours run edit box on the equipment screen. From this, you
can see the table and field name
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8.3

Data Fields f RAW_DATA Macro

RMSM&WI? ﬁ?fﬂﬂﬂ&ﬁﬂﬂ Formi Name frmEquipmentChecks
Table SAFE_CK Control Type TDBE dit

Field RUN_HOURS Control Name dbeHoursRun
i Show Complete Current Recard I Table Type

 Azenr At o ea8s £ Seienr Rl

Esenmplalzen ‘{ RMS_DATA TABLE=SAFE_CK: FIELD=RUN_HOURS }

Parcnpitn | siPasoamir

(] 9 |

All of the data we want for this report is available in the SAFE_CK table with one exception. We want
to print the first day on site and that is not stored with the equipment item. To get it, we will have to
look at the table that stores the actual hours for the equipment - EQUIP_HR. We want to join the
SAFE_CK table with the EQUIP_HR table and get the first day on site for each piece of equipment.
We will do this by using a correlated subquery in an expression in the query designer.

Also, we will want this report to handle multiple contracts so we will be doing a join in the query
designer with the contract table to get the contract number and title.

Step 2 - Load the Landscape Template

Add a new report and save it with the name of Equipment List. Form the design tab of the report,
select File>Load From File

RMS Report Designer [ de_rms.world J: EQList ‘._”EHE
Fle Edit View Report Help

Data | Cale  Design | Preview |

h | AEnmEEl | a0 ARepane® |(BRRE

[Fament 4 | [[ova e Sliezu === [A-2-| @ | T
&v-ﬁv;EH@ml@EHE:n‘éIua‘u;'HIE-e-e“IIWﬂD@\Wé|Inn| | O ﬂl é@l;&hﬁ|
En"""'l""""lz"""‘\s‘“""|n"""'|s"""'|s'“|““h““ B ER N F ! o' "0 [n
______________ L s
| :r.c.m.s. &_HUJR'_T_‘efJ_t_E-_'_s_t__ S R .M_M”!
(1]

-
10 FESEESEES
s Pags

* Footer
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8.4  Step 3 - Create the Query
Switch to the data tab in the report designer and select File > New > Query Designer and hit Ok.

From the list of tables, scroll down to SAFE_CK and move it into the list of selected tables.

R Query Designer.

Tables ]Fields | Cales | Group | Search| ot | 5oL |

Available Tables

Table

. SAFETY_EXPOSURE

SAFETY_EXPOSURE_HOURS
SCHEDULE_INFO
SCHEMA_LOG
SCHEMA_VERSION
SCURVE_TEMPLATE
SDEF_ACTRATY
SDEF_ACTRATY_HISTORY
SDEF_CALEWDAR_HISTORY
SDEF_DATA
SDEF_HOLIDAY_HISTORY
SDEF_PRECEDENCE_HISTORY

Table Hame ~
SAFE_CK
SAFETY_EXPOSUF
SAFETY_EXPOSUF
SCHEDULE_INFO
SCHEMA_LOG
SCHEMA_VERSIOM
SCURWE_TEMPLA’
SDEF_ACTIMITY
SDEF_ACTIVITY_H
SDEF_CALEMNDAR_
SOEF_DATA,
SDEF_HOLIDAY_H
SDEF_PRECEDENI

SDEF PROJECT HISTORY SDEF PROJECT H )
Selected Tables [~ Distinct
Tahle Tahle Mame SOL Alias Join Tupe

SAFE_CK. SAFE_CK SAFE_CK

R - i o~ - p— " - . -~ - /.

Now, switch to the Fields tab and select the fields as shown. These are the fields that we are
interested for our report.
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R Query Designer =13

Tables Fields l Calcs ] Group ] Search ] Sart ] SOL ]

Al Available Fields

Field Alias | Field 50L s | Table SOL Alias |

INSFECTION SAFE_CK.MSP.. SAFE_CK

LAST_Day SAFE_CK.LAST... SAFE_Ck

QAVERSION SAFE_CK.OAVE... SAFE_CK

GCYERSION SAFE_CK.GQCVE.. S&FE_CK

RE_INSPECT SAFE_CK.RE_I.. SAFE_CK

Selected Fields [~ AllFields
Field Aliaz Field S0L Alias Table 50L Alias

ITER SAFE_CE.ITEM SAFE_CK

MODEL SAFE_CK.MODEL SAFE_CK *
SERIAL SAFE_CK.SERIAL  SAFE_Ck

DS SAFE_CK.DS SAFE_Ck.

MOTES SAFE_CK.MOTES SAFE_Ck

COMD_AMNS SAFE_CK.CONW.. SAFE_CK

RUN_HOURS SAFE_CK.RUM..  SAFE_CK

HRS_REMAIMNIMNG SAFE_CK.HRS_... SAFE_CK »
AUTH_HOURS SAFE_CK.AUT..  SAFE_CK

COMTRALCT_ID SAFE_CK.CON.. SAFE_CK

Ok | Cancel |

In addition to the safe_ck table, we want to get some information from the contract table. Specifically,
we want the contract number and delivery number along with the title. To get that data, we need to join
SAFE_CK with CONTRACT. Switch back to the tables tab and add CONTRACT to the list of selected
tables. A table join dialog box will appear.

Join Table Dialog: It's important to understand how this dialog works. Join Type tells the database
what to do when it doesn't find matching rows between the two tables. Lets use an RMS example to
illustrate. Lets say you want to join the CONTRACT table with the OFFICES table. We know that an
Office can have many contracts and that a contract can be assigned to no office, or to one office. Lets
say that for our join, that OFFICE is the Left table and CONTRACT is the right table.

Inner: If a match is not made between both tables, then no row is inserted in the result set. In our
example, if we have an office with no contracts, then the office will not be included. Likewise, if we
have a contract with no office, it will not be included either. Only those records where an Office and a
Contract match will be included in the result set.

Examples:

SELECT OFFICES.FLNAME, CONTRACT.FMT_CONTRACT_DELIVERY FROM OFFICES INNER JOIN CONTRACT ON
OFFICES.FLSYMBOL=CONTRACT.OFFICE_SYMBOL

SELECT OFFICES.FLNAME, CONTRACT.FMT_CONTRACT_DELIVERY FROM OFFICES, CONTRACT WHERE
OFFICES.FLSYMBOL=CONTRACT.OFFICE_SYMBOL

(These are equivalent, just using different syntax)

Outer joins do not require there to be a matching row in both tables. There are three types of outer
joins:

Left Outer: All records from the Left table will always be included - even if there is no matching record
in the right table. In our example, all offices will be included even if they have no contracts. If a
contract is not assigned to a valid office, however, it will not be included.

SELECT OFFICES.FLNAME, CONTRACT.FMT_CONTRACT_DELIVERY FROM OFFICES LEFT OUTER JOIN CONTRACT ON
OFFICES.FLSYMBOL=CONTRACT.OFFICE_SYMBOL
SELECT OFFICES.FLNAME, CONTRACT.FMT_CONTRACT_DELIVERY FROM OFFICES, CONTRACT WHERE
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OFFICES.FLSYMBOL=CONTRACT.OFFICE_SYMBOL(+)
(These are equivalent. Oracle allows the use of (+) to indicate which table can have missing records.
Think of it like oracle is adding (+) some blank records to get a match)

Right Outer: All records from the Right table will always be included - even if there is no matching
record in the left table. In this case, all contracts will be included even if they do not have a valid office.
If an office has no contracts however, it will not be included.

SELECT OFFICES.FLNAME, CONTRACT.FMT_CONTRACT_DELIVERY FROM OFFICES RIGHT OUTER JOIN CONTRACT ON
OFFICES.FLSYMBOL=CONTRACT.OFFICE_SYMBOL

SELECT OFFICES.FLNAME, CONTRACT.FMT_CONTRACT_DELIVERY FROM OFFICES, CONTRACT WHERE
OFFICES.FLSYMBOL(+)=CONTRACT.OFFICE_SYMBOL

(These are equivalent. Oracle allows the use of (+) to indicate which table can have missing records.
Think of it like oracle is adding (+) some blank records to get a match)

Full Outer: All records from the Right table will always be included AND all records form the left table
will be included - even if there is no matching record in the corresponding table. So, if an office has no
contracts, it will still be included and if a contract has an invalid office, it will still be included.

SELECT OFFICES.FLNAME, CONTRACT.FMT_CONTRACT_DELIVERY FROM OFFICES RIGHT OUTER JOIN CONTRACT ON
OFFICES.FLSYMBOL=CONTRACT.OFFICE_SYMBOL

(Oracle's special (+) syntax does not support full outer joins - you must use the explicit syntax)

NOTE: Full outer joins are not functional in the report tool - They work as a full inner join due to a bug
with the report designer.

To make this dialog clear as far as knowing which type of join to use, always remember that the report
writer is treating the table in the combo box (SAFE_CK) in this case as the LEFT table and that the
table on top of the dialog box (CONTRACT in this case) is the RIGHT table.

If you are still confused about joins or want more examples, you may want to check out
Wikipedia link on SQL Joins, Easy Oracle SOL Book

So back to our actual join for this report, we only want to join based on the contract_id field and we
want to use an inner join. Make your join dialog look like the one below and click Ok.
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Pl ook

Join Type

|Inner

El

Jain COMTRALCT Table with

ISAFE_CK

=

El

COMTRACT Figlds Left Table [ SAFE_CK Fields
ACO_AGEMT_CODE AUTH_HOURS .
ACTIVITY WARIAMCE COMND_AMS
ACT_PER COMNTRACT_ID
ACT_PER_LESS_STORED 05
ACT_PLCMT HRS_REMAIMING
ACT_TOT INSPECTION
AE_ADDRESST ITEHM
AE_ADDRESS2 LAST DAy
AE ADDRESS3 4 MODEL .’
Joined Fields
COMTRALCT Field Dperatar SAFE_CK Field

‘CONTRACT.CONTRALCT ID

SAFE CK.COMTRACT ID

o]

Cancel

Now that our tables are joined, jump over to the fields tab and select the
FMT_CONTRACT_DELIVERY field and the PROJ_NAME field form the contract table as shown here:

R Query Designer.

Tables Fields ] Calcs ] Group ] Search ] Sort ] SOL ]
[8] Awvailable Fields
Field Alias | Field 5OL Alias | Table SOL &ias | ~
PROG_AMT COMTRACT PROG_AMT COMTRACT
PROJECTED_COMTRALCT COMTRACT.PROJECTED_COMTRACT  COMTRACT
FROJECTED_COMTRACT_... COMTRACT.PROJECTED_COMTRACT.. CONTRALCT
FROJECT_STAGE COMTRACT.PROJECT_STAGE COMTRALCT
PROJ_DS COMTRACT PROJ_DS COMTRALCT
FROJ_EMGR COMTRACT.PROJ_EMGR COMTRALCT

COMTRACT.PROJ_wI_CODE COMTRALCT o
Selected Figlds [~ AllFields
Field &lias Field SOL Alias Table SOL Alias
ITEM SAFE_CK.ITEM SAFE_CK
MODEL SAFE_CK.MODEL SAFE_CK ﬁ
SERIAL SAFE_CK.SERIAL  SAFE_Ck
DS SAFE_CK.DS SAFE_Ck.
MOTES SAFE_CK.MOTES  SAFE_CK
COMD_AMS SAFE_CK.COM...  SAFE_Ck
RUM_HOURS SAFE_CK.RUM... SAFE_CK
HRS_REMAINIMG SAFE_CK.HRS_.. SAFE_Ck ﬂ
AUTH_HOURS SAFE_CK.AUT..  SAFE_CK
COMTRACT_ID SAFE_CK.COM...  SAFE_Ck
FMT_COMTRAC... CONTRACT.FM.. COWTRACT
PROJ_MAME COMTRACT.PR... COMTRACT

Ok | Cancel
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8.5

Step 4 - More Query Work - SQL Expressions

In this step, we will refine our query in 3 ways:

- We will show another way to handle the Y/N fields so that they display Yes or No.

- The report shows the last inspection. What we want to do is use the RE_INSPECT field if it has a
value, otherwise, we will use the INSPECTION field

- We are still missing the first day on site, which is not stored with the equipment. We will have to use
an oracle expression to get that from the table that has the hours in it.

We'll start with the Y/N field. As before, we don't want our report to show Y or N, we want Yes or No
instead. In the query designer, switch over to the Calcs tab and move the COND_ANS field into the
selected list, select Expression from the function type dropdown, and past in this oracle expression:

decode (cond_ans,"Y','Yes','No")

This is an Oracle function that takes its first parameter and then starts comparing it to pairs of
parameters. When the first parameter matches the first parameter of a pair, the result will be the
second parameter of the pair that matched. In this case, the decode is saying if cond_ans hasa'y,
then return Yes else return No.

Tables] Figeldz Calcs l Group ] Search] Sort ] SoL ]

[ Available Fields

Field Alias | Field SOL Aias | Table SOL Alias | »

AUTH_HOURS SAFE_CK.AUT..  SAFE_CK

COMD_AMS SAFE_CK.COM... SAFE_CK

CONTRACT_ID SAFE_CK.COM... SAFE_CK

DS SAFE_CK.DS SAFE_CK.

HRS_REMAINING SAFE_CK.HRS_... SAFE_CK

INSPECTION SAFE_CK.INSP.. SAFE_CK

ITEM SAFE_CK.ITEM SAFE_CK

LAST_ DAY SAFE_CK.LAST.. SAFE_CK

MODEL SAFE_CK.MODEL SAFE_CK

MNOTES SAFE_CK.NOTES SAFE_CK

QAVERSION SAFE_CK.QAVE.. SAFE_CK

GQCYERSION SAFE_CK.OCWE.. SAFE_CK

RE_INSPECT SAFE_CK.RE_l.. SAFE_CK

RUN_HOURS SAFE_CK.RUM.. SAFE_CK

CERIAL CAFE MK CERIAL CAFE 1K A

Calculations

Field &lias Field SGL Aliaz Table SOL Alias Funiztion Exprezsion

decode [cond_ans,"Wes'... decode [cond a..  SAFE_CK Expression ﬂ |decode [cond_ans " "es' Ma'] J

=

,Tl Cancel |

Click on the field alias column and change the name of our calculated field to V_COND_ANS.

Now, lets handle the last inspection date. This time we will use Oracle's NVL function which allows
you to specify a value to return in case the first parameter is NULL. Select the RE_INSPECT field and
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move it into the selected list, set function to Expression, and past in this code

NVL(safe_ck.RE_INSPECT,safe_ck.INSPECTION)

Then click on the first column and change the alias to V_REINSPECT

R Query Designer, Mi=1E3
Tables] Field: Calcs l Group ] Sealch] Sort ] sSoL ]
B Available Fislds
Field Alias | Field SOL Alias | Table SOL Alias | ~
AUTH_HOURS SAFE_CK.AUT..  SAFE_CK
COND_ANS SAFE_CK.COM...  SAFE_CK
CONTRACT_ID SAFE_CK.COM...  SAFE_CK
D5 SAFE_CK.DS SAFE_CK
HRS_REMAINING S&FE_CK.HRS_... SAFE_CK
INSPECTION SAFE_CK.INSP.. SAFE_CK
ITEM SAFE_CKTEM SAFE_CK
LasST_Day SAFE_CK.LAST.. SAFE_CK
MODEL SAFE_CK.MODEL SAFE_CK
MNOTES SAFE_CK.NOTES  SAFE_CK
QAVERSION SAFE_CK.QAVE.. SAFE_CK
QCYERSION SAFE_CK.QCVE.. SAFE_CK
RE_INSPECT SAFE_CK.RE_I.. SAFE_CK
RUN_HOURS SAFE_CK.RUM..  SAFE_CK
SERIAL SAFF MK SFRIAL  GAFF K v
Calculations
Field Aliaz Field SOL Alias Table SAL Aliaz Function E xpression
decode [cond_a..  SAFE_CK Expression decode [cond_ans,™" e’ Mol ﬂ
ML(safe_ck.R.. SAFE_CK Expression MWL [zafe_ck RE_INSPECT zafe_ck INSPECTION)
|
,Tl Cancel |

Finally, we need to get the first day on site from the equip_hr hours. What we want is the earliest date
that hours were reported to get this, select the inspection field and move it into the list of selected

fields. Then change the function type to Expression and enter this SQL

(select min(insp_date) from equip_hr where contract_id=safe_ck.contract_id and item=safe_ck.item)

This expression will become a correlated subquery and will get the earliest date for each row in the

main query. Change the field alias to V_FIRSTDAY.
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8.6

R Query Designer.

Tables] Fields Calcs l Group ] Sealch] Sart ] SOL ]

B pwailable Fields

Field Alias | Field 50L s | Table SOL Alias | A

AUTH_HOURS SAFE_CK.AUT..  SAFE_CK

COMD_AMNS SAFE_CK.COM...  SAFE_Ck

COMTRACT_ID SAFE_CK.COM...  SAFE_CK

D5 SAFE_CK.DS SAFE_CK

HRS_REMAIMIMG SAFE_CK.HRS_... SAFE_CE

INSPECTION SAFE_CE.IMSP... SAFE_Ck

ITEM SAFE_CK.ITEM SAFE_CK

LAST_Day SAFE_CK.LAST.. SAFE_CK

MODEL SAFE_CK.MODEL SAFE_Ck

MOTES SAFE_CK.MOTES SAFE_CK

QAVERSION SAFE_CK.QAVE... SAFE_CK

QCVERSION SAFE_CK.OCWE... SAFE_Ck

RE_IMSPECT SAFE_CK.RE_l... SAFE_Ck

RUN_HOURS SAFE_CK.RUN.. SAFE_CK

CERIAL CACE MK CERIAL  CACE ¥ L

Calculations

Field Alias Field SOL Alias Table 50L Alias Function Expression

W_COND_AMNS decode (cond_a..  SAFE_CK E spressian decode [cond_ans, " es' Mo ﬁ

W REINSPECT  Mvlfsafe ck.R.. SAFE_CK E spression NVL(safe_ck RE_INSPECT safe_ck INSPECTION]

W_FIRSTDAY [select minfinsp_... SAFE_CK Expression L fl|date] from equip_br where contract ontract_id and item= ﬂ
Ok | Cancel |

Step 5 - Enable the query to allow the user to select contract(s)

In this step we will set up the query to let the user pick a contract when the report runs. Or, they can
pick multiple contracts. This is a simple task. Switch over to the Search tab on the query designer and
move the SAFE_CK.CONTRACT _ID field into the selected list of fields. Then, set the operator to In
List and set AutoSearch and Mandatory to Yes as shown here
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R Query Designer.

Tables ] Fields ] Calcs ] Group  Search l Sart ] SOL ]

O, Available Fields

Field Alias | Field 50L s | Table SOL Alias | ~

AUTH_HOURS SAFE_CK.AUT..  SAFE_CK 0

COMD_AMS SAFE_CK.CON.. SAFE_CK

CONTRACT_ID SAFE_CK.COM.. SAFE_CK

D5 SAFE_CK.DS SAFE_CK

HRS_REMAINING S4FE_CK.HRS_... SAFE_CK

INSFECTION SAFE_CK.NSP..  SAFE_CK

ITEM SAFE_CK.ITEM SAFE_CK

LAST_Day SAFE_CK.LAST.. SAFE_CK

MODEL SAFE_CK.MODEL SAFE_CK

QAVERSION SAFE_CK.QAVE.. SAFE_CK

QCYERSION SAFE_CK.GOCWE.. SAFE_CK

RE_INSPECT SAFE_CK.RE_|.  SAFE_CK

RUN_HOURS SAFE_CK.RUM.. SAFE_CK

SERIAL SAFE_CK.SERIAL SAFE_CK

APAAREMT © CAMTRACT AT CAMTRACT v

Criteria

Field Operataor Walue AutoSearch | Mandatary Show All

SAFE_CK.COMT... InList f'es Yes
2]
=

Ok | Cancel |

This is a special setup that will tell the report engine to popup a dialog and ask the user which
contracts to include in the report when it gets run.
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8.7

| Search | | Filter | | Clear Filker |
Select Contract

Caontract |D |F'ru:uiec:t M ame Caontract Mo A
_|J3000606 A/C Equipment Performance pgrades, MCEH DACADY-96-D-0031 060
_|J3000347 A/C Equipment Perfornance Upgrades, MCEBH DACARY-96-D-0031 0006

J3000630 Abatesbdsbestos & Lead Containing Paint WO 280-06-P-0010 Ma,
Dot A/ Improvements-Hangar 103, KMC 4 C487-96-D-0031 0002
_|J3000346 Erergy Eff Lighting Upgrades, MCEH DACART-96-D-0021 0005
_|J3000587 Erergy Eff Lighting Upgrades, MCEH DACAST-98-D-0031 0501
_|J3000353 1013 - LYZ, Ine. DACARZ-03-D-0ME M
_|J3000350 |00 - Goto Construction, Inc. DaCAR3-03-D-0013 Ma,
_|J3000349 D10 - Alan Shintani, [nc. DACARI03-D-002 MA 2
£ >

Clear Selected Contracts |

Selected Contracts

Cantract 1D |F'ru3ieu:t M ame Cantract Ma. L
_|J3000630 Abateddsbestos & Lead Containing Paint WA 280-06-P-0010 Ma,
_|43000347 A/C Equipment Perfornance Upgrades, MCEH DACAZY-9E5-D-0031 000E
L m A4C Improvementz-Hangar 103, KMCEH DACAZY-96-0-0031 0002

w
£ >
Finished | | Cancel

Contract Record Count: 345 *You have zelected 3 contract(z].  Search Test:

Step 6 - Sort the query

The final step for the query is to get it into the proper sort order. Since the user may select multiple
contracts, we will be adding groups to the report to separate the equipment by contract. Within a
contract we want the items sorted by equipment ID number.

Switch to the Sort tab and select CONTRACT _ID and then select ITEM.
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R Query Designer.

Tablesl Fields I Calcs I Groupl Search Sort ISQL I
& available Fields

Field Alias | Field SAL Allas | Table SOL Alias | ~|
AUTH_HOURS SAFE_CKAUT..  SAFE_CK W
COND_ANS SAFE_CK.COM..  SAFE_CK
D3 SAFE_CK.DS SAFE_CK
HRS_REMAINING SAFE_CK.HRS_. SAFE_CK

SAFE_CKINSP..  SAFE_CK
SAFE_CK.LAST.. SAFE_CK

MODEL SAFE_CK.MODEL SAFE_CK
NOTES SAFE_CK.NOTES  SAFE_CK
OAVERSION SAFE_CK.OAVE.. SAFE_CK
OCVERSION SAFE_CK.OCVE.. SAFE_CK
RE_INSPECT SAFE_CK.RE_L.  SAFE_CK
RUN_HOURS SAFE_CK.RUM..  SAFE_CK
SERIAL SAFE_CK.SERIAL  SAFE_CK
ACO_AGENT_CODE COMTRACTAC.. COMTRACT
ACTRATY WARIAMTE CORMTREACT AT FMOMTRATT :I
Sort Fields [~ Matural Order
Field Alias | Field SOL Alias | Table SALAkss | Desclz> 4 |
COMTRACT_ID  SAFE_CK.COM..  SAFE_CK |
ITEM SAFE_CKITEM  SAFE_CK
|

Ok I Cancel |

8.8 Step 7-Add Column Titles
Save the report and then switch over to the Design tab.

Add labels to the blue column header for each of the data columns that we will use. Add lines as
shown below for the hours section of the report.

RMS Report Designer [ de_rms.world ]: EQList

File Edit WYiew Report Help

Data | Calc  Desin |Prewew|

h AHEumE=(| Ao AERLL"S 808 @
| | |[eia =] sl msru = =lA-2- 4@ | %
B owRad men wE | WME DSH OSSR i@
e 1 T - L B E R
‘ Equipment Description | i _. Fi nJl dours
Lo Metes LastInspectedd Last Dav.on Stel | Authorized Run: Remainina:
* Header
Lo Dol =
“~ Detall
o Page 1
“ Faoter
£ 11 ] ]
Ready. |Left: 0 Top: 0 [width: 0 Height: 0

IMPORTANT POINT ON MEMOS
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8.9

RMS Report Designer [ de_rms.world ]: EQList

File Edit Y“iew Report Help

Data | Cale  Design | Preview |

h | AdEmeut | aee | AEBRR S (B0 B
| ‘ | s ~IE j\nlg\%%%él&dhl&ﬂ\ﬁﬂl
s|rg [ ww a8 |cw[Ees  Taoa  meg WE DEH USSR | L BB
'"I""g"'\"‘|3"'I"'|“"\"‘|5"'I"'|E"'\' [ Ilﬁl R | R

| Al

0 |F\ egion ]

~ Detail

=l i I 2
R@/‘ Left: 9,7083 \Tng: i |Wid-th: 0.6771 |Hﬂht: 01458 d

Step 8 - Add a Region for the detail Band

Anytime you are going to have a memo or other variable height object, ALWAYS use a region within
the band. This will eliminate some quirky behavior when your detail band is near a page break. By
putting all of your detail items in a region, you will have more control over keeping the items grouped
together.

To add a region, click on the Region toolbar button and drop a region into the detail band. Once you
have the region in the band, right click and select ParentWidth, ParentHeight, Stretch and
KeepTogether. This will make the region occupy the entire detail band it will set it up to stretch with
our notes memo.

RMS Report Designer [ de_rms.world ]: EQList |Z”E”i

File Edit View Report Help

Data | Cac  Design | F'rewew' Region Toolbutton

L AEEhEEN | A8 AT e wewwEe B0R @
| | | [l =IE -l msu === A-s-|9v@A B
»-4-=m=|0E @ &8 | cr|Ead [ Tan wi [ WE DSH| USR | BB

v ' o R N v v 1 o] " et 1o |

Mo R R

[P, T [ '

U8 Army Cosps.
- of Englneers.. - -

" Header
- |Regionl

* Detal

 Footer

] I ] ]
Ready. Left: 92,7083 \Tog: 0 |W|d-th: 0.6771 |Hﬂht: 0.1458 d
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8.10

8.11

Step 9 - Add the DBText Objects

Now, add the DBText objects to print the data within the region on the detail band. Add all of the fields
as show below - Do not add a DBText object for the notes, it is special. Adding the DBText objects is
straightforward. Just drop a new DBText object into the region and then set the field to the appropriate
field from the query for each item.

RMS Report Designer [ de_rms.world ]: EQList |Z”i”i

File Edit WYiew Repart Help

Data I Calc  Design | Praviewl

h | ABEnect | a2 A2 RRa"G |(BER B

I ‘ “Aﬂal ;”B j‘ B 7 U
== me BE  swer2a | Tes @ | WE DSHE

! B | A [T iy

R

s

. UE Army Corps. . .
. ofEnginesrs. . T

- ® |Region1

“ Footer

= i I [
Ready, Left: 0 \Tog: i |Wid-th: 0 |Hﬂht: i

Step 10 - Add the DBMemo Object

Now, add a DBMemo object for the notes field and position it as shown.

RMS Report Designer [ de_rms.world ]: EQList |Z||i||£
File Edit WYiew Repart Help

Data | Calc  Design | Freview |

h | AgEnect | a2 |AEBRR®% (B0R B
DEMemo Toolbuttan I IAHGI ;”E
H.d-==1 ¢ 8 ow|Ead  Tod wd | l4E
L

- ® |Region1

Q. i | &J

Ready, Left: 0 \Tog: i |Wid-th: 0 |Hﬂht: i
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In order for the report engine to allow the DBMemo to grow vertically as needed, you have to set it to
stretch. Right click on the DBMemo and select stretch. Now, when the report runs, the dbmemo object
will size vertically as needed based on the text in the database.

8.12 Step 11 - Add Grouping by Contract
To clearly separate the data by contract, create a group in the report. A group allows you to create a
header and footer to enclose sections of the report. In our case, we want to have a header every time
we start a new contract.

From the Report pulldown menu, select Groups

Report Designer [ de orld J: EQ m]
File Edit Wiew Help
Data I Calc bata... L
Rlag ™ 5| AEURTL®® Ome @
I v Header “A”al L”E j‘BIﬂ‘ §§§|A'!'|¢D\ﬁ!ﬁ‘
B - F -1, Footer B B |uD‘I]E'|I|,=‘E'$‘=':||"Iﬁ'“D‘“u_“Dﬂ“§ ||HD|E|JD#H|U§|§|%E‘
Bo' ] Pasestre B ‘
m e —
i . Grups.., @ |pocaacaascaaies

UE Arih Cutline Settings...
o MBEH:T:a Find Text Settings...

Equpmen  Portrait
[ 1] B v} v Landscape

Cache Pages
Pass Setting [

~ Detail
o Page 1
“ Footer

Units >

< i | 2|

Ready. Left: 0 \Tn£: i |Wid-th: 0 IHﬂht: i

From the groups dialog box, select the FMT_CONTRACT_DELIVERY field and set the options as
follows:
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8.13

Groups | S&FE_CK.FMT_COMTRACT_DELMERY ﬂ

Group[OLSAFE CE.FMT COMTRACT DELMERY

Add
Inzert |

Break On
f* [ata Field " Cugtam Field

On Group Change
[ Start new page

=

Mew page when lezz than ICI

[v Keep group together

[v Reprint group headers on subzequent pages

k. Cancel

Note: Because groups are based on a change in field value, the field on which a group is based
should always be used to order the records. You may remember that the query for this report is
ordered by the 'fmt_contract_delivery' field. You must always order the records by the fields you intend
to use for groups because ReportBuilder will not sort records for you.

The options on the group dialog box are self explanatory. If you want each group to start on a new
page, you can check the box "Start new Page". Keep in mind, that this may lead to a lot of white space
on your reports and will make your reports take up more pages. Keep together is an option that tries to
keep the data for a group together as much as possible. Again, this may lead to more white space on
the report as the engine might decide to start a group on a new page to keep it together.

Click Ok to add the group.

Step 12 - Design the Group Header

Now that we have added a group, we have to design the header for the group. In our case, we just
want to print the contract number and title for each contract.

Notice, that when you add the group, there is no space created for your group header. To add some
space, grab the group header with your mouse and drag it downward
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RMS Report Designer [ de_rms.world ]: EQList

File Edit Y“iew Report Help

Data ICaIc DES\Q”'F‘raviewl

h | AdEmeEuit | a2 AREBRR® (D6 B
IAHaI L”E j ‘ B 7 U ‘
|ow|E2a | Toed msg | WME DS

T Y I e Lo

2 il
] 4 m |

i

o

(]

L Motes Lastinsnected Last Dav on Sie | Authorized

“ Header Mo space for group
~ Group Headei[O]. FMT_COMTRACT_DELIVERY header

Regionl

o

LAy
i

" Detal

™ Group Footer(0]: FMT_COMTRACT_DELIMERY
L9 Page 1
“ Footer

il | 2| -

Left: 0 Top: 0 [width: 0 |Height: 0

After making space for the header, the group header band should look like this:
RMS Report Designer [ de_rms.world ]: EQList

File Edit WYiew Repart Help

Data IEaIc Design | Praviewl
h | ABEnect | a2 A EBRR®% (D6 B
| ol ~IE A-2- | vE TE

[Pss | 70w

R SN 5 et A LI R AL Tl

* Header

Lo TS pace createdalter | oLl

= dragaing downward

* Group Header O
- ® |Region1 i

* Detal

* Group Footer0]: FMT_CONTRACT_DELIMERY
o

Page 1 =
“ Footer

Il | =) -

|Left: 0 Top: 0 width: 0 |Height: 0

Now, follow these steps to design the group header.

- Add a shape object for the background of the group header. Set it to parentheight and parentwidth
(right click for these settings) and set its color to grey.

- Add a DBText object and set it to use the FMT_CONTRACT_DELIVERY field. Make the font Bold to
make it stand out more.

- Add a DBText object for the contract title and set it to use the PROJ_NAME field

Your design should look something like this:
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8.14

RMS Report Designer [ de_rms.world ]: EQList

File Edit Y“iew Report Help

Data | Cale  Design | Preview |

h | AdEmeut | aee | AEERR®m (E0R B
IAHaI L”E

Xl miu

of* D&

LEEERELE T B

| WE| | D@

[P Lo

2 il
:{ m |

| | i o

I’

i

o

‘Fistoayen? |

Lastinsnected Last Dav on Sie

* Group Header[0]: FMT_CONTRACT_DELIVERY

Regionl B

™ Detail
™ Group Footer0]: FMT_COMTRACT_DELMWERY

Page 1
“ Footer

51 ]

|

Left: 0 Top: 0 [width: 0 |Height: 0

Summary

Save your report and preview it. Also, be sure to run it from outside the designer to see how the
contract selection screen works.

This report showed more advanced concepts including some oracle expressions and grouping. It also

showed how to use a region and how to make a DBMemo stretch with the actual data.
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9.1

Example 9 - Contract Value History

Overview

This report will show the entire history of a contract's value in chronological order. It will include a
running total so you can see the value of a contract at each point in time as well as a grand total for
the current contract amount. This is an interesting report in that it needs to get data fro award and for
mods and treat them like they are one dataset. To do this, we will create a view. Also, we will create
our first subreport and this report will have 2 data pipelines joined together in the designer.

L -
V8 P Corre Contract Value History 16-Aug-07
of Englhaers.
pod Apoitaf Rurng Corrae
DACAZ3-02-C-0006 F¥02 MCA, WBR, Ph 64, Modular Ofc Bldas.
05/28/2002  Contract Awarded %2997 000.00 $2 997 000.00
1142002002 ROOOO1 “Warious chgs due to "exceptional treeg” §75,000.00 $3,072 000.00
01/08/2003  ROOOOZ “arious chas due to "exceptional trees” (%28 .235.000 $3.043 7B5.00
02/03/2003  ROOOO3 Fire rated roll up doors, 2 ea $12 580.00 $3 055 ,345.00
03/24/2003  ROODO7 Admin - Payment Office Change §0.00 $3 055 ,345.00
040742003  ROOOO4 Conc encasefreinforce telephone duct FE0E.00 $3,055 9535.00
05/19/2003  ROO0DS Provide Cat SE LAKN ILO Fiber Optic F189.00 $3.057 142.00
05/23/2003  ROODDG Extinguishers & Outlets $15000.00 $3072,142.00
07292003 ROOOOZ “oicedData outlet and fire extingishers $4.430.00 $3076 57200
Current Contract Amount $3.076 572.00

DACYYE3-02-C-0004

For Four Flood Contl Proj, 1sle of HI

09/23/2002
06/10/2003
07/25/2003
03/15/2003
10427,/2003
11/06/2003
11426/2003
02/08/2004
03/04,/2008
03/16/2006
03/30/2006

Contract Awarded

RO0001 Additional Repairs @ Paauau (MTF)
ROO00Z Additional Repairs at Paauau

RO0003 Repair Addtl Joints @ Alenaio Stream
RO000S Alenaio Strearmn Repair ltem &
ROO00E Addtional Repairs & YWailoa

ROO0O7 Delete Installation of Perm Project Sign
ROODDS Repairs @ YWWailoa and YWaiakea Uka
ROOC10 Definitize Final Quantities

ROO00S Reclassify Type of Waters at Wailoa Strm

ROOD11 Admin Changes to Mod ADODOS

$3.766,121.00
$80,000.00
{§4.500.00)
54 548.00
$10,500.00
5167 .,000.00
(17 060.00
$83,395.00
§0.00
$675,000.00
§0.00

$3.766,121.00
$3.846,121.00
$3.841621.00
$3 846 269.00
$3 856 7B83.00
$4.023 769.00
$4 005 703.00
$4 095 107.00
$4.095107.00
$4,770,107.00
$4 770,107.00

Current Contract Armount

$4.770,107.00

Skills shown:

- Multiple datapipelines and linking pipelines together

- Creating a custom view for a report

- SQL Union

- Subreports

- Running Totals
- Grand Totals
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9.2

9.3

Step 1 - Load the Standard Portrait Template and Set the basic
report items

From the designer, load the standard report template into the designer. Change the title of the report
and add column headers for our 4 columns of data as shown:

RMS Report Designer [ de_rms.world ]: NewRepEx4
File Edit Vview Repart Help

Data | Calc  Design | Preview |

L ABEnEEl A28 | ADERERe® | ARA @

[ | | [Brd i - | B 1
6.4 . == | mm|e8 | sr|(Eas | Tom | owed | WE|
Y A Y L A

T . USArmyCerps. . .

A Eng asrr. || e————
o Act Description;
‘ e LoAdtion L Amount
“ Header
e Dol Dol Dol R
* Detail
L Page 1

" Footer
* Summary

Left: O Top: O ‘Width: 0 Height: 0 ]

Step 2 - Create a View for the detail data

We want to combine data for award and mods and print that data out in our report. Unfortunately, the
award data is in the contract table and the mod data is in the MOD_LOG data. In this case, we don't
want to do a simple join where we combine mod data and award data into the same row, instead, we
want the award data to have its own row and the mod data have its own rows as well. What we need
is an SQL Union. A union takes to like columned result sets and combines them so that they look like
one result set. The trick here is to make the contract table data and the mod_log table data look like
columned. Here is the SQL to do it.

select contract_id, 'Contract Awarded' as v_text, awd_act as v_date, award_contract as v_amt from
contract

union

select contract_id, mod_no||' '||mod_ds as v_text,govsig_date as v_date, mod_tot as v_amt from
mod_log

We are just tricking the database into treating the two tables like they have the same columns and
then we are unioining them together. To make that SQL usable in out report, we will create a view.
You should use a view whenever your SQL gets too complicated for the report engine to handle. To
add a view to our report, switch to the data tab and select File > Create View
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RMS Report Designer, [ de_rms.world |: NewRepEx4

Mew, .,
Close. ..

Import...
Merge..,
Expart...

Import From File...
Expaort Ta File. ..

Launch I3GL

Create Yiew
Save Report With Wiew To File
Load Report With Wiew From File

The view browser will be displayed. Click on add view:
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View Browser

| [ViewName ___________|vi
»

=

addView || Edtview || Delets View

Name the view VALUE_HISTORY and paste this SQL into the SQL editor

select contract_id, 'Contract Awarded' as v_text, awd_act as v_date, award_contract as v_amt from
contract

union

select contract_id, mod_no||' '||mod_ds as v_text,govsig_date as v_date, mod_tot as v_amt from
mod_log
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9.4

Add / Edit View

Wiew Mame
[VALUE_HISTORY

Yiew Description

“igw to combine contract eward with contract mod armounts)

SQL Editor
1 |[zelect -::Dntract_id, "Contrict Awarded' 23 v text, awd
2 |union
3 |zelect chtract_:i_d; mod nol| " "||mod ds as v text,.govss
‘ )
Create View

Click on create view and your view will be created. Now, when we return to the query designer, we will
be able to use this view just like any other table.

Step 3 - Create 2 Data Pipelines

We will create two data pipelines for this report. One with the basic contract information and the other
with the details contract value information. This way we can create a subreport for the detail data and
total control over it.

Create a new query using the query designer. Select the CONTRACT table and chose the three fields
as show below:
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CONTRACT '

& EmaETQs |

M ame I Type | Size |
[H COMTRACT_ID Shing 25
[CH FMT_COMTRACT_DELMER™ String 22
[H FROJ_MAME Shing a0

Next, create a second datapipeline using the RBVU_VALUE_HISTORY view we created earlier and
select the following fields

RBYU_¥VALUE_HISTORY linked to CONTRACT .

& EmaETQa & ¥

Mame | Type I Size |
[f] CONTRACT_ID String 25

[H] v_amT Double

[H] v_DATE DateTime

[ Y_TEXT String 47

Now, join the two pipelines together by grabbing the CONTRACT_ID field in the
RBVU_VALUE_HISTORY table and dragging it over to the CONTRACT_ID field in the CONTRACT
table. This will create a link as shown below. This means that each time the contract table traverses a
record, then the RBVU_VALUE_HISTORY will traverse all records where the CONTRACT _ID
matches the current CONTRACT _ID in the contract table.
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RMS Report Designer [ de_rms.world ]: NewRepEx4

File

Data ]Ealc 1 Design] Previawl

OR L ON

DNTRA RE A H R ked to RA
B EneTqs R B0 TqE &
Mame | Type | Size | Mame | Type | Size |
[B] CONTRACT_I String 25 L = [A CONTRACT_ID String 25
[B FMT_COMTRAL Sting 22 [A) V_aMT Double
[B] FROJ_MNAME  Sting 40 [A ¥_DATE DateTime
[A V_TEXT Stiing 47

9.5

Ready,

Step 4 - Add a subreport for detail data

Next we are going to add a subreport for our detail data. This will allow us to treat the detail data like
its is its own separate report so we can get it just the way we want. Think of a subreport as a report
within a report.

Switch back to the Design tab and drop a subreport into the detail band. You will notice a new tab at
the bottom of the designer for the subreport. You can switch back and forth between the main report
and your subreports by clicking on these tabs:
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RMS Report Designer [ de_rms.world ]J: NewRepEx4
File Edit Wiew Report Help

Data | Cale  Desion | Freview|

| AEEnEEh | aee| | ATEREL®E/ 8068 B

FBVLI_VALUE_HISTORY I = ~h3 “llpru |[[e==- |A-2-| &8 | l‘;\!i‘
d-4-==08 =9 28 ar|k29 Tad | wd WE OSH DSR4 B@
- | N A A A 0 M A

T . USAmmyCorps. . .
B L

< b epa BV VALOE STaR 1 e e
“ Detai

“ Faoter
“ Summary

Report/SubReport tabs

Main: CONTRACT A SiEReparti: REVU_VALUE_HISTORT,

lLeft: 0 Top: 0.0625  width: & Height: 0,1979 4

Object: SubReport1

Now, click on the SubReport tab - Everything you do at this point will be in reference to the subreport.

- Click on Report > Data and make sure that the subreport is set to use the VALUE_HISTORY

pipeline.
- Make room in the title band, add a background shape and color it and then add DBText objects for

the FMT_CONTRACT_DELIVERY and PROJ_NAME fields
- In the detail band, add DBText objects for V_DATE, V_TEXT and V_AMT fields: at this point your

designer should look something like this
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RMS Report Designer [ de_rms.world ]J: NewRepEx4
File Edit Wiew Report Help

Data | Cale  Desion | Freview|

| AEEnEEh | aee| | ATEREL®E/ 8068 B

= <o === A-¢-| 90| 9%

S-s-==[08 =388 | ow|E2d Toa | wi WE DSH DSR4 BB
R R S A O K S B S R
-t VDATE T

~ Detall

* Summary

Ready,

Main: CONTRACT j SubReportl: REVU_VALUE_HISTORY f
lleft: 6.5625  Top: 0

9.6

Step 5 - Add arunning subtotal

Now lets add a DBCalc to take care of our running subtotal.

[width: 1.0833  Height: 0.1563

A

Select a DBCalc object from the toolbar and position it in the right side of the detail band as shown
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9.7

RMS Report Designer [ de_rms.world ]J: NewRepEx4

File Edt Yiew Report Help

Data | Cale  Desion | Freview|

| AEEnEEh | e | APERER®E/| 806 B

V_AMT = | [FBVUVALUE_HISTORY » - faiial [0 S| Bru ====|A-4- $O l‘l!i|
s-s-==8 8 [|"F FlE2s maw wi  WE ODSH LSRR | 4 B@

(N A B LS R AN B H LN I

-

“Detal
* Summary

Main: CONTRACT j, SubFeporth: REVU_VALUE_HISTORY /

Object: DBECalc! lleft: 6.5625  Top: 0.0313  |width: 1.0833  Height: 0.1563 4

Right click on the DBCalc and select Calculations. Make sure Sum is selected and make sure that
Reset Group is empty. Remember, this is a subreport so, we never want the total to clear out. It will
clear out on its own because the subreport will be a new report for each contract. By not clearing it, we
will create a running total. In the Field dropdown in the designer toolbar, make sure the field is set to
V_AMT since that is the field we want to keep running a total on.

Step 6 - Add a grand total Summary Band to the SubReport

To finish up the SubReport, add a summary band that has the final total for the contract amount.
- Grab the summary band and drag down to make room.

- Add a Label for the Current Contract Amount title

- Add a DBCalc and set the field to V_AMT, and the Calculation to Sum with no reset
- Add a line above the text in the summary band
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RMS Report Designer [ de_rms.world ]: NewRepEx4
Fle Edt Wew Report Help
Data | Cale  Desion | Freview|
| AEEmhEEk | aee| | ATEREL®E/ 806 B
V_AMT _~|[revu_vaLue_HisToRY <] | [Arl <[ S| Brun ===-— |A-2- | &3 qq|
d-4-==08 =9 28 sr|k29 Tad | wd  WE ODSH DSR4 B@
EO"'I"‘ "'I"‘le"'\"‘la"'\"‘l“"\"'|5"‘|'"‘5"‘|"'h"‘|""8"‘I"
e
o
“Detal
@ L
“ Summary
Wain: CONTRACT (CILEEEeENEENNEIEE
Objert: DECalZ lleft: 6.5625  [Top:0.0521  |width: 10833 Height: 0.1563 4

This report introduced the import ability to use views in a report when the SQL gets too complicated
for the report writer to handle. It also showed how to do a basic subreport and work with multiple data
pipelines. To enhance the report further, you could add a filter and sort to make the report more

useful.
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10

10.1

Example 10 - Office Org Chart

Overview

This report list out the RMS office structure in heirarchichal office order. It indents child offices in
successive levels from the parent. It's a rather gimmicky report, but it shows how to manipulate

placement of report objects at run time.

US Ay Corpe

Office Org Chart

18-Aug-07

of Englnoers.

Engineering Services Branch
Address:US Army Engineer District, Honolulu
Blclg. 230
Fort Shafter, HI  96538-3440

CEPOH-EC-M

Phone:435-35358
Fax:

Information Management Office
Address:Us Army Engineer District, Honolul
Bldg, 230
Fort Shafter, HI 96855-5440

CEPCH-IM

Phone:435-3420
Fax:

Address:Us Armny Engineer District, Honoluluy
Bldg. 230
Fort Shafter, HI 96855-5440

Internal Review Office CEPOH-IR
Address:
Phone:
Fax:
Program & Project Mgt Division CEPOH-PP

Phone:435-1634
Fax:

Address:US Army Engineer District, Honolulu
Bldg. 230
Fort Shafter, HI 96855-5440

Military Branch, Other CEPOH-PP-D
Address:US Army Engineer District, Honolulu
Bldg. 230 Phone:
Fort Shafter, H1 96855-5440 Fax:
Civil & Public Works Branch CEPOH-PP-C

Phone:433-5550
Fax:

Envir & Special Projs Spt Br
Address:US Army Engineer District, Honolulu
Bldg. 230
Fort Shafter, HI 95555-5440

CEPOH-PP-E

Phone:433-6974
Fax:

Skills shown:

- Getting creative with Oracle Functions

- Anchoring report objects

- Moving and sizing regions at run time with RAP

- Learning about RMS office fields and structure (OFFICE_SEQUENCE)
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10.2 Step 1- Load the Portrat Template and Set Report Title

Load the standard template report and set the Title to Office Org Chart

RMS Report Designer [ de_rms.world ]: Ex3
File Edit Yiew Report Help

Data | Calc  Desian |Preview|

h  AlEnech| || AREERns® EMRE
[Offcs Org Char | Iz EE Slasru === A-¢- &0 T
B-4-==0E 2o 58 [ ar|Ped  Tak | w2 | WE DSH| DER | BB

e e R R R L L R N NN

~ Detai

Chject: Labels lLeft: 1,2917 Top: 0,3125 [width: 14067  Height: 0.2125 A

10.3 Step 2 - About the Office Hierarchy

The offices in RMS are shown in a hierarchical fashion were an office finds its place in the tree based
on who its parent is. That's nice for the end user, but its difficult to deal with for programmers. Oracle
actually does have a hierarchical SQL methodology, but its too generic for use to use. There is no
magic SQL method to say give me the offices and order by RMS OFFICE ORDER.

Thankfully, the staff at the RMS center have provided a solution via the
OFFICES.OFFICE_SEQUENCE column.
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10.4

Resident Management System

File Help

Home Summary

Contracts - Fort Shafter Area Office

Office

Local Library

District Library

®

Owerview

P

Syztem Library .
eports

Gl

E it

= Honolulu Engineer District

G Office of Counsel Add Edt  Delete  Find Ar:}:;lve J 4l Cerracts [
+-31 Contracting Divizion
=2 Engrg & Const Division Eont.ract A ‘ Contract | C-:-ntract ~
3 Cost Engineering Branch 'EF' == |D/No iBIG L | Title
+-F] Design Branch CEPOH-EC-C ) - 1E - LYZ, Inc.
& Envirgmmentc-d Techrical Branch CEPOH-ECCF  DACAS3-03-D-0015 0005 FY03 DOE Schaols R&M Frojects
£ Technical Support Branch CEFOH-ECCF | DACAS3-03-D-0015 0008 | POD EOC 3id Floor Renavation
21 Civil works Technical Branch CEPOH-EC-CF  DaACAZ3-03-D-00150007 Fr04 OMA Pkg 4-22 Parking and Hardstand
- Construction Branch CEPOH-ECCF  DACAS3-03-D-0015 0008 FYD4 OMA Pkg4-23 Rena B-1507 for DOL
+-(= Fort Shafter Area Office CEPOH-EC-CF  DACAB3-03-D-0015 0009  Aliamanu Elem School Drainage Improve
21 Schofield Barracks Area Offic. | |CEPOH-ECCF | DACAS3-03-D-0015 0010 | Kinau Hale EOC Renavations, DOH
B8 Kwasjalein Resident Office CEPOH-ECCF  DACASIO3-D-0015 0011 |Fy05 E-020 Sakt Lake Sediment Stuc BMP
£ Palau Compact Residert Offic {opppyEC.CF | DACAB3-03-D-0015 0013 |FyDE NAF PNE1342 Golf Course Maintenance
& Corstruction Services Section CEFOH-ECCF  DACAS3-03-D-0016 DI - Niking Corporation
- F'moinagt:ﬁmi:;e'::z: gf';;‘;h CEPOH-ECCF | DACAS3-03-D-0016 0003 | Modify Diesel Fuel Spstem
A Internal Peview Dffice CEPOH-ECCF  DACAS3-03-D-0016 0005 | FCCE-Paauau FCF, HI (PLIS)
X . CEPOH-ECCF  DACAS3-03-D-0016 0007 | FYO7 PM106514 Septic Tank Systems at KMC
+-1 Program & Project Mgt Divizion - —
£ Resource Management Office | |CEPOHECCF  DACAB3-03-D-0017 D13 Contract for Medical Facilities
= 3 CEPOH-ECCF  DACAS3-03-D-0017 0002 | FY04 DHF Plkg T-29 MICU, Phase 1, TAMC
Displey (% Contacts (~ Frojects CEPOH-ECCF  DACAS3-03-D-0017 0003 FY04 Pkg T-25. G20 & G1C Crawl Spe Acc
CEPOH-ECCF  DACAB3-03-D-0017 0005 | F¥05 DHP Mursing Statian
¥ Include Contracts of Sub-Offices CEPOH-ECCF  DACAZ3-03-D-0017 000 FY0E DHF Pkg T-67, Radiology (Trans]
[ Include Contracts with Access Denied CEFOH-ECCF | DACAS3-03-D-0017 0007 | FYOE DHF Phg T-70 Veterinary Clinic v

TFrmiContrackManu- =TFrm3eleckConkrack

s

el

X Q

Iy

The OFFICE_SEQUENCE column is set by triggers and stored procedures in the database in such a
way that when you order by OFFICE_SEQUENCE, you will get the offices in the same order as the
RMS office tree. The OFFICE_SEQUENCE is a series of numbers indicating where in the tree an

office should go - For example 001.001.002 means that this office is the 2nd suboffice of the first
suboffice of the root office. The first root office is always 001. If your district has more than one office
at the root, they will be 002 and so on.

This makes it easy to order offices and to find all of the suboffices for an office. For example to get all
of the suboffices of 001.001.002, just use a OFFICE_SEQUENCE like '001.001.002.%' clause.

Step 3 - Create the query
From the data tab, select File > New > Query Designer and click Ok.

Select the OFFICES table into the selected list.
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R Query Designer

Fields ] Calcs ] Group] Search} Sort 1 S0L 1

Available Tables

Table Tablz Name ~
ACCIDENT ACCIDENT

ACTMTY_DESC  ACTMATY_DESC

ACTMATY_PaY_HISACTITY_PAT_HI y
ACTMTY_QA ACTMITY_QA

ACTMTY_SCHEDUACTMTY_SCHEDL

AGENCY AGENCY
AGENT AGENT
AHA_HAZARD AHA_HAZARD
AHS_STER AHS_STER

ANT_WEATHER  ANT_WEATHER
APFYL_CONTRACTAPFYU_COMTRALC
APFYL_CONTRACTAPFYU_COMTRALC
APFYL_CONTRACTAPFYU_COMTRALC
BASELINE_LIBRAR BASELINE_LIBRAR
BASELINE_OFFICE BASELINE_OFFICE
BID EBID

BID_CHANGE BID_CHANGE
BID_CHANGE_OBLIBID_CHAMGE_OBL

BID_OBLI BID_OBLI
CALENDAR CALEMDAR
CATEGORIES CATEGORIES
CATEGORY CATEGORY

CEFMS_ACCRUAL CEFMS_ACCRUAL
CEFMS_INV_LIME_|CEFMS_INV_LINE_
CEFMS_INV_LIME_|CEFMS_INV_LINE_
CEFMS_INVOICE  CEFMS_INVOICE
CEFMS_INVOICE_E CEFMS_INVOICE_E

CCCWAC MO CCCRAC MDD !
Selected Tables [ Distinct
Table Table Mame SOL Alias Join Type

OFFICES OFFICES OFFICES

Cancel

Switch to the fields tab and select the fields as shown here. We will use all of these in out report.
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R Query Designer

Tables Fields ]Ca\cs ] Group] Search} Sort 1 S0L 1

[A] Available Fields

Field Alias | Field SOL &fias | Table SOL Allss | ~
EATCH_CEFMS.. OFFICES.BATC.. OFFICES

EATCH_CEFMS.. OFFICES.BATC.. OFFICES

EATCH_CEFMS.. OFFICES.BATC.. OFFICES

EATCH_CEFMS.. OFFICES.BATC.. OFFICES

BATCH_P2 AFT.. OFFICES.BATC.. OFFICES

EATCH_P2 DATE OFFICES.BATC.. OFFICES

BEATCH_P2 DAY OFFICES.BATC.. OFFICES

BATCH_P2 MO.. OFFICES.BATC.. OFFICES

CEFMS_ORG_C.. OFFICES.CEFM.. OFFICES

DAYLIGHTSAY].. OFFICES.DAYLL.. 0OFFICES =
FL_CODE OFFICES.FL_C..  OFFICES

MOD_FREFI< OFFICES.MOD_.. 0OFFICES

OFFICE_FLAGS OFFICES.OFFIC..  OFFICES

OFFICE_MANAG... OFFICES.OFFIC.. OFFICES

Pz_DOWMLOA..  OFFICES.PZ_D.. OFFICES

PAREMTSYMBOL OFFICES.PARE.. OFFICES

Ml A e ncorcc nan neoirce b
Selected Fields [~ AllFields
Field Alias Field SOL Alias Tahle SOL Alias
OFFICE_SEQUENCE OFFICES.OFFIC... OFFICES
FLMAME OFFICES.FLMA..  OFFICES
FLSYMBOL OFFICES.FLSY...  OFFICES
ADDRESST OFFICES.ADDR... OFFICES
ADDRESS2 OFFICES.ADDR... OFFICES
ADDRESSS OFFICES.ADDR... OFFICES
PHOME OFFICES.PHOME ~ OFFICES ﬂ
Fiés OFFICES.Fix OFFICES
DISPLAY_SYMBOL OFFICES.DISPL.. OFFICES
]

Cancel

Switch to the Sort tab and sort the offices by OFFICE_SEQUENCE as we have already discussed.
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10.5

R Query Designer
Tables] Fields ] Calcs ] Group] Search Sort ]SQL 1
%l Available Fields

Field Alias | Field SOL &fias | Table SOL Allss | A
ADDRESS1 OFFICES.ADDR... OFFICES
ADDRESS2 OFFICES.ADDR... OFFICES
ADDRESS3 OFFICES.ADDR... OFFICES

EATCH_CEFMS.. OFFICES.BATC.. OFFICES
EATCH_CEFMS.. OFFICES.BATC.. OFFICES
EATCH_CEFMS.. OFFICES.BATC.. OFFICES
EATCH_CEFMS.. OFFICES.BATC.. OFFICES
BATCH_P2 AFT.. OFFICES.BATC.. OFFICES
EATCH_P2 DATE OFFICES.BATC.. OFFICES
BEATCH_P2 DAY OFFICES.BATC.. OFFICES
BATCH_PZ2_M0O.. OFFICES.BATC.. OFFICES
CEFMS_ORG_C.. OFFICES.CEFM.. OFFICES
DAYLIGHTSAY].. OFFICES.DAYLL.. 0OFFICES
DISPLAY_SYMEB.. OFFICES.DISPL.. OFFICES

Fx OFFICES. Fax OFFICES
FLMAME OFFICES.FLNA...  OFFICES
FLSYMBOL OFFICES.FLSY... OFFICES
FL_CODE OFFICES.FL_C..  OFFICES

MOD_PREFI< OFFICES.MOD_.. OFFICES
OFFICE_FLAGS OFFICES.OFFIC. OFFICES
OFFICE_MAMAG.. OFFICES.OFFIC OFFICES
P2_DOWNLOA OFFICES.P2_D OFFICES
PARENTSYMBOL OFFICES.PARE OFFICES
PHOME OFFICES.PHOME ~ OFFICES
GQALOCKDAYS OFFICES QALD OFFICES
OalOCKPOLICY  OFFICES.QALD OFFICES
OavERSION OFFICES QAVE OFFICES

M CTkARACKIT NACCIECC MA T NCCIrCC b
Sort Fields [ Matural Drder
Field Alias Field SOL Alias Table SOL Alias Descz> a]
OFFICE_SEQUEMNCE OFFICES.OFFICE_SEQIUIENCE OFFICES r
|
|

Cancel

Step 4 - Create a Calculated Field for the Office Level

We want to get a little bit fancy and indent our report based on the level that the office falls in the tree.
We've discussed the OFFICE_SEQUENCE field and we know that it is based on where it falls in the
tree, so we will use that to figure out our level. If we want the indentation level to be zero for the root of
the tree, then we can use the length of the OFFICE_SEQUENCE to figure out the level by adding one
to the length dividing by 4 and then subtracting one from the result. Here is the SQL expression to do

it:

((LENGTH(OFFICE_SEQUENCE)+1) / 4)-1)

Switch to the Calcs tab of the query designer and drag down the OFFICE_SEQUENCE field and set
the new calculated field as shown here.
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R Query Designer

Tablesl Fields Calcs |Group| Searchl Sart I sS0L I
@ Available Fields

Field Alias | FieldSOL Aas | Table SOLAkas | A
ADDRESST OFFICES.ADDR..  OFFICES
ADDRESS2 OFFICES.ADDR..  OFFICES
ADDRESS3 OFFICES.ADDR..  OFFICES

BATCH_CEFMS.. OFFICES.BATC.. OFFICES
BATCH_CEFMS.. OFFICES.BATC.. OFFICES
BATCH_CEFMS.. OFFICES.BATC.. OFFICES
BATCH_CEFMS.. OFFICES.BATC.. OFFICES
BATCH_PZ_&4FT... OFFICES.BATC.. OFFICES
BATCH_PZ_DATE OFFICES.BATC.. OFFICES
BATCH_PZ_DaY OFFICES.BATC.. OFFICES
BATCH_PZ_MO.. OFFICES.BATC.. OFFICES
CEFMS_ORG_C.. OFFICES.CEFM.. OFFICES
DavLIGHTSAY].. OFFICES.DAYLL.. OFFICES
DISPLAY_SYME... OFFICES.DISFL.. OFFICES B

Féi OFFICES. Fax OFFICES
FLMAME OFFICES.FLMA...  OFFICES
FLSYMEBOL OFFICES.FLSY.. OFFICES
FL_CODE OFFICES.FL_C.. OFFICES

MOD_PREFI< OFFICES.MOD_... OFFICES
OFFICE_FLAGS  OFFICES.OFFIC.. OFFICES
OFFICE_MANAG... OFFICES.OFFIC.. OFFICES
OFFICE_SEQUE... OFFICES.OFFIC.. OFFICES

~|

Calculations

Field Alias | Field SAL Alias | Table S0L Alias | Function | Expression |

05_TREE [((LENGTH(OFFICE_SEGUENCE]+1) / 41) LENGTH_OFFICE_SEGUENCE_1 OFFICES Expression [(ILENGTHOFFICE_SEQIUENCE]+1) / 4)1) |
=l

Cancel |

10.6 Step 5 - Layout the Detail Band

Add a Region to the detail band and then add labels and DBText objects as shown here

RMS Report Designer [ de_rms.world ]: Ex3

File Edit Yiew Report Help

Data | Calc  Desian | Previen |

K| ABEnEchl aen A une® MR E
| | [Aa s

& S W ol | o 2

B - -
Bo ' '

ls* [

™ Detail

* Foater

Chject: Regionl Left: 0.0833 Top: 00313 lwidth: 7.8854  Height: 0.7708 |
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10.7 Step 6 - Dynamically indent the Region
To give the rows a bit of an office tree feel, we will indent the region based on the office level.
We can do this by coding a RAP event for our detail band. We will simply set the Left property of the
Region based on the tree level and then we will adjust the width of the region so that its right side
always ends at the same location. here is the code to do that where we are moving in a quarter of an
inch for each level in the tree,
Regionl. Left := ( OFFICES[' OS_ TREE'] * 0.25 );
Regi onl. Wdth := 8.0 - Regionl. Left;
Switch to the Calc tab, highlight the Detail band, and add a BeforePrint RAP event
RMS Report Designer [ de_rms.world ]: Ex3 Q@Igl
File Edit V“iew Help
Dats  Cale WDEs\gnw F‘revlew}
Report Objects Ewvents for Detail
= -8 Report [ anerGenerate
—| ==t Header DAllerF'rint
A LfabeIEI [ BeforeGenerate
‘Elj I;_l,':;:m\f’anahla'l 8 R
[ Imags2
EE Shapel
= pimst Detal
+ -5 Regionl
#]--- s Footer
procedure DetailBeforePrint; Code Toolbox: Data
begin OFFICES
Regionl.Left := { OFFICES['CS TREE'] * D.25 1z
Regionl.Width := 8.0 - Regionl.Left;
end;
Fields for OFFICES
Carmpile Completed: 0 Erars - Tomm S
Data f Objects ALanguage
4: 50
10.8 Step 7 - Anchor the DBText Objects

By default, objects are anchored using the top and left anchor point. When you start playing games
like resizing regions at run time, this can lead to problems. All of our report objects that are anchored
using Left, are going to shift when we move the left side of our region. We want that for the objects on
the left part of our region, but the objects on the right side of our region should stay in the same
relative position. To accomplish that, we need to change the Anchoring scheme for those objects.

Switch to the design tab and Select View > ToolBars > ReportTree from the PullDown menu
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RMS Report Designer [ de_rms.world ]: Ex3

File Edit Report  Help
oolbars 3
ue | o IR
v Rulers
[:E arid Opkions, ..

E v Show Data
M. F == H
iER R

d m
- B,
__ :::Uﬂiﬁﬁniﬂﬁﬁs:::::

Report Tree

Dakta Tree
v Standard Components ﬁ h_{
v Dakta Components [
v Advanced Components o
v Standard -
v Formak Y
v Edit S
v Size SR
o tosee B
v Draw ——

With the Report Tree Open, select the DBText Object for the DISPLAY_SYMBOL and scroll down to

the Layout > Anchors Section
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Report Tree
Object Duthne

119

|- =i Header
A Labeld
| Lined
P Systeny aniable]
[ Image2
'El Shapel
|- et Dbl
- Regionl
EA DBText?
LA DBText3
LA DBTextd
LA DBTexts
LA DBTextf
LA DBText?
LA DBTextd
A Label
A Label2
A Label3
2wt Fnkbar

Properties for DBT ext3

DrataField
D ataPipeling
ParentD ataPipeline
El Identity
IdzerM ame
E Layout
Height
Left
Top
Width
B Layout - Dynamic

atBattom
atLeft
atRight
atTop
AutoSize
Reprintdn0yverFlow
El Output - File
Save
Savelength
Savelrder
E Text
Angle

Charrap

DISPLAY_SvMBOL
OFFICES
W

DBText3

01354
51666933
01146
1.0104001

ERTETTE S (=T op. atRigh]

== A"7adan

—ln:n

Change your anchoring scheme from using Left to Using Right instead. This will insure that this object
keeps the same relative Right position within the region even when it is resized.
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Repeat the Right Anchoring steps for the remaining objects on the right side of the Region.

10.9 Summary

This report showed some creative ways to give a static page a more dynamic tree like feel by
indenting regions. It discussed anchoring and using the RMS office fields to sort offices in RMS office

order.
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111

11.2

Example 11 - Progress Payment Processing

Overview

This report is a summary style report that an office can use to see what payments need to be
processed for the current month. The report lists all awarded contracts that should have a payment for
the current month and shows an entry for every report wether it has a payment or not. We will have to
do an outer join to accomplish this. The report makes quite a bit of use of Oracle date functions. Very

importantly, this report will illustrate how to properly use an OR condition in the where clause of the

guery. Buckle up your seat belts because there is quite a bit of RAP code as well.

17-Aug07

Amount Due
Interest Due

$100.00

$100.00

|—| Progress Payment for July 2007
U Amy Corpe
of Englnesrs..
Contract Mo Payment Inwvoice Payment Payment Contractor
Contract Title Mo, Raceived? Completed? Approved?
DACAS3-03-0-0015 0006 17
POD EOC 3rd Floor Renovation Projected)
DACAZ2-02-D-0015 0002 11 Ho Yes
F04 OMA Pkg A-22 Reno B-1507 for DOL
DACAS3-03-0-0015 0009 7 Mo Yes
Aliamanu Elem School Drainage Improve
DACAS3-03-0-0015 0010 8
Kinau Hale EOC Renovations, DOH (Projected)
DACAZ2.02.0-0015 0011 5
F¥05 E-020 Salt Lake Sediment Stuc BMP Projected)
DACAS3-03-D-0015 0012 2 ves Yes
F05 OMA Pkg A-001, Rstr 1=t Floor, B102

F276,866.50
F0.00

Skills shown:

- How to properly use ANDs and ORs in the where clause

- Oracle date functions and sysdate

- Oracle Max function in correlated subquery
- Using an expression in the FIELD portion of a search condition

- Using Variable Objects
- Outer Join

- Renaming objects using the report data tree

- Dynamically setting object visibility

- Joining Multiple tables

- SQL groups

- RAP Code

- Creating Query Links with Multiple Fields
- Multiple Pipelines in One Report

Step 1 - Load the Standard Landscape Template and Design the

Header

Create a new report and load the standard Landscape template. Change the report title and layout the

column headers as show here:
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11.3

RMS Report Designer || de_rms.world ]: SampleS

EEX

Fle Edt View Report Help

Data | Cae  Desian | Preview |
h | AlEn@eEt | ao8 AEEESDSS ama@
| | = =i -] | 1 U
op pad mad wi WE D&

“ Footer

Step 2 - Create a Left Outer Join DataView

We want to have a row for every contract that is awarded and not yet final paid. For each of these
contracts, we want to show the payment information for the current month. To do that, we will join the
CONTRACT table to the REQUEST table. However, we want to make sure we don't eliminate
contracts just because they do not have a payment entered for the current month yet. The outer join is
what we need.

From the data tab, select File > New > Query Designer and click Ok

Select the CONTRACT table and put it into the selected tables list. Then, select the request table and
put it into the selected list. The Join Table Dialog appears:
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Join Table

Join Type Join REQUEST Table with
| Inher ﬂ
REQUEST Fields COMTRALCT Fields
ALLOWED_EARMIMGS_COMPLETE A ACO_AGEMT_CODE A
APPROVER_MAME = ACTMITY WaRIANCE =
APPROVER_TITLE ALT_PER
Cad' LINE_ITERM_AMT ACT_PER_LESS_STORED
CEFMS_APPROWAL STATUS ACT_PLCMT
CEFMS_CHAMGES ACT_TOT
CEFMS_COMPARE AE_ADDRESST
CEFMS_EARMIMNGS AE_ADDRESSZ
COMTRACT ID s AE ADDRESS3 bt
Joined Fields
REGQUEST Field Operator COMTRALCT Field »
REQUEST.COMTRACT_ID = COMTRACT.COMTRALCT_ID
REQUEST.PaAY_ALLOWED = COMTRALCT.PAY_ALLOWED
REQUEST.PaY_CALC = COMTRALCT . PaY_CALC )
REQUEST.PAY_SECL_NO = COMTRACT.PAY_SEQ_MO w
<

5ol FYIPT " NUUEeY LU I J-"’w -,

First off, we don't want to use its suggested fields to do the join. It suggested them because the field

names match in the two tables. We just want to join on the CONTRATC_ID field. so remove all of the
others
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Join Table

Join Type Join REQUEST Table with

| Inner | |CONTRACT |
REQUEST Fields COMTRALCT Fields
ALLOWED_EARMIMGS_COMPLETE A ACO_AGEMT_CODE A
APPROVER_MAME = ACTMITY WaRIANCE =

APPROVER_TITLE ACT_PER
Caw'_LIME_ITEM_aMT ACT_PER_LESS_STORED
CEFMS_APPROVAL_STATUS ACT_PLCMT
CEFMS_CHAMNGES ACT_TOT
CEFMS_COMPARE AFE_ADDRESST
CEFMS_EARMIMNGS AF_ADDRESSZ

COMTRACT ID b’ AE ADDRESS3 .’
Joined Fields

REGQLEST Field Dperator COMTRALCT Field
REQUEST.CONTRACT ID = COMTRACT.COMTRACT _ID

ol o I L s e ik Jr"’&"’"""-’-u_

125

If we keep the join as an inner join, then contracts without a matching request row are going to get
eliminated and we don't want that. So, switch this to a Left Outer join instead. That will tell the engine

to keep ALL of our rows in from the contract table even if there is no match from request.
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11.4

Join Table
Join REQUEST Table with

APPROVER_TITLE ACT_PER
Caw'_LIME_ITEM_aMT ACT_PER_LESS_STORED
CEFMS_APPROVAL_STATUS ACT_PLCMT
CEFMS_CHAMNGES ACT_TOT
CEFMS_COMPARE AFE_ADDRESST
CEFMS_EARMIMNGS AF_ADDRESSZ

S N I CORITRLTT -
T Left Quter Jain J
REGQLUEST Fields ds
ALLOWED_EARMIMGS_COMPLETE o CODE e
APPROVER_MAME E BLTTITY _WARIANCE =

Bl e et b 0t et e -l-’ah'*""ﬂd..

Step 3 - Filter the Contract Rows

We only want contracts that are awarded and have not been final paid before the current month.
Those are all the contracts that we expect to have some kind of payment for the current month.

COMTRACT ID b’ AE ADDRESS3 .’
Joined Fields
REGQLEST Field Dperator COMTRALCT Field
REQUEST.COMTRACT_ID = COMTRACT.COMTRACT _ID

Switch over to the search tab. Select the AWD_ACT field and set its requirements to Not Blank. This

will eliminate any contracts that have not yet been awarded.
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R Query Designer,

Tables I Fields ] Calcs I Group Search I Sort 1 SQL ]
Q Available Fields

Field Alias [ Field SOL Alias | Table SOL Alias_|
AwiARD_FUNDIL.. CONTRACTA.. CONTRACT
AwARD_FUNDI.. COMTRACTA.  CONTRACT
AwiARD_FUNDIL.. CONTRACTA.. CONTRACT
AiBRD_GOV_.. CONTRACTA.. CONTRACT
AwiaRD_MGT_.. CONTRACT.A. CONTRACT
AiBR0_OPTIO.. CONTRACT A CONTRACT
AuiSRD_OPTIO.. CONTRACT.A. CONTRACT
AwiaR0_OPTIO.. CONTRACTA.. CONTRACT
AuiSRD_OPTIO.. CONTRACT.A. CONTRACT
AwiaRD_OPTIO.. CONTRACTA.. CONTRACT
HwARD_OPTIO.. COMTRACTA..  CONTRACT
AwiaRD_PROB CONTRALCT.A... CONTRACT
ABRD_SA CONTRALCT.A... CONTRACT
AiaRD_SUPP. CONTRALT A, CONTRACT
awaRD WOSA  CONTRACTA.. CONTRACT

wD_ACT COMTRALCT A, CONTRACT
wD_SCH CONTRACT.A..  CONTRACT
BOD_ACT CONTRACT.BO.. CONTRALCT
BOD_ORG CONTRACT BO.. CONTRACT
BOD_SCH CONTRACT.BO.. CONTRACT

CEFMS_ALIAS CONTRACT CE CONTRACT
CEFMS_DOWM.. CONTRACT.CE.. CONTRACT

Ciiteria
Field Operatar Value AutoSearch | Mandatom Show Al
CONTRACT.AWD_ACT Mot Blank hd r r r
#'._ - P _r—l‘r‘—”— e —— T, -
e P EIEY NPT T R R i‘“—-—-—.u—-_,,ﬂl—"h S .. F 4 Rt
-_—
T

The next condition is more tricky. We want to filter out any contracts that have final pay dates, but not
those that are final paid in the current month. We will use the Oracle TO_CHAR function and the built
in sysdate variable to get the rows we want. Select the FCOMP_ACT field and put it into the selected
criteria list. Set the Operator to Blank. Select the FCOMP_ACT field again and this time, set the
operator to > and the value to

TO_CHAR(sysdate,'YYYYMM")
click on the field alias and change it to

TO_CHAR(CONTRACT.FCOMP_ACT,YYYYMM)

Field Operatar Walue AutoSearch | Mandatory Show &ll
CONTRACT AwWD_ACT Mot Blank
CONTRACT.FCOMP_ACT Blark
iTO_CHAR[CONTRACT FCOMP_ALT "] | ¥ TO_CHAR[sysdate, Vv MY
) =

T

This says we want rows where the FCOMP_ACT is blank or where the FCOMP_ACT month and year
exactly match the month and year of the system date. However, by default, all of the criteria we add
will use AND logic and in

this case we want OR logic.

Right click on the TO_CHAR(... field and select the Insert OR option from the context menu.
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Insert OF.
Insert MOT

Rermowve

Add Parentheses
wlapsiss Bagsettbncan,,

Your screen should now look like this:

Field Operator Walus AutoSearch | Mandatary Show All

CONTRACT AwWD_ACT Mot Blank

CONTRACT.FCOMP_ACT Blark

OR

iT0_CHAR[COMTRACT FCOMP_ACT "M > TO_CHAR[sysdate, M4

Sl S — P . _’_.’——-._..._.__ﬁ—_._—’

If we left things as they are however, we would be making a BIG mistake. And one that even
experienced SQL folks sometimes make. Right now, our query is basically of this form:

AANDBORC

In SQL, AND has precedence over OR so with this form, anytime C is true, the expression will be true
REGARDLESS of A. What we need is this form:

A AND (B OR C)
In this form, A must be true AND either B OR C must be true. This is an important difference. To get

the form we want, we have to insert parentheses at the correct spot. Right click on
CONTRACT.FCOMP_ACT and select Insert Parentheses and you should get this:

Field Operatar Walue AutoSearch | Mandatory Show &ll

CONTRACT AwD_ACT Mot Blank

begin

CONTRACT FCOMP_ACT Blark

end

a3}

TO_CHAR[CONTRACT FCOMP_ACT M vhib'] > TO_CHAR[sysdate, M4

S S —— et ettt T —————

The begin and end will become parentheses when the report engine sends the query to the database.
The begin is in the correct spot, but we need the end to be after the TO_CHAR(... entry. Use the
arrows on the left side of the window to move the end downward in the list until you have this:
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Field Operatar Walue AutoSearch | Mandatory Show &ll

CONTRACT. AwWD_ACT Mat Blank

begin

CONTRALT.FCOMP_ACT Blank

a3}

TO_CHARCONTRACT FEOMP_ALT %y vhMY) 5 TO_CHAR(sysdate, Y rhbY

Bl . P - B i T _'__,-————._.___:-__-"

11.5 Step 4 - Filter the Request Table Rows

We have the correct contract filter, but as the query stands now, we will be getting a joined row for
every payment on a contract. We want to filter to get only the last payment.

Select the INV_NO field from the list and add it to the list of selected criteria. Set the operator to =.
The tricky part here is that we want the INV_NO to be the biggest INV_NO for a given contract. So
what we compare our equalilty to is this correlated subquery:

(SELECT MAX(INV_NO) FROM REQUEST WHERE CONTRACT_ID=CONTRACT.CONTRACT_ID)

which returns the highest invoice for a given contract.

Your screen should now look like this:

Field Operatar Yalue AutoSearch | Mandatary Shaw All
CONTRACT AwWD_ACT Mot Blank

begin

CONTRACT FCOMP_ACT Elank.

OR

TO_CHAR[CONTRACT FCOMP_ACT.... » TO_CHAR [spedate MM

end

REQUEST.INV_ND = j |[SELEET MAX[INY_NO] FROM REQUEST WHERE CONTRACT _ID=CONTRACT CONTRACT_ID] r - r

R R R -J*"-_‘—H—_“““"v__ = _’_’-—F—-—L_-——_j

11.6 Step 5 - Select the fields and the sort order

To finish off this query, lets select our required fields and sort order. Switch over to the Fields tab and
select the fields as shown here:
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R Query Designer,

Tables Fields IEaIcs I Group] Search] Sort 1 SQL ]
[Al Available Fields
Field Alias [ Field SOL Alias | Table SOL Alias_|

~
ACO_AGENT_C.. CONTRACTAC.. CONTRACT 0
ACTMTY_VARIL.. CONTRACTALC.. CONTRACT

ACT_PER CONTRACT.AC.. CONTRACT

ACT_PER_LESS.. CONTRACTAC.. CONTRACT

ACT_PLCMT CONTRALCT AL, CONTRACT

ACT_TOT CONTRACT.AC...  CONTRACT

AE_ADDRESST CONTRALCT.AE CONTRACT

AE_ADDRESSZ  CONTRACT.AE.. CONTRACT

AE_ADDRESS3  CONTRACT AE CONTRACT

AE_EVAL_ACT CONTRACT.AE... CONTRACT

AE_EVAL_RO CONTRACT.AE... CONTRALT b
Selected Figlds I~ AllFiglds
Field Alias Field SOL Alias Table SOL Alias

CONTRACT_ID CONTRACT.CONTRACT_ID CONTRACT

FMT_CONTRACT_DELMERY CONTRACT.FMT_CONTRACT_DELWERY CONTRACT

PROJ_MNAME CONTRACT.PROJ_NAME CONTRACT

INV_NO REGQUEST IMv_MO REGQUEST

INV_RECD_DATE REQUEST.IMY_RECD_DATE REQUEST

ENG33_COMPLETE REQUEST ENGS3 COMPLETE REQUEST

CEFMS_APPROVAL_STATUS REGQUEST CEFMS_APPROVAL_STATUS  REQUEST

FINAL REQUEST.FINAL REQUEST

FLFROM REGQUEST.FLFROM REGQUEST

THRU REQUEST.THRU REQUEST

INVOICE_DATE REGQUEST IMVOICE_DATE REGQUEST

DUEDATE REQUEST.DUEDATE REQUEST

CURREMT_PAYMENT REQUEST.CURRENT_PATMENT REQUEST

fi’uuf*w_#hflfmm_;_ﬂ Jr_..v-—-«- b—.a-‘.{‘
™

Finally, switch to the Sort tab and sort the query by FMT_CONTRACT_DELIVERY

R Query Designer,

Tables | Fislds | Cales | Group | Search Sot |soL |
2] Available Fields

Field Alias | Field QL Alie | Table SGL Alas | ~
ACO_AGENT_C CONTRACT AT CONTRACT
ACTIITY WARL. CONTRACTAC. CONTRACT
4CT_PER COMTRACT.AC..  COMTRACT
ACT_PER_LESS.. CONTRACTAC. CONTRACT
ACT_PLOMT CONTRACT.AC..  CONTRACT
ACT_TOT CONTRACT AT CONTRACT
4E_ADDRESST — COMTRACTAE.. COMTRACT
4F_ADDRESSZ  CONTRACT AF . CONTRACT
4E_ADDRESS3  COMTRACTAE.. COMTRACT
HE_EVSL_ACT  CONTRACTAE.. CONTRACT
4E_EVAL P CONTRACTAE.. CONTRACT
SE_EVSL_SCH  COMTRACTAE.. CONTRACT

AE_TITLE CONTRALCT AE CONTRACT
ALT_REP CONTRACT.AL..  CONTRACT
ALT_REPZ CONTRACT AL CONTRACT
ALT_REP3 CONTRACT.AL..  CONTRACT

AwWARD_AE_DE  COMTRACTA.  CONTRACT
AwARD ALLOC.. CONTRACTA..  CONTRACT
AwARD_APPR.. CONTRACTA..  CONTRACT
AWARD_AUTH . CONTRALCT A CONTRACT
AwARD_BID_D.. CONTRACTA..  CONTRACT

AwWARD_BID_T.. COMTRACT A, CONTRACT v
Sort Fields [~ Mahural Order
Field Alias Field SOL Alias Table SGL Alias Desclz » a)

FMT_CONTRACT_DELVERY CONTRACT.FM.. CONTRACT

— P P S T
r&’ﬂ“f‘##d‘“-fmm#f Jr-“v-v ‘e P——

-
" i

11.7 Step 6 - Create a second query for the Receipt table

Our contract/invoice query is set now, but we still need some more data. We have to use the
RECEIPT_VOUCHER table to get payment amount, check date and interest amount information.
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11.8

Save your CONTRACT dataview and then select File > New > Query Designer and click Ok.

From the list of tables, select RECEIPT_VOUCHER and then switch to the Fields tab and select the
CONTRACT _ID and INV_NO fields as shown. These are the only two fields we need because the rest
will be handled on the Calcs tab. We need these two, because we will be linking to the CONTRACT
dataview using them.

Tables Fields IEaIcs I Group] Search] Sort 1 SQL ]

[Al Available Fields

Field Alias [ Field SOL Alias | Table SOL Alias_| ~
BASE_AMT RECEIPT OU.. RECEIPT WOU..
CERT_P&YMEN.. RECEIFT_VOU.. RECEIPT_vaL..
CHECK_DATE  RECEIPT VOU.. RECEIPT VOU..
CHECK_MUMBER RECEIFT_VOU.. RECEIPT_VOU...
CHECK_PROCE. . RECEIPT_VOLL. RECEIPT VLl
CURRENCY_CO.. RECEIFT_VOU.. RECEIPT_VOU...
D&TS_LATE RECEIPT_VOL. RECEIPT_vll
D&YS_PAID RECEIPT_¥OU.. RECEIPT vOU..
DELWERY_DR . RECEIFT_VOLL. RECEIPT vl
DISBURSE_AMT  RECEIPT VOU.. RECEIPT VOU...
DISB_STATION... RECEIFT_VOU.. RECEIPT_vU...
DISCOUMT_DATE RECEIPT_VOU..  RECEIPT_VOU...
DISCOUMT_D&YS RECEIFT_VOU.. RECEIPT_VOU...
DISCOUNT_FE . RECEIFT_VOLL. RECEIPT vl

DOV_NOD RECEIFT_VOU... RECEIPT_VOU..
FC_RATE RECEIPT_vOU RECEIPT_vOU
FC_SYMBOL RECEIPT_VOU... RECEIPT_VOU..

INTEREST_AMT  RECEIPT_VOU.. RECEIPT_VOU...
INTEREST_PRA... RECEIPT_VOU.. RECEIPT_vOU...

INTEREST PRA... RECEIPT VOU.. RECEIPT vOU... s
Selected Fields [~ Al Figlds
Field Alias Field SOL Alias Table SOL Alias

CONTRACT_ID  RECEIPT_vOU RECEIPT_VOU.

INV_ND RECEIPT_YOU... RECEIPT_vOU..
f‘_"_,“_u s TR h”‘_}*w S

= . A P i . P —
"

Step 7 - Create Calc Fields for the Request Pipeline
The RECEIPT_VOUCHER table may have many rows for a single payment. We don't want that level
of detail. We just want a payment date, a payment amount and an interest amount. To get those, we
sill use Oracle group functions and we will group our table by invoice number.

Switch to the Calcs tab and enter the three group calcs as shown here:

USACE



132

RMS Report Writing

11.9

R Query Designer,

Tab\esl Figlds Calos WGroup] Search] Sort 1 SQL ]
@ Avaiable Fields

Field Alizs [ Field SOL Alise [ Table SOL Alias |
BASE_&MT RECEIPT_VOL... RECEIPT_VOL...
CERT_PAYMEN.. RECEIPT_VOU.. RECEIPT_\OU..
CHECE_DATE RECEIPT_VOL... RECEIPT_VOL...
CHECK_NUMBER RECEIFT_VOL.. RECEIPT_VOL...
CHECK_PROCE... RECEIPT_VOU RECEIPT_vOU
CONTRACT_ID RECEIFT_VOL... RECEIPT_VOL...
CURREMCY_CO... RECEIPT_VOU RECEIPT_vOL
DaYS_LATE RECEIPT_VOL... RECEIPT_VOL...
DATS_PAID RECEIFT_vOU. RECEIPT_vOL
DELVERY_OR... RECEIPT_VOL.. RECEIPT_VOL...
DISBURSE_AMT  RECEIPT_VOU.. RECEIPT_\OU..
DISB_STATIOM... RECEIPT_VOLL.. RECEIPT_VOL..
DISCOUMT_DATE RECEIFT_VOL.. RECEIPT_VOL...
DISCOUMT_D&YS RECEIPT_VOU RECEIPT_vOL
DISCOUMT_PE... RECEIFT_VOL.. RECEIPT_VOL..
Dov_MO RECEIFT_vOU. RECEIPT_vOL
FC_RATE RECEIPT_VOL... RECEIPT_VOL...
FC_SYMBOL RECEIFT_vOU... RECEIPT_\OL..
INTEREST_&MT  RECEIPT_VOLL.. RECEIPT_VOLL...
INTEREST_PRa... RECEIFT_VOL.. RECEIPT_VOL...
INTEREST_PRa... RECEIPT_VOU RECEIPT_vOL
INT_PEM_CODE  RECEIFT_VOL.. RECEIPT_VOL...

Calculations
Field Alias Field SOL Alias Table SOL Alias Function Expression
W_AMT SUM[RECEIPT_VOUCHER.NET_AMT) SUM_RECEIPT_WOUCHER_MET_A RECEIPT_VOUCHER Sum
W_DATE MAXRECEIPT_VOUCHER.CHECK_DATE] Méx_RECEIPT_YOUCHER_CHECK. RECEIPT_YOUCHER Max
W_INTEREST SUMIRECEIPT_YOUCHER.INTEREST_aMT] SUM_RECEIPT_VOUCHER_INTER RECEIPT_VOUCHER Sum
= ™ e e S e ;...__4__"___;‘_’.» Jr--”‘ —nnn . ——
"

Now instead of having three or four receipts for an invoice, these group expressions will just give us
the sums and max values as we have requested.

Step 8 - Check the Grouping of the Query

If you use group expressions, then your query cannot return detailed information for the fields involved
in your group calcs. Id other words, we can't say we want the SUM(NET_AMT) and then also say that
we want NET_AMT itself. So, we have to make sure we group appropriately. Fortunately, the report
tool will generally take care of this for you and automatically create your groups.

Switch to the Groups tab and you should see this:
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R Query Designer,

Tab\esl Fields ] Cales  Group ISearch] Sort 1 S6L ]
T Avalable Fields

Field Alias [ Field SOL Alias | Table SOL Alias_|
BASE_&MT RECEIPT_VOL... RECEIPT_VOL...
CERT_PAYMEN.. RECEIPT_VOU.. RECEIPT_\OU..
CHECE_DATE RECEIPT_VOL... RECEIPT_VOL...
CHECK_NUMBER RECEIFT_VOL.. RECEIPT_VOL...
CHECK_PROCE... RECEIPT_VOU RECEIPT_vOU
CURREMCY_CO... RECEIFT_VOL.. RECEIPT_VOL..
DATS_LATE RECEIFT_vOU. RECEIPT_vOL
DaYS_PAID RECEIPT_VOL... RECEIPT_VOL...
DELVERY_OR RECEIFT_vOU. RECEIPT_vOL
DISBURSE_AMT  RECEIPT_VOLL.. RECEIPT_VOLL...
DISE_STATIOM... RECEIPT_VOU.. RECEIPT_VOU..
DISCOUMT_DATE RECEIPT_VOL.. RECEIPT_VOL...
DISCOUMT_DAYS RECEIPT_VOL.. RECEIPT_VOL...
DISCOUMT_PE RECEIFT_vOU. RECEIPT_vOL

DOV_NOD RECEIFT_VOU... RECEIPT_VOU..
FC_RATE RECEIPT_vOU RECEIPT_vOU
FC_SYMBOL RECEIPT_VOU... RECEIPT_VOU..

INTEREST_AMT  RECEIPT_VOU.. RECEIPT_VOU...
INTEREST_PRA... RECEIPT_VOLU... RECEIPT_VOU..
INTEREST_FRaA... RECEIFT_VOL.. RECEIPT_vOU..
INT_PEM_CODE  RECEIPT_\OU RECEIPT_vOU

LR_CODE RECEIFT_VOU... RECEIPT_VOL...
Group Fields
Field Alias Field SOL Alias Table SOL Alias
CONTRACT_ID RECEIPT_VOUCHER.CONTRACT_ID RECEIPT_YDUCHER
INV_NO RECEIPT_WOUCHER.INY_NO RECEIPT_YOUCHER
.. L =
™ i P i e e ___’,_f"'_,ir'.y-—- - b —
T

This is saying to group by CONTRACT _ID and INV_NO so our sums and max values will now be for a
given contract/invoice which is exactly what we need.

11.10 Step 9 - Linking the DataViews

At this point we have 2 dataviews. One for the Contract/Invoice and another for the Receipts for an
invoice. Now, we need to link them together.
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RMS Report Designer || de_rms.world ]: SampleS

File
Data | Caic | Design | Preview |
R M BOBTAN & | E#mavqs4| & &
Han [ Tpe | siee | Name Typs | Size
[mEouTRALT D e 2
CONTRACT_ID St 25
FBI FMT_CONTRACT_DELIVERY Siing 22 Eg}mv T De
[ PROJ_MAME Sting 40 g Double
[y mv_na Double [7] ¥_DATE DateTime
[[) INv_RECD_DATE DateTime [ WTEREST Donhle
[P ENGS3_COMPLETE Sting 1 -
A CEFMS_APPROVAL_STATUS Stiing 1
[B] FINAL Sting 1
[B) FLFROM DateTime
[B) THRU DateTime
[p) INVOICE_DATE DateTime
[f) DUEDATE DateTime
LBl CURRENT_PAYMENT Double
L = N J—D!"’ e it T
#a’puﬁwﬂwdﬁmm _’-P-J c“ M‘
R

Grab the CONTRACT_ID field with your mouse in the RECEIPT_VOUCHER dataview and drag it
over to the CONTRACT _ID in the CONTRACT view. That makes the link between our two dataviews.
But, we need to link by CONTRACT _ID AND INV_NO. If you try to create a second link by dragging
the INV_NO field, you will see that your first link vanishes. Since we need both, we have to edit the
link. With your mouse, double click on the link created:

CONTRACT. A RECEIPT_Y¥OUCHER linked to CONTRACT
Biemevas|~ | 3 R #oevAl &
Mame | Twpe | size |
[ CONTRACT_ID Sting 25 L e
[ FMT_CONTRACT_DELIVER'Y Sting 2 NN
LI PROJ_NAME Sting 40 Double Click an Link Double
ANV ND Double o
[ INV_RECD_DATE DateTime ‘ P
R ENGS3_COMPLETE Sting 1
[ CEFMS_APPROVAL STATUS sving 1
[l FINAL Sting 1
IR FLFROM DateTime
[AI THRU DateTime
[ IMVDICE_DATE DateTime
[ DUEDATE DateTime
[ CURRENT_PAYMENT Double

#VWMNU‘mM;#JﬁmCéw ’!...“___,\j
T
=

When you double click the link, you will get the link editor. Set the options as shown including the #2
radio button which makes the link work like an outer join.
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7+ Link RECEIPT_VOUCHER as Detail M=
Detail - RECEIPT_VOUCHER Master - CONTRALT
CONTRACT_ID ~
FMT_CONTRACT_DELIVER!

PROJ_MAME

INY_RECD_DATE
ENGI3_COMPLETE
CEFMS_APPROVAL_STATU
FINAL

FLFROM

THRU v

Linked Fields

CONTRACT_ID -» CONTRACT_ID
IMy_NO - INV_ND

Clear

-

1 Include only thaze recards frorm COMTRACT far which matzhing
RECEIPT_VOUUCHER recaords can be found.

2 Include all recards fram COMTRALCT . regardless af whether any

%)
]

matching RECEIPT _VOUCHER recaords can be found. Cancel

11.11 Step 10 - Add aregion and DBText Field to the detail band

Switch to the design tab and drop a region into the detail band. Set it to ParentHeight and
ParentWidth. Some of our detail band will have to be done using variables and calcs so for now, just
ad din the following DBText objects:
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11.12

11.13

RMS Report Designer || de_rms.world ]: SampleS
Fle Edt View Report Help

Data | Cae  Desian | Preview |
h | AlEn@eEt | ao8 AEEESDSS ama@
[Regant = BE -] | 1 U
B8 | a us'H B2
s

IR PO R [ R I R R g R . "

US Army Coips
- of EnglReers. - - - — — B -

“ Footer

Set the fields of each of these DBText objects to the appropriate field - They are self explanatory.
Step 11 - Add a Variable Object for the Invoice Number

We have a special requirement for our invoice number. If there is no invoice for the current month,
then we want to show the next available invoice number and add a red label indicating that the invoice
is projected. IN other words, if the contract had invoice 20 done last month, and there is no invoice
entered for this month yet, we want to print 21 and say projected to indicate that the invoice hasn't
even been created yet for this month.

Drop a variable into the column for the Payment No and also a label. Set the label text and color as
shown.

U ey Cofps oo
- - -of Englneers.

~ Detail

Step 12 - Set the name of the Report Objects using the Report
Tree
Got to View > Toolbars > ReportData Tree and you should see the following screen. Your objects will

have generic names like dbtextl and variablel. To make it more manageable, change the names as
shown here, matching them to the correct object.
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Report Tree
Object Dutline

A LabelZs
=i Detail
- Region
LA DBETex
LA DBETem?
LA dhtFram
LA dbtT ke
L dbtrvoiceDate
LA dbtrvoiceR eceivedDate
L dbtPsidDate
L4 dbtamountDue
LA dbtnterestDu
A blProject
L4 dbtDueD ate
=i Footer
El Shapes
3R Swater aniable?
Properties for vrblnvaiceMa
B Appearance
Blank wherZemn r
Border [TppBorder)
Color [ chathite
Tranzparent 2
Wisible ~
B Calculations
CalcComponent
CalcOrder ]
CalcType vel raversal
Lookshead r
FezetComponent
FezetType veReportEnd
E Identity
lzerMame viblrvoiceMo
B Layout
Height 015629335
Left 28020933
Top 0.083300002
) wiidth 03854 rr "
. . = TTH
R R i 4

This tree shows you all of the objects in your report and lets you set certain properties for those
objects. We are going to have lots of variables for this report so we want to give them meaningful
names rather than using generic names created automatically for us. Click on the variable object and
rename it to vrblnvoiceNo.
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11.14 Step 13 - Add remaing variable objects

11.15

Just as with the invoice number variable, we have to do special handling for all of the following. Add
variables for all of these:

vrblsCompleted
vrblsApproved
vrblsPaid
vrblsFinal
vrbDaysLate
vrbContractorPaid

Position them as shown here:

B iy Gt | o ooene TAYMENT TOT A 200
- - -of Englnoors..

Contract o ¢ From IvoiceDate  Payment Due  Days

Cortract Tile | Th  ficiceReceived  DatzPadl  Lats

Header
FREDMONTRACT DELMERY: [OCENE  Secehied  moled  oived  ciobad sibfrel  ---TLTOM (OICEDATE  LIDUEDATE oo

PROJMAME ... e e i THE 0 DAT] LMD

iProfected]
“ Detail
P ;) S IRt S S, _'_,._____,..___i""

Step 14 - Add RAP code to handle the invoice number variable
and visible properties

Now lets start adding our RAP code to set and use all of these variables. Go to the Calc tab and click
on the Detail band. In the events window, highlight the BeforeGenerateEvent and insert all of this
code:

var
Curr Year: i nt eger;
Cur r Mont h: i nt eger;;
CurrDay: i nt eger;
ThruYear: i nt eger;
ThruMont h: i nt eger;
ThruDay: i nt eger;
Thr uDat e: Dat e;
begi n
Thr uDat e: =CONTRACT[ ' THRU ] ;
DecodeDat e( ThruDat e, ThruYear, ThruMonth, ThruDay);
DecodeDat e(Current Date, CurrYear, CurrMonth, CurrDay);

i f (ThruMont h<>CurrMonth) or (ThruYear<>CurrYear) then
begi n

vr bl nvoi ceNo. Val ue: =CONTRACT[ ' | NV_NO ] +1;

| bl Proj ected. Visible:=true;

vr bl sRecei ved. Vi si bl e: =f al se;

vr bl sConpl et ed. Vi si bl e: =f al se;

vr bl sApproved. Vi si bl e: =f al se;

vr bl sCont ract or Pai d. Vi si bl e: =f al se;

vr bl sFi nal . Vi si bl e: =f al se;

dbt From Vi si bl e: =f al se;

dbt Thru. Vi si bl e: =f al se;
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dbt | nvoi ceDat e. Vi si bl e: =f al se;
dbt I nvoi ceRecei vedDat e. Vi si bl e: =f al se;
dbt Pai dDat e. Vi si bl e: =f al se;
dbt Anrount Due. Vi si bl e: =f al se;
dbt | nt er est Due. Vi si bl e: =f al se;
vrbDayslLat e. Vi si bl e: =f al se;
dbt DueDat e. Vi si bl e: =f al se;
end
el se
begi n
vr bl nvoi ceNo. Val ue: =CONTRACT[ ' | NV_NO ]
| bl Proj ected. Visibl e: =fal se;
vr bl sRecei ved. Vi si bl e: =t rue;
vr bl sConpl et ed. Vi si bl e: =t r ue;
vr bl sApproved. Vi si bl e: =true;
vr bl sCont ract or Pai d. Vi si bl e: =t rue;
vr bl sFi nal . Vi si bl e: =true;
dbt From Vi si bl e: =t r ue;
dbt Thru. Vi si bl e: =t rue;
dbt | nvoi ceDat e. Vi si bl e: =t rue;
dbt | nvoi ceRecei vedDat e. Vi si bl e: =t rue;
dbt Pai dDat e. Vi si bl e: =t rue;
dbt Anrount Due. Vi si bl e: =t rue;
dbt | nt er est Due. Vi si bl e: =t rue;
vrbDayslLat e. Vi si bl e: =tr ue;
dbt DueDat e. Vi si bl e: =t r ue;

end;

i f CONTRACT[' | NV_RECD DATE']=0 then
dbt DueDat e. Vi si bl e: =f al se;

i f CONTRACT[' EN&®®3_COVPLETE' ]<>'"Y' then
begi n
vr bl sConpl et ed. Vi si bl e: =f al se;
vr bl sApproved. Vi si bl e: =f al se;
vr bl sContract or Pai d. Vi si bl e: =f al se;
vr bl sFi nal . Vi si bl e: =f al se;
dbt From Vi si bl e: =f al se;
dbt Thru. Vi si bl e: =f al se;
dbt | nvoi ceDat e. Vi si bl e: =f al se;
dbt I nvoi ceRecei vedDat e. Vi si bl e: =f al se;
dbt Pai dDat e. Vi si bl e: =f al se;
dbt Anrount Due. Vi si bl e: =f al se;
dbt | nt er est Due. Vi si bl e: =f al se;
vrbDayslLat e. Vi si bl e: =f al se;
dbt DueDat e. Vi si bl e: =f al se;
end;
end;

The code looks worse than it really is. Its just comparing the thru date of the invocie for a contract with
the current system date. If it does not match the current month, then there is no invoice so it sets the
vrbinvoiceNo variable to the next highest invoice and turns all of the other objects to invisible so they
will not show.
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11.16 Step 15 - Add RAP code for remianing variables

Now lets set the actual value for the remaining variables by writing a RAP event for each one.

Right click on the vrbisReceived variable and select calculations. An editor opens. Add the simple

code as shown:

R Calculations

Code Toolbowx: Data

if CONTRACT['IMNYV RECD DATE']=0 then
value:='HNo'

else
walus:='Tez';

= CONTRACT
RECEIPT_VOUCHER

Fields for COMTRACT

Mame Type Size
£ CEFMS_APPROVAL | R Il
i CONTRACT_ID String 26
i CURRENT_PAYMEMT Double

i DUEDATE DateTime

i EMGI3 COMPLETE | String 1
i FINAL String 1
i FLFROM DateTime

i FMT_COMTRACT _DE Sting 22
HMNV MO Double

i INY_RECD_DATE | DateTime

i INWOICE_DATE DateTime

i PROJ_NAME String 40
it THRU DateTime

i b P Jli-ii"" B _\‘w'a.ta.a{-m lﬁ"‘! malbia: . :

repeat the same for all of the following using the code provided:

vrblsReceived:

i f CONTRACT[' | NV_RECD DATE ]=0 then
val ue: =' No'

el se
val ue: =' Yes';

vrblsCompleted:

i f CONTRACT[' ENG®®3_COVPLETE ]1="Y'
Val ue : = 'Yes'

el se
Value := 'No';

t hen
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11.17

vrblsApproved:
i f CONTRACT[ ' CEFMS_APPROVAL_STATUS ]1='A" then

Val ue : = 'Yes'
el se
Value := "No';

vr bCont r act or Pai d:
i f RECEI PT_VOUCHER[' V_AMI" ] >=CONTRACT[ ' CURRENT_PAYMENT' ] t hen
Val ue : = 'Yes'

el se
Val ue: ="' No' ;

vr bl sFinal :

if CONTRACT[' FINAL']="Y"' then
Val ue : = ' Yes'

el se
Value := 'No';

vr bDayslLat e:

i f RECElI PT_VOUCHER] ' V_AMT" ] >=CONTRACT[ ' CURRENT _PAYMENT' ] then
Dat ePai d: =RECEI PT_VOUCHER] ' V_DATE' ]

el se
Dat ePai d: =RECElI PT_VOUCHER[ ' V_DATE' | ;

i f ( CONTRACT[ ' DUEDATE' ] <>0) and ( Dat ePai d<>0) and
( CONTRACT][ ' DUEDATE' ] <Dat ePai d) t hen
Val ue: =Dat ePai d- CONTRACT[ ' DUEDATE' ]

el se
Val ue: =0;
Summary

141

This report used a lot of RAP code and some interesting Oracle functions and groups. Its a good

example of how a simple loking report can get complex due to the storage of the data.
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12 Example 12 - Scheduled Construction Events

12.1 Overview

This report shows some of the scheduled events for contracts. It includes milestones, preparatory
inspections, initial inspections, correspondence and change requests. It uses many subreports all
linked to one driving dataview and shows how to handle some advanced autosearch criteria issues.

Scheduled Construction Events 18-Aug-07
UE Army Corps
of Engineors.. 3/11/2007 thru 5/11/2007
DACA83-03-D-0015 0012 FYO05 OMA Pkg A-001, Rstr 1st Floor, B108
Milestone Events Date Scheduled  Actual Date
Canstruction Start Date 04/032007 04/03/2007
Preparatery Inspection Date Scheduled Actual Date
01525 SAFETY PLAN 03r2172007 1:00 PM 03r212007
02082 LBP- SEL DEMO 04/02/2007 8:00 A 04/05/2007
01500 TEMP COMSTFACILITIE 045032007 2:00 PM 04/03i2007
132804 ASBESTOS ABATEMENT 04f05/2007 08:30 A 04/05i2007
01451 CONTR QLTYCONTROL 04/05/2007 10:00 Ad 04/05/2007
01312 CONTR QLTYCONTROL S 04/05/2007 1:00 PM 04/05/2007
02092 LBP  ABATEMENT 0470572007 9:00 At 04/05/2007
SHT A-1 SELECTIVE DEMOLITIO 04/05/2007 04/05/2007
01900 MISCELLANEPROVISION 0411272007 01:00 PM 04/1212007
01420 EMVIRO PROTPLAM 0452072007 1:00 Pm 04/20i2007
Initial Inspections Date Scheduled Actual Date
01525 GAFETY PLAN 0M21/2007  1:00FM 03/21i2007
01500 TEMP CONSTFACILITIE 04032007 2:00PM 040312007
01451 CONTR QLTYCONTROL 04i05/2007 10:00 AM 04/05i2007
01312 CONTR QLTYCONTROL S 04i05/2007 1:00 PM 04/05i2007
01900 MISCELLANEPROVISION 041272007 1:00FM 0471202007
01430 ENVIRO PROTPLAN 04/20/2007 1:00 P 04/20/2007
02082 LBP-SEL DEMO 0412472007
02082 LBP  ABATEMENT 0412472007 0472412007
132804 ASBESTOS ABATEMENT 04f30/2007 0473002007
SHT A1 SELECTIVE DEMOLITIO 04¢30/2007
| Correspondence Requiring Answer Date Scheduled Actual Date ‘
RFP-0002 04/03/2007
Change Requests with Mod Due Date Scheduled Stage Code ‘
cloo1 Rev"h" Retain Interior Historical Wialls 031es2007 5

Skills shown:

- Multiple SubReports

- Sharing Autosearch criteria in multiple queries.
- Subreport shift relative to.

- Accessing the text of autosearch criteria

- RAP Function to convert Dates to Strings

12.2 Step 1- Load the Landscape Template and Set the title

Load the RMS Landscape Template and set the Report title
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12.3

RMS Report Designer [ DC_RMS.WO)
Fle Edit Wew Report Help

Data | Cale  Desion | Preview|

b | ADEwEah  aos  ARDPemme®| |80

| \ [[ewa I Sllezry 1Y
2-2-m==|0s wmm|as ow|kad | Ten wE WE DSH 0NSR | sb@

ERE T I I S L L | N N LN A A LN S L (SR [

US Ay Coips.
of Englnesrs.

* Header

* Detail

“ Footer

Ready.

Left: 0 Top: 0 Width: 0 Height: O A

Step 2 - Create the Contract Query
From the data tab select File > New > Query Designer.

Select the CONTRACT table and add the following fields

R Query Designer

Tables Fields |Calcs I Groupl Searchl Sart I 500 I

[B Available Fields

Field Alias [ Field SOL Alias | Table SAL Alias | ~

ACO_AGENT_C.. COMTRACTAC. COMTRACT ]

ACTIMITY_VARL. COMTRACTAC. COMTRACT

ACT_PER COMTRACT.AC.  COWTRACT

ACT_PER_LESS.. COMTRACTAC. COMTRACT

ACT_PLCMT COMTRACT.AC.  COWTRACT

ACT_TOT COMTRACT.AC.  COWTRACT

AE_ADDRESS1  COMTRACTAE. COMTRACT

AE_ADDRESSZ  COMTRACTAE. COMTRACT

AE_ADDRESS3  COMTRACTAE. COMTRACT

AE_EVAL_ACT  COMTRACTAE. COMTRACT

AE_EVAL_RO  COMTRACTAE. COMTRACT

AE_EVAL_SCH  COMTRACTAE. COMTRACT

AE_TITLE COMTRACT.AE.. COMTRACT

ALT_REP COMTRACT.AL..  COWTRACT

ALT_REF2 COMTRACT.AL..  COWTRACT

ALT_REF3 COMTRACT.AL..  COWTRACT

#WERD_AE DE  COMTRACTA.  COMTRACT

AWERD_ALLOC.. COMTRACTA.  COMTRACT ~

Selected Fields I~ A&l Fields

Field Alias | FieldSOL Alas | TableSOLAkas |

FMT_CONTRACT_DELIVERY COMTRACT.FM.. CONTRACT

PROJ_NAME COMTRACT.PR.. CONTRACT

COMTRACT_ID COMTRACT.CO.. CONTRACT
|
=

Cancel |

Switch to the sort tab and sort the query by FMT_CONTRACT_DELIVERY
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R Query Designer

Tables] Fields ] Calcs ] Groupl Search Sort ]SQL ]
%l Available Fields

Field Alias | Field SOL &as | Table SAL Alias |

S

ACO_AGENT_C.. COMTRACT.AC.. COMTRACT

ACTIVITY_WARL.. COMTRACT.AC.. COMTRACT

ACT_PER COMTRACT.AC.. COMTRACT

ACT_PER_LESS.. COMTRACT.AC.. COMTRACT

ACT_PLCMT COMTRACT.AC.. COMTRACT

ACT_TOT COMTRACT.AC.. COMTRACT

AE_ADDRESST COMTRACT.AE.. COMTRACT

AE_ADDRESS2  COMTRACT.AE.. COMTRACT

AE_ADDRESS3  COMTRACT.AE.. COMTRACT

AE_EVAL_ACT COMTRACT.AE.. COMTRACT

AE_EVAL RO COMTRACT.AE.. COMTRACT

AE_EWVAL_SCH COMTRACT.AE.. COMTRACT

AE_TITLE COMTRACT.AE.. COMTRACT

ALT_REP COMTRACT.AL.. COMTRACT

ALT_REPZ COMTRACT.AL.. COMTRACT

ALT_REP3 COMTRACT.AL.. COMTRACT

AwARD_AE_DE  COMTRACT.A.. COMTRACT

AwARD_ALLOC.. COMTRACT.A.. COMTRACT

AwWARD_APPR... COMTRACT.A.. COMTRACT

AwWARD_AUTH... COMTRACT.A.. COMTRACT

AwARD_BID_O.. COMTRACT.A.. COMTRACT

AwARD_BID_T... COMTRACT.A.. COMTRACT v

Sort Fields ™ Matural Order

Field Alias Field SOL Alias Table SGL Alias Desc(z> a]

FMT_CONTRACT_DELIVERY COMTRACT.FMT_CONTRACT_DELNWERY COMTRACT
|
|

Cancel

12.4 Step 3 - Create the EVENT Query

Select File > New > Query Designer

Select the EVENT table and select the following fields:
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R Query Designer

Tables Fields ]Calcs ] Groupl Search] Sart ] sS0L ]

[A Available Fields

Field Alias | Field SOL &as | Table SAL Alias |

ACTIWITY_ID EVENT.ACTIVI.. EVENT

DATE_ORG EVENT.DATE_.. EVENT

DO_MOT_DEL EVENT.DO_MO... EVENT

EVEWNT_CODE EVENT.EVENT... EVENT

EVENT_ID EVENT.EVENT... EVENT

EVENT_RO EVENT.EVENT... EVENT

EVENT_TIME EVENT.EVENT... EVENT

LAG_LEAD EVENT.LAG_LE.. EVENT

LINK_EVENT_C.. EWENT.LINK_E.. EVENT

LINK_TvFE EVENT.LINK_T... EVENT

MILESTOME_C... EWENT.MILEST.. EVENT

NEEDTIME EVENT.MEEDTI.. EVENT

ORDER_MO EVENT.ORDER.. EVENT

PHASE_ID EVENT.PHASE... EVENT

SUBGROUP EVENT.SUBGR.. EVENT

TIME_WaLUE EVENT.TIME_Y.. EVENT

Selected Fields [~ Al Fields

Field Alias Field SOL Alias Table SOL Alias

COMTRACT_ID EVENT.CONTRACT_ID EVENT

EVENT_DS EVENT.EVENT_DS EVENT ﬂ

DATE_SCH EVENT.DATE_SCH EVENT

DATE_ALCT EVENT.DATE_ACT EVENT ﬂ
Cancel

Switch to the sort tab and sort the table by DATE_SCH

R Query Designer

Tables] Figlds ] Calcs ] Group] Gearch ot ]SQL ]
81 mvasilable Fields
Field Alias | Field SOL Aias | Table SOL Alias |
ACTIVITY_ID EVEMT.ACTIVI..  EVENT
COMTRACT_ID EVEMT.COMTR... EVENT
DATE_ALCT EVEMT.DATE_.. EVENT
EVEMT.DATE_.. EVENT

i EVENT.DO_NO.. EVENT
EVEMT_CODE EVEMT.EVEMT... EVENT
EVEMT_DS EVEMT.EVEMT... EVENT
EVEMT_ID EVEMT.EVEMT... EVENT
EVEMT_RO EVEMT.EVEMT... EVENT
EVEMT_TIME EVEMT.EVEMT... EVENT
LAG_LEAD EVEMT.LAG_LE.. EVENT
LIMK_EVENT_C.. EWEMT.LIMK_E.. EVENT
LIMK_TPFE EVEMT.LIMKE_T... EVENT
MILESTOME_C... EWEMT.MILEST.. EVENT
MEEDTIME EVEMT.MEEDTI.. EVEMT
ORDER_MO EVEMT.ORDER.. EVEMT
PHASE_ID EVEMT.PHASE... EVENT
SUBGROUP EVEMT.SUBGR... EVENT
TIME_WALUE EVEMT.TIME_Y.. EVENT
Sort Fields [~ Matural Order
Field Aliaz Field SOL Alias Table SOL Alias Desc(z> a
DATE_SCH EVENT DATE_ EVEMT

|
|
Cancel
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12.5

Switch to the Search tab and set the following criteria:
R Query Designer __|[E|Pz|

Tables] Fields ] Calcs ] Group Search ]Sort ] 500 ]
O Available Fields
Field &lias [ FieldSOLAkas [ Table SOL Alias |

ACTIVITY_ID EVENT.ACTIVI.. EVENT
CONTRACT_ID EVENT.CONTR.. EVENT

DATE_ALCT EVENT.DATE_.. EVENT
DATE_ORG EVENT.DATE_.. EVENT
DATE_SCH EVENT.DATE_.. EVENT

DO_WOT_DEL EVENT.DO_MO.. EVENT
EVENT_CODE EVENT EVENT... EVENT

EVENT_DS EVENT EVENT... EVENT
EVENT_ID EVENT EVENT... EVENT
EVENT_RO EVENT EVENT... EVENT
EVEMT_TIME EVENT EVENT... EVENT
LAG_LEAD EVENT.LAG_LE.. EVENT
LINK_EVENT_C... EVENT.LINK_E.. EVENT
LINK_TvPE EVENT.LINE_T... EVENT
MILESTOME_C... EVENT.MILEST.. EVENT
NEEDTIME EVENT MEEDTI.. EVENT
ORDER_NO EVENT.ORDER.. EVENT
FPHASE_ID EVENT.PHASE.. EVENT
SUBGROUF EVENT.SUBGR.. EVENT

TIME_WaLUE EVENT.TIME_Y.. EVENT

Criteria

Field Operator Walue AutoSearch | Mandatory Show &l
EVEMNT DATE_SCH ¥= Yes Tes

EVEMNT DATE_SCH <= Yes Tes

|
|
Cancel

NOTE: We will reuse this same criteria on all o f the rest of our pipelines by using some RAP code.
This is the only one we will set in the query designer. If we set all of the queries in the query designer,
then the user would get prompted multiple times.

Step 4 - Create the Prep Query

Select File > New > Query Designer and select the FEATURE_QA table and then the FEATURE
table. Join them by CONTRACT_ID and FEATURE_ID using an inner join
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R Query Designer
] Fields ] Calos ] Groupl Search] Sort ] saL ]
Available Tables

EBX

Table Table Name 2
ACCIDENT ACCIDENT

ACTMTY_DESC  ACTMTY_DESC =
ACTMTY_PAY_HISACTITY_Pay_HIE

ACTMTY_QA ACTIATY_O&

ACTMTY_SCHEDUACTITY_SCHEDL

AGENCY AGENCY

AGENT AGENT

AHA_HAZARD AHA_HAZARD

AHA_STEP “HA_STEP

ANT_WEATHER  ANT_WEATHER

APPYU_COMTRACTAPPYU_CONTRAL

APPYU_COMTRACTAPPYU_CONTRAL

APPYU_COMTRACTAPPYU_CONTRAL

BASELINE_LIBRAR BASELINE_LIERAR

BASELINE_OFFICE BASELINE_OFFICE

BID BID

BID_CHANGE BID_CHAMGE

BID_CHANGE_OBLIBID_CHAMGE_OBL

BID_OBLI BID_OBLI

CALENDAR CALEMNDAR

CATEGORIES CATEGORIES

CATEGORY CATEGORY v
Selected Tables [~ Distinct
Table Table Mame SOL Alias Join Type:

FEATURE_OA FEATURE_QA FEATURE_QA

FEATURE FEATURE FEATURE Inner

Cancel

Join Tahle

Join Type

| [rner

FEATURE Fields

COMTRACT_ID
FEATURE
FEATURE_ID
FIMISHED
FINISH_DATE
FIRST_ACTDS
FIRST_ACTID
FOLLOW _COUNT
GO STATUS

Jaoined Fields:

3

| &

[
[ e

Join FEATURE T able with

FEATURE_OA Fields

COMTRACT_ID ”
FEATURE_ID E
IMIT_HELD

INIT_SCHL

INIT_TIME

FREP_HELD

FREP_SCHL B
FREP_TIME
QAYVERSION

£

FEATLURE Field

FEATURE.CONTRACT_ID
FEATURE.FEATURE_ID

Operator

FEATURE_GA Field

FEATURE_OA.CONTRACT_ID
FEATURE_OAFEATURE_ID

Cancel

o]

USACE



Example 12 - Scheduled Construction Events 149

Select the fields as shown here:

R Query Designer

Tables Fields ]Calcs | Group | Search| sot | saL |
[A] Available Fields

Field Alias | Fied SOL &fias | Table SOL Alias | ~
FEATURE_ID FEATURE Q4. ..  FEATURE_OA
INIT_HELD FEATURE_G4).. FEATURE_QA
INIT_SCHL FEATURE_G4).. FEATURE_QA
INIT_TIME FEATURE_G4).. FEATURE_QA

QavERSION FEATURE_QA... FEATURE_QA
QCVERSION FEATURE_QA... FEATURE_QA
COMTRACT_ID FEATURE.COM... FEATURE
FEATURE_ID FEATUREFEA.. FEATURE
FINISHED FEATUREFINI.. FEATURE
FINISH_DATE FEATUREFINI.. FEATURE
FIRST_ACTDS FEATUREFIRS.. FEATURE B
FIRST_ACTID FEATUREFIRS.. FEATURE
FOLLOW _COUNT FEATUREFOLL.. FEATURE
GOV_STATUS FEATURE.GOY... FEATURE
HaZaRD_ACCE.. FEATIIREHAZ..  FEATURE
HaZaRD_ACCE.. FEATIIREHAZ..  FEATURE
HeZaRD_COMP.. FEATIIREHAZ..  FEATURE
HaZaRD_COMT... FEATUREHAZ..  FEATURE

HeZaRD EGQUL..  FEATURE HAZ FEATURE b
Selected Figlds [~ AllFields
Field Alias Field SOL Alias Tahle SOL Alias
PREP_SCHL FEATURE_Q4.PREP_SCHL FEATURE_OA
PREF_HELD FEATURE_Q4.PREP_HELD FEATURE_OA
FEATURE FEATURE.FEATURE FEATURE
CONTRACT_ID FEATURE_QA.COMTRALCT_ID FEATURE_OA ﬂ
PREP_TIME FEATURE_Q4.PREP_TIME FEATURE_OA

|

And set the sort order as follows:
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R Query Designer

Tables] Fields ] Calcs ] Groupl Search Sort ]SQL ]
%l Available Fields
Field Alias | Field SOL &as | Table SAL Alias | -

CONTRACT_ID FEATURE_@A... FEATURE_OA
FEATURE_ID FEATURE_@A... FEATURE_OA

IMIT_HELD FEATURE_QAI.. FEATURE_QA
IMIT_SCHL FEATURE_QAI.. FEATURE_QA
INIT_TIME FEATURE_QAI.. FEATURE_QA

PREF_HELD FEATURE_@A... FEATURE_OA
GaYERSION FEATURE_@A... FEATURE_OA
QCYERSION FEATURE_@A... FEATURE_OA
CONTRACT_ID FEATURE.COM... FEATURE

FEATURE FEATUREFEA.. FEATURE
FEATURE_ID FEATUREFEA.. FEATURE
FINISHED FEATUREFINI.. FEATURE

FINISH_DATE FEATUREFINI.. FEATURE
FIRST_ACTDS FEATUREFIRS.. FEATURE
FIRST_ACTID FEATUREFIRS.. FEATURE
FOLLOWw _COUNT FEATUREFOLL.. FEATURE
GOYV_STATUS FEATURE.GOY... FEATURE
HeZaRD_ACCE.. FEATUREHAZ..  FEATURE
HeZaRD_ACCE.. FEATUREHAZ..  FEATURE
HeZaRD_COMP.. FEATUUIREHAZ..  FEATURE
HeZaRD_CONT... FEATUREHAZ..  FEATURE
HeZaRD_EQUL..  FEATUREHAZ..  FEATURE

v
Sort Fields ™ Matural Order
Field Alias Field SOL Alias Table SGL Alias Desc(z> a)
PREP_SCHL FEATURE_QA FPREP_SCHL FEATURE_QA
FREP_TIME FEATURE_QA.FREP_TIME FEATURE_QA -
|

Cancel

12.6 Step 5 - Create the Initial Query

Select File > New > Query Designer and select FEATURE_QA and FEATURE. Join them by
CONTRACT _ID and FEATURE_ID as before using an inner join.
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R Query Designer
] Fields ] Calos ] Groupl Search] Sort ] saL ]
Available Tables

Table Table Name 2
ACCIDENT ACCIDENT

ACTMTY_DESC  ACTMTY_DESC =
ACTMTY_PAY_HISACTITY_Pay_HIE

ACTMTY_QA ACTIATY_O&

ACTMTY_SCHEDUACTITY_SCHEDL

AGENCY AGENCY

AGENT AGENT

AHA_HAZARD AHA_HAZARD

AHA_STEP “HA_STEP

ANT_WEATHER  ANT_WEATHER

APPYU_COMTRACTAPPYU_CONTRAL

APPYU_COMTRACTAPPYU_CONTRAL

APPYU_COMTRACTAPPYU_CONTRAL

BASELINE_LIBRAR BASELINE_LIERAR

BASELINE_OFFICE BASELINE_OFFICE

BID BID

BID_CHANGE BID_CHAMGE

BID_CHANGE_OBLIBID_CHAMGE_OBL

BID_OBLI BID_OBLI

CALENDAR CALEMNDAR

CATEGORIES CATEGORIES

CATEGORY CATEGORY v
Selected Tables [~ Distinct
Table Table Mame SOL Alias Join Type:

FEATURE_OA FEATURE_QA FEATURE_QA

FEATURE FEATURE FEATURE Inner

Cancel

Join Tahle

Join Type

| [rner

FEATURE Fields

COMTRACT_ID
FEATURE
FEATURE_ID
FIMISHED
FINISH_DATE
FIRST_ACTDS
FIRST_ACTID
FOLLOW _COUNT
GO STATUS

Jaoined Fields:

3

| &

Join FEATURE T able with

FEATURE_OA Fields

COMTRACT_ID
FEATURE_ID
IMIT_HELD
INIT_SCHL
INIT_TIME
FREP_HELD
FREP_SCHL
FREP_TIME
QAYVERSION

[
[ e

£

FEATLURE Field

FEATURE.CONTRACT_ID
FEATURE.FEATURE_ID

Operator FEATURE A Field
FEATURE_OA CONTRACT_ID

FEATURE_OAFEATURE_ID

Cancel

o]
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Set the fields as follows:

R Query Designer

Tables Fields ]Calcs | Group | Search| sot | saL |

[0 Available Fields

Field Alias | Fied SOL &fias | Table SOL Alias | ~
PREF_HELD FEATURE Q4. ..  FEATURE_OA

PREF_SCHL FEATURE_G4. . FEATURE_DA

PREF_TIME FEATURE_G4. . FEATURE_DA

DAVERSION FEATURE_G4. . FEATURE_DA

OCVERSION FEATURE_G4. . FEATURE_DA

COMTRACT_ID  FEATURE.COM.. FEATURE

FEATURE_ID FEATUREFEA.. FEATURE 3
FINISHED FEATUREFINL.  FEATURE

FIMSH_DATE ~ FEATUREFINI.  FEATURE

FIRST_ACTDS  FEATUREFIRS.. FEATURE

FIRST_ACTID  FEATUREFIRS.. FEATURE

FOLLOW _COUNT FEATURE.FOLL . FEATURE

GOV_STATUS  FEATURE.GOV.. FEATURE

HAZARD_ACCE .. FEATUREMAZ.. FEATURE

H&Z&RM AFTF FFATIIRF H&7 FFATIIRF s
Selected Fields [~ AllFields
Field Alias Figld SOL Alias Table SOL Alias
INIT_SCHL FEATURE_BA.INIT_SCHL FEATURE_QA
INIT_HELD FEATURE_BA.INIT_HELD FEATURE_Q&
INIT_TIME FEATURE_QA.INIT_TIME FEATURE_Q&
FEATURE_ID FEATURE_RAFEATURE_ID FEATURE_Q&
CONTRACT_ID  FEATURE_GA.CONTRACT_ID FEATURE_Q& ﬂ
FEATURE FEATURE.FEATURE FEATURE

|

And the sort:
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R Query Designer

Tables] Fields ] Calcs ] Groupl Search Sort ]SQL ]
%l Available Fields

Field Alias | Field SOL &as | Table SAL Alias | -
COMTRACT_ID FEATURE_QA... FEATURE_QA
FEATURE_ID FEATURE_QA... FEATURE_QA
IMIT_HELD FEATURE_QAI.. FEATURE_QA
FREP_HELD FEATURE_QA... FEATURE_QA
PREP_SCHL FEATURE_QA... FEATURE_QA
FREP_TIME FEATURE_QA... FEATURE_QA
GaYERSION FEATURE_QA... FEATURE_QA
GQCYERSION FEATURE_QA... FEATURE_QA
COMTRACT_ID FEATURE.COM... FEATURE

FEATURE FEATUREFEA.. FEATURE
FEATURE_ID FEATUREFEA.. FEATURE
FINISHED FEATUREFINI.. FEATURE

FINISH_DATE FEATUREFINI.. FEATURE
FIRST_ACTDS FEATUREFIRS.. FEATURE
FIRST_ACTID FEATUREFIRS.. FEATURE
FOLLOWw _COUNT FEATUREFOLL.. FEATURE
GOYV_STATUS FEATURE.GOY... FEATURE
HeZaRD_ACCE.. FEATUREHAZ..  FEATURE
HeZaRD_ACCE.. FEATUREHAZ..  FEATURE
HeZaRD_COMP.. FEATUUIREHAZ..  FEATURE
HeZaRD_CONT... FEATUREHAZ..  FEATURE
HeZaRD_EQUL..  FEATUREHAZ..  FEATURE

v
Sort Fields ™ Matural Order
Field Alias Field SOL Alias Table SOL Alias Desc[z> a]
IMIT_SCHL FEATURE_QAIMIT_SCHL FEATURE_QA
INIT_TIME FEATURE_QAINIT_TIME FEATURE_QA =
|

Cancel

12.7 Step 6 - Create the SER_LOG query

Select File > New > Query Designer. Select SER_LOG from the table list and set the fields as shown
here:
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R Query Designer

Tables ]Calcs ] Groupl Search] Sart ] sS0L ]
[A Available Fields

Field Alias | Field SOL &as | Table SAL Alias |
ANS_BY SER_LOG.ANS..  SER_LOG
ANS_LINE SER_LOG.ANS..  SER_LOG
COE_COMPLET.. SER_LOG.COE.. SER_LOG
EMP_ID_NO SER_LOGEMP.. SER_LOG
FILE_ID SER_LOG.FILE... SER_LOG
FL_CODE SER_LOGFL C. SER_LOG
FL_DATE SER_LOGFL D.. SER_LOG
GOVT_ONLY SER_LOG.GOV... SER_LOG
GR_OWHNER SER_LOG.GR_.. SER_LOG
KTR_COMPLET.. SER_LOG.KTR.. SER_LOG

PC_NO SER_LOGPC_.. SER_LOG

GaYERSION SER_LOG.O&Y..  SER_LDG
QCYERSION SER_LOG.OCY... SER_LDG

RCYD SER_LOGRCYD  SER_LOG
REMARES SER_LOG.REM.. SER_LOG
REQ SER_LOG.REQ SER_LOG
ROUTE SER_LOG.ROU... SER_LOG
SENT SER_LOG.SENT  SER_LOG

UNRESOLYED SER_LOG.UNR... SER_LOG

Selected Fields [~ Al Fields
Field Alias Field SOL Alias Table SGL Alias

SER_ID SER_LOG.SER... SER_LOG

ANS_DUE SER_LOG.ANS..  SER_LOG ﬂ
ANS_DATE SER_LOG.ANS..  SER_LOG

COMTRACT_ID SER_LOG.COM... SER_LOG ﬂ

Cancel

And the sort as shown here:
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R Query Designer

Tables] Fields ] Calcs ] Groupl Search Sort ]SQL ]
%l Available Fields

Field Alias | Field SOL &as | Table SAL Alias |
ANS_BY SER_LOG.ANS.. SEF_LOG
ANS_DATE SER_LOG.ANS.. SEF_LOG
ANS_LINK SER_LOG.ANS.. SEF_LOG

COE_COMPLET.. SER_LOG.COE.. SER_LOG
CONTRACT_ID SER_LOG.COM... SER_LOG

EMP_ID_NO SER_LOGEMP. SER_LOG
FILE_ID SER_LOGFILE.. SER_LOG
FL_CODE SER_LOGFL C.. SER_LOG
FL_DATE SER_LOGFL_D.. SER_LOG
GOVT_ONLY SER_LOG.GOV.. SER_LOG
GR_OWNER SER_LOG.GR_.. SER_LOG
KTR_COMPLET.. SER_LOGKTR.. SER_LOG
PC_NO SER_LOGPC_.. SER_LOG

GaYERSION SER_LOG.O&Y..  SER_LDG
QCYERSION SER_LOG.OCY... SER_LDG

RCYD SER_LOG.RCVD  SER_LOG

REMARES SER_LOG.REM... SER_LOG

REQ SER_LOG.REQ SER_LOG

ROUTE SER_LOG.ROU... SER_LOG

SENT SER_LOG.SEMT  SER_LOG

SER_ID SER_LOG.SER... SER_LOG

UNRESOLVED SER_LOG.UMR... SER_LOG

Sort Fields ™ Matural Order

Field Alias Field SOL Alias Table SGL Alias Desc(z> a)

ANS_DUE SER_LOG.ANS_DUE SER_LOG
|
|

Cancel

12.8 Step 7 - Create the PC_LOG query
(Last one folks)

Select File > New > Query Designer. Select the PC_LOG table and select the following fields
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R Query Designer

Tables Fields ]Calcs ] Groupl Search] Sart ] sS0L ]

[A Available Fields

Field Alias | Field SOL &as | Table SAL Alias | -
AGEMCYCODE PC_LOG.AGEM... PC_LOG

AGREGATE_&MT PC_LOGAGRE.. PC_LOG

AMOUMT_FINAL - PC_LOG.AMOU... PC_LOG

AMT_CEFMS PC_LOGAMT_.. PC_LOG

BCO_APPEY M. PC_LOGBCD.. PC_LOG

BCO_APPEY_TI.. PC_LOGBCD.. PC_LOG

BCO_COMP PC_LOGECD .. PC_LOG -
BCO_DUE PC_LOGECD .. PC_LOG

BCD_RECBY N.. PC_LOGBCD_. PC_LOG

BCO_RECBY_TI.. PC_LOGBCD_. PC_LOG

BCD_RE@EY_M.. PC_LOGBCD .. PC_LOG

BCD_RE@EY_TI.. PC_LOGBCD .. PC_LOG

BCD_RO PC_LOGEBCD .. PC_LOG

CAMCELLED PC_LOG.CANC.. PC_LOG

CLk PC_LOG.CLM PC_LOG

EST_AMT PC_LOG.EST 4. PC_LOG

EST_BY PC_LOG.EST_BY PC_LOG

EST_COMP PC_LOG.EST_C.. PC_LOG

EST_DUE PC_LOG.EST .. PC_LOG

EST_REQ PC_LOGEST_.. PCLOG

EST_RO PC_LOG.EST_RG PC_LOG

EST_TIME PC_LOG.EST_T.. PC_LOG 2
Selected Fields [~ Al Fields
Field Alias Field SOL Alias Table SOL Aliaz

PC_NO PC_LOG.PC_NO FC_LOG |
PC_DS PC_LOG.PC_DS FC_LOG

COMTRACT_ID PC_LOG.CONTRACT_ID PC_LOG

MOD_DUE PC_LOG.MOD_DUE FC_LOG |
TRAN_CODE PC_LOG.TRAN_CODE PC_LOG

Cancel

And finally, sort it by MOD_DUE
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R Query Designer

Tables] Fields ] Calcs ] Groupl Search Sort ]SQL ]
%l Available Fields

Field Alias | Field SOL &lias | Table SOL Alias | ~
CLM FC_LOG.CLM FC_LOG
CONTRACT_ID FC_LOG.CONT..  FC_LOG
EST_AMT FC_LOGEST 4. FC_LOG
EST_BY FC_LOGEST_BY FC_LOG
EST_COMP FC_LOGEST_C.. FC_LOG
EST_DUE FC_LOGEST_. FC_LOG
EST_REQ PC_LOGEST . PC_LOG
EST_FO PC_LOG.EST_RQ PC_LOG
EST_TIME FC_LOGEST_T.. FC_LOG
INCEPTION FC_LOGINCEF.. FC_LOG
ITEM_AMT FC_LOGITEM_. FC_LOG
ITEM_TIME FC_LOGITEM . FC_LOG
MOD_BY FC_LOGMOD_. FC_LOG
iMOD_ND '} FC_LOGMOD_. FC_LOG
MOD_TYFE FC_LOGMOD_. FC_LOG

MULTIPART_FINAL ~ PC_LOG.MULTI.. PC_LOG
MULTIPART_PC_MWO  PC_LOG.MULTI.. PC_LOG

NEGO_&MT PC_LOG.MEGO... PC_LOG

NEGO_COMP PC_LOG.MEGO... PC_LOG

NEGO_RO PC_LOGMEGOD.. PC_LOG

NEGO_TIME PC_LOG.MEGO... PC_LOG

FART_NO PC_LOG.PART... PC_LOG v
Sort Fields ™ Matural Order
Field Alias Field SOL Alias Table SGL Alias Desc(z> a]

MOD_DUE PC_LOG.MOD_.. PC_LOG

Cancel

12.9 Step 8 - Link all the Dataviews

Link each of the queries as shown here by dragging the CONTRACT _ID from the query into the
CONTRACT_ID in the CONTRACT query.

Your screen should look something like this
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RMS Report Designer [ de_rms.world ]: ConstEvents

File

Data |Cale | Design| Preview|

NT linked to CONTRA
& maE Q| & B
| e A | Name [ Type | s |

[& mEvQs 22 [l CONTRACT_I Stiing 25

EVENTDS  Sting 30
Nemd | Type | Size | ] - na

[ADATESCH  DeteTime
[BI FMT_CONTRALT Sting 22 [0l DATE_ACT  DateTime
[A]FROJ_NAME  Sting 40
[A] CONTRACT_ID Sting 25

L Eoe TEH &
Name | Type | Gie |

[f] PREF_SCHL  DateTime

[f] FREF_HELD  DateTime

[fl] FEATURE Sting 30

= () CONTRACT_I Stiing 25

[M| FREP_TIME  Sting 20

h 20 ETQ:s & ¥
Mame | Tvpe | Size | ~
Bl INIT_SCHL DateTime

LB INIT_HELD DateTime

L8] INIT_TIME Swing 20

CAIFEATUREID Sting &

=2 [0 CONTRACT_I Stiing 25

B @BDaTq s

Name Tope | Sies

& [alﬁﬁ?’“Q%i L 2NE

£ PC_ND Sting 7
[ PC_Ds Sting 40 Name: | Type | Size |
[ CONTRACT I Sting 25 [l SER_ID Sing 8

[ANSDUE  DateTime
[l ANS_DATE  DateTime
El[ﬂ] CONTRACT_| Sting 25

[l MOD_DUE  DaleTime
[fl TRAN_CODE  Sting 1

Ready.

12.10 Step 9 - Configure the queries to share autosearch values

This operation requires some voodoo code to get the search criteria from the EVENT query (the date
range) and to have it apply to all of the other dataviews.

This code does the job. It basically adds 2 search criteria to each of the dataviews using the values
from the autosearch entries on the event query.

var
| SQLBuUi | der: TdaSQLBui | der;
begi n
| SQLBui | der : = TdaSQLBui | der. Creat e( FEATURE_QA) ;
| SQ.Bui | der. SearchCriteria. Add(' feature _ga', 'prep_schl', '>=",
Report . Aut oSear chFi el ds[ 0] . Val ue) ;
| SQLBui | der. SearchCriteria. Add(' feature _ga', 'prep_schl', '<=",

Report . Aut oSear chFi el ds[ 1] . Val ue) ;
| SQLBui | der. Fr ee;

| SQLBui | der : = TdaSQLBui | der. Cr eat e( FEATURE_QA2) ;

| SQLBui | der. SearchCriteria. Add(' feature_ga', '"init_schl', '>=,
Report . Aut oSear chFi el ds[ 0] . Val ue) ;
| SQLBui | der. SearchCriteria. Add(' feature_ga', '"init_schl', '<=,

Report . Aut oSear chFi el ds[ 1] . Val ue) ;
| SQLBui | der. Free;

| SQLBui | der := TdaSQ.Buil der. Create(SER LOG ;
| SQLBui | der. SearchCriteria. Add(' ser _log', 'ans_due', '>=,
Report . Aut oSear chFi el ds[ 0] . Val ue) ;
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| SQLBui | der. SearchCriteria. Add(' ser_log', 'ans_due', '<=
Report . Aut oSear chFi el ds[ 1] . Val ue) ;
| SQLBui | der. Free;

| SQLBui | der : = TdaSQ.Buil der. Create(PC LOG ;

| SQLBui | der. SearchCriteria. Add(' pc_log', 'nod due', '>=
Report . Aut oSear chFi el ds[ 0] . Val ue) ;

| SQLBui | der. SearchCriteria. Add(' pc_log', 'nmod due', '<=
Report . Aut oSear chFi el ds[ 1] . Val ue) ;
| SQLBui | der. Fr ee;
end;

Switch over to the Calc tab in the deisgner and highlight the report object, then scroll down to the
BeforeOpenDataPipelines event and enter the above code.

RMS Report Designer [ de_rms.world ]: ConstEvents Q@@l

File Edit Wiew Help

Data  Calc | Desian| Preview|

Report Objects: Events
= [ Repott 4 | [ MtestutoS sarchDislogCreats ~
.- et Header [ AfterDpenD ataPipefines
A Labeld [ AfterFrint
| Lined [ BeforetutoSearchDislooCreste
Ba Systemvariable1 y
Image2
& Imege B BeforePiint
£m Shapet )
[ OntssignPreviewFormSettings
A biDateRange
[ OnéwteSearchbislogClose
=¥ Groups(l]
St Header [ OnCancel
S@ Shaped [ OnCanceDialogClose
DETexts [ OnCanceiDislogCreats
A DBTexiz0 [ OnEndColumn
i Foater [ OnEndFirstPass
= Dtail [ OnEndPage
SubReport1 [ OnEndsecandPass
M SubReportz |1 nRetdiinGearhaes —
procedure ReportBeforeOpenDataPipelines; Code Tonlbox: Language
var Sting ~
13QLBuilder: TdaSQLBuilder: Corversion
hegin Foimat
15QLBuilder := TdaSQLBEuilder.Create (FEATURE_QA); DateTims
13QLBuilder .SearchCriteria.Add (' feature ga', 'prep schl', '»=', Report.lutoSearchFields[0] .¥alue): Math
130LBuilder.SearchCriteria. Add (' feature ga', 'prep schl', '<=', Report.lutoSearchFields[1].Value): Uity
15QLBuilder . Free; User Selection Forms v
13QLBuilder := TdaSQLBuilder.Create{FEATURE_ Qaz): Conversion
13QLBuilder .SearchCriteria. Add (' feature ga', 'init_schl', '»=', Report.AutoSearchFields([0].Value): Name Definition
1S0LBuilder.Searchriteria. ddd (' feature_ga', 'init_schl', '<=', Report.liutoSesrchFields[1].Value): s Che function Chil¥alue: Integerk: Char
15QLBuilder.Free; s CunToSte | function CunToSt(alue: Currend

i DateTimeT oS! function DateTimeT oSu{aDateTi
13QLBuilder := TdaSQLEuilder.Create(SER_LOG):  hreen | 4
1S0LBuilder.Searchriteria.ddd('ser_log', 'ans_dus', '>=', Report.kutoSearchFields(0].Value): “ FloalToBr | funlion FloalToGialue: Extont
1SQLBui lder.SearchCriteria. Add('ser log', 'ans due', '<=', Report.iutoSearchFields([1].Value); - ~

- — i IntToSte function IntT o5tV alue: Integer]:
13QLBuilder .Free;

i AGB function RGB(zRed, aGres, 2B
150LBuilder := TdaSOLEuilder.Creats|PC LOG): # SuToCur | function SUT oCun(canst : Sting
1SQLBullder.Searchriteria. Add('pe_log , 'mod due', '>=', Report.AutoSearchFields[0].Value): GRS VX G fncion StrT oD ate{const S: Stin
13QLBuilder.Searchiriteria. ddd{'pe_log', 'mod due', '<=', Report.lutoSesrchFields[1].Value]; # StiToDateTimi function StTaD ateTime(const S
1S0LBuilder.Free; st SuToFloat | function SUT oFloallconst §: Stin

end: i SuTolnt funetion ST dlnijconst 5: String)

i SuTolnDef | function SuTelnDeficonst 5: Sti

: StTaTime | function StT aTime(const : Stin

it TimeToSt | function TimeToStrlaTime: Time]

Compile Completed: 0 Enors < >
Diats [Obiects jLanguage
Main P WENT, ponZ: FEATURE_GA port: FEATURE_GAZ portd: SER_LOG poits: PC_LOG
8 22

12.11 Step 10 - Add a subtitle to display the date range

Click on the design tab and add a label beneath the report title. Change its name to IbiIDateRange
using the ReportTree.

Switch to the Calc tab again and highlight the report object. Add an event for the BeforePrint and set

USACE



160

RMS Report Writing

12.12

the IbIDateRangeText using this code:

begi n

| bl Dat eRange. Text: = Dat eToStr ( Report. Aut oSear chFi el ds[ 0] . Val ue) + '

thru '
end;

+ Dat eToStr (Report. Aut oSear chFi el ds[ 1] . Val ue) ;

This will set the text to the date values that the user actually types in when the report runs. Note the
need to convert the date into a string type so that the strings can be concatenated together.

RMS Report Designer [ de_rms.world ]: ConstEvents

File Edit Wiew Help
Data  Calc | Design| Preview|
Fiport Objects Events
=+ Repott # | O sftersutos carchDialogCreate ~
= (=1 Header [ AfterDpenDataFipelines
A Labetd [ AfterPrint
| Linsd [ BeforedutoS earchDislogCreste
5 Spstematiat B BeforeOperDataPioslines
1ad Image2
£a Shepe1 BeforeFint
% bDaeRange [ On&ssignPreviewFormSettings
S F Groupsld] [ OnéwtoSearchDialogClose
5 i Header [ OnCancel
©m Shaped [ OnCanceDialogClose
DETextl3 [ OnCancelDialogCreate
A DBText2 [ OnEndCalumn
el Footer [ OnEndFirstPass
). Gt Dgtail [ OrEndPage
SubRepart] [ OnEndSecondPass
M SubRepon2 ¥ NnfietdtnG archivahies v
procedure ReportBeforePrint: Code Toolbox: Language
begin Stiing -
1blDateRange . Text:= DateToStr (Report.iutoSearchFields[0] .Walue) + ' thru ' + DateToStr {Report.lutoSearchFields[1] .Value) ———
end; Format
DateTime
Math
Uiy
User Selection Forms v
Conversion
Name Definitian
i Che funetion ChilValue: Integer): Chai
@ CunToSt | function CunTeSu(Value: Cunend
2 DateTimeToSi function DateTimeT oSt{aDateTi
i DateToSt functic Date: Date)
 FloatToStr | function FloalToStValue: Extent
i IntToStr funetion IntT oSt{Value: Integer):
it REB function REB{aRed. aGreen, 281
# SuToCur | function SuToCun{const $: Sting
i StToDate | function StT oD ate[const S: Stin
:i2 STaDateTim function ST aDateTime{canst 5
i SuToFloat | function SuT oFloatlconst §: Stin
i SuTalnt funetion SUT elneonst 5: Sting)
i StTalntDef | function StT alniDef{const S: Sti
i SuTaTime | function SUT oTimelconst : Stin
< 5 |3 TimeToSt | function TimeToSt{aTime: Time]
Compile Completed: 0 Enors < >
Dats [ Obiects yLanguage
Iilain P WENT portZ: FEATURE_GA, ports: FEATURE_GAZ pond; SEF_LOG pons: F_LOG
31

Step 12 - Add a Contract group

Switch to the design tab and select Report > Groups and add a group as shown here for the

CONTRACT_ID
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Groups EE

Group[0JCOMTRACT. COMTRACT _[D

Break On
{# [ata Field " Cugtam Field

On Group Change
[ Start new page

-

Mew page when less than D

[v K.eep group together

[w Reprint group headers on subzequent pages

k. | Cancel

Drag down the Group header to make room and format it as seen here with a background shape and
DBText objects for the contract number and title:
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EEX

RMS Report Designer [ de_rms.world ]: ConstEvents
File Edit ¥iew Report Help

Data | Cale  Desion | Preview|

h | AEEneE=i g AoEEane= BE2E

[ | [ =l S Bsu === |A-2-| &8 | W%
|28 m® %28 on Red Tow w2 WE DSH | WER | sB@

B NI TIOE N T e B [ ot S [

. USAmmy Corps. | | mm
ofEngineors:

" Group Header[DJ: CONTRACT_ID
" Detail
“ Group Footer[0]: CONTRACT_ID

~ Footer

|Left: 0 Top: 0 [width: 0 Height: O |

Ready.

12.13 Step 13 - Add 5 Subreports

Add five subreports and set the Datapipelines as shown here. To set the pipeline on each, click on the
subreport in the tab at the bottom of the designer and then select Report > Data
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12.14

RMS Report Designer [ de_rms.world ]: ConstEvents |;”EHX|
File Edit ¥iew Report Help

Data | Cale  Desion | Preview|

h | AEEneE=i g AoEEane= BE2E
[ | [ =l S Bsu === |A-2-| &8 | W%
B - |7E ma|eg | on Pea Ted | wm: WE |DSH OS8R | 4 02@

o [ e T P P B S B P B L B U B PR U P BN 'O

T MSAMY COrpS. | me
ofEngineors:

" Group Footer[0: CONTRACT_ID
]

“ Footer

Msin: CONTRACT #{SubFepont: PC_LOG /,SubRepard: SEF LOG A GubHepan: FEATURE_BAZ J GubFeportz: FEATURE A | GubFeportt EVENT /

Roady. |Left: 0 [Top: 0 [width: 0 Height: O |

Step 14 - Set the ShiftRelative to on all of the Subreports

If you done tell the subreports to shift relative to each other, then they will just print on top of each
other. Right click on subreport 2 and set its ShiftRelative to SubReport1.

Do the same for the remaining subreports in sequence so the shift relative to each other from top to
bottom.

USACE



164 RMS Report Writing

Bring bo Fronk
Send ko Back,

v Child
Fixed
Section

Drill Dowany

Excpand All

keepTogether

rewPrinkJob
W ParentPrinterSetup
v Parentitidth
Pasition. ..
ReprinkonicrerFlow
ResetPagefo
shiftRelativeTo. ..
Traverse all Data
Wisible

Shift Relative To

Set object pozition bazed an
SubReport]

(] I Cancel |

12.15 Step 15 - Design all 5 subreports

Design each of the subreports as you see fit - Don't worry about the details - Just make a header and
add the primary data. You can pretty them up later.

Events:

RMS Report Designer [ de_rms.world ]: ConstEvents \;H§HX|
File Edit View Report Help

Data | Cae  Desian | Preview|

h  AHEnESH| oo | APEEERE | d0RB

e =l = | B
&9 Tow | oz | WE |

e

“ Detail

sin: CONTRACT pont: PC_LOG portd: SEF_LOG pontd: FEATURE_BA2 pon?: FEATURE_ B}, SubPeportt EVENT / o

Ready, lLeft: 0 [Top: 0 [widkh: 0 Height: 0
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Preps:

RMS Report Designer [ de_rms.world ]: ConstEvents
File Edit View Report Help

Dats | Calc  Desian | Preview|

| ABEnE@i | G = |4 8E8 5%
\ [ =IF S eru = lA-2- | 9E | B

b.4.==0@ =@ &8 | swpta TFan w: WME | DSH DSR4 BB

[EN i ! s e 1 e O N e

T

* Summary

Hiain: CONTRACT  SubFeports: FC_LOG  SubReportd: SEF_LOG | SubFeport: FEATURE_GAZ J, SubReporta: FEATURE_GA j{SubReportt EVENT §

JLeft: 0 [Topi 0 [width: 0 Height: 0

Ready,

Initials:

RMS Report Designer [ de_rms.world ]: ConstEvents
File Edit View Report Help

Dats | Calc  Desian | Preview|
h ABnEEt|l oo ATEEERRE | E0BE

| A 1 E A | vE | wa
|ew/pea [ Tad w: wWE DSH DSR4 B8
N N O T N

d

|s

IMain: CONTRACT portd: FEATURE_G42 4 part2 FEATURE_GA portl EWENT -

Ready, JLeft: 0 [Topi 0 [width: 0 Height: 0

Correspondence:

RMS Report Designer [ de_rms.world ]: ConstEvents
Fle Edit View Report Help

Data | Cae  Desian | Preview|

h ABEheEwE| g AREpLRee | a0nE

| [t = x| Bru
[P2a Taow [ wi WE D=HE

| o

=iy

s 1 ls'i'

|
|

[r

il A s il

Hiain: CONTRACT  SubFeports: FC_LOG jy SubReport4: SER_LOG {SubReport: FEATURE_GAZ fSubReporta: FEATURE_GA J SubFeporth EVENT §

Ready, lLeft: 0 [Top: 0 [widkh: 0 Height: 0

Change Requests:
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RMS Report Designer [ de_rms.world ]: ConstEvents
File Edit View Report Help

Data | Cae  Desian | Preview|

h  AHEnESH| oo | APEEERE | d0RB

| [aa =1 Zlssru === A-7- | 0H | G%

|ow|p2ea  gon [ wi WE D@

7

MESR | hB®

RO e [P T A K A M A M

sin: CONTRACT pont: PC_LOG { portd: SEF_LOG pontd: FEATURE_BA2 pon2 FEATURE_GA portl EVENT

Ready, lLeft: 0 [Top: 0 [widkh: 0 Height: 0

12.16 Summary

This report had 5 subreports and some fancy RAP code to get to the autosearch options and share it
between queries. It also showed how to add a subtitle to show the range of data selected by the user.
You could easily modify this report to add other tables or remove some of these that you are not
interested in. Or, you could use a drill down option. See the Driller example for more info on that
option.
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13

13.1

13.2

Example 13 - Interactive Invoice Drilldown

Overview

Did you know reports can be clickable? This interesting example shows how you can turn a report into
an interactive tool that lets the user expand and contract sections at run time. This report will list the
invoices for a contract and let the user drill into the invoice and see CLIN payment details and further
down to see activity payment details.

US Army Corpe
of Englneers.

Invoice Drilldown

19-Aug-0T7

DACAO5-01-C0015

Air Traffic Control Tower

Invoice No: 1

Invoice No: 2

CLIN 0007
CLIN 0002

Invoice No: 3
CLIN 0001
LI 0002

Invoice No: 4
Invoice No: 5

Skills shown:

09/14/2001
02/08/2002

$0.00
$515,896.10

Adr Traffic Control Tower to the 2 Meter Line, Comple
Site Wark, Utilities and Infrastructure Outside the 2

Activity
Activity
Activity
Activity
Activity
Activity

SWWO1003
SwvWO1005
SWO1009
SO0
=WO1015
SwWO1019

02/19/2002

CLEAR AND GRUE SITE

SURVEY SITE

GRADE SITE

INSTAL SITE SEWER LINE
ELECTRICAL TRENCHING ONEITE
EMCASE COMMY ELECTRICAL LIME

$700,123.82

Air Traffic Control Tower to the 2 Meter Line, Comple
Site Work, Utilities and Infrastructure Outside the 2

Activity
Activity
Activity
Activity
Activity
Activity
Activity

- Interactive subreports
- Creating a customized view
- Multi-chained queries
- Custom Report Views
- Nested subreports

SWvWO1003
SWO1005
SwWO1009
=101
SWO1013
SwWO1015
SWO1017
02/28/2002
03/05/2002

CLEAR AND GRUB SITE

SURVEY SITE

GRADE SITE

INSTAL SITE SEWER LIME

INSTAL SITE WATER LINE

ELECTRICAL TRENCHING ONSITE

ELECTRICAL TREMCHING OFF SITE
$779.515.00
$779,515.00

$315,417.50
$200.478.60

1394 .501.12
$305 62270

Step 1 - Load the standard Portrait Template

{Click for CLIN Details)
(Click for CLIN Details)
[Click for Activity Details)
[Click for Activity Details)
$7.249.00

$5 84000

$51.704.00

$4d4 046.00

$65.000.00

$26 53960

{Click for CLIN Details)

[Click for Activity Details)
(Click for Activity Details)
57 24900

$5,840.00

$51,704.00

$44 045,00

$75.423.00

$E55 00000

$56.360.70

(Click for CLIN Details)
(Click for CLIN Details)

Load the standard portrait template with contract query and set the title as shown here.
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RMS Report Designer [ de_rms.world ]: InvoiceDriller

File Edit View Report Help

Data | Calc  Design | Preview |

h | ABEnEEk G ATERTD®E AMRE
[inveice Drildovr] | “Arial JaliE ~ |/ D
R B8 |or E&a Ted w2 | WE |D

[P PO e

 Header

~ Detail

Object: Labely

Left: 1.2917 Top: 0.3125 Width: 1.5 Height: 0,2125 Y

13.3 Step 2 - Create the Request Query

Create a new query, select the REQUEST table and select the following fields
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R Query Designer

Tables Fields ]Calcs ] Groupl Search] Sart ] sS0L ]

[A Available Fields

Field Alias | Field SOL &lias | Table SOL Alias ~

ALLOWED_EARNINGS_COMPLETE  REQUEST.ALL..  REQUEST

APPROVER_MAME REGQUEST.APP.. REGQUEST

APPROVER_TITLE REGQUEST.APP.. REGQUEST

Cay_LIME_ITEM_AMT REGQUEST.CAY... REQUEST

CEFMS_APPROVAL_STATUS REGQUEST.CEF... REGQUEST =

CEFMS_CHANGES REGQUEST.CEF... REGQUEST

CEFMS_COMPARE REGQUEST.CEF... REGQUEST

CEFMS_EARNINGS REGQUEST.CEF... REGQUEST

COMTRACT_SETTLEMENT_DATE REGQUEST.COM... REGQUEST

CURREMNT_DED REGQUEST.CUR.. REGQUEST

CURREMT_DEDUCTIONS REGQUEST.CUR.. REGQUEST

CURREMT_EARMINGS REGQUEST.CUR.. REGQUEST

CURRENT_LIG_DaMAGE REGQUEST.CUR.. REGQUEST

CURREMT_OTHER_REFUND REGQUEST.CUR.. REGQUEST

CURREMT_PAYMENT REGQUEST.CUR.. REGQUEST

CURREMT_PER_RETAINED REGQUEST.CUR.. REGQUEST

CURREMT_REFUNDS REGQUEST.CUR.. REGQUEST

CURREMT_RETAINED REGQUEST.CUR.. REGQUEST

CURREMT_RETAIN_REFUND REGQUEST.CUR.. REGQUEST

DISCOUMT_DAYS REGQUEST.DIS... REQUEST

DISCOUMT_PERCENT REGQUEST.DIS... REQUEST

DUEDATE REGQUEST.DUE.. REGQUEST v

Selected Fields [~ Al Fields

Field Alias Field SAL Alias Table SAL Alias

INV_NO REQUEST.INY_... REQUEST ﬂ

INWVOICE_DATE REQUEST.INY.. REQUEST

PaY_ALLOWED REQUEST.R&Y.. REQUEST

COMTRACT_ID REQUEST.COM... REQUEST ﬂ
Cancel

Set the sort to INV_NO as shown here

R Query Designer Q@@

Tables] Figlds ] Calcs ] Group] Gearch ot ]SQL ]
81 mvasilable Fields

Field Alias | Field 5OL &lias | Table SOL Alias | ~
DUEDATE REQUESTDUE.. REQUEST
DUE_TEXT REQUESTDUE.. REQUEST
EARMNINGS_VARIANCE REQUESTEAR.. REQUEST
ENGS3_ COMPLETE REQUESTENG.. REQUEST
ERRMSG REQUESTERA.. REQUEST
FAST_PAY_IND REQUESTFAS.. REQUEST
FINAL REQUESTFINAL  REQUEST
FLFROM REQUESTFLF.. REQUEST
IMPORT_DATE REQUESTIMP..  REQUEST 1
INVOICE_DATE REQUESTINV.. REQUEST

REQUESTINV_.. REQUEST
" REF| REQUESTINV_.. REQUEST
LAST_MOD_NO REQUESTLAS.. REQUEST
MALLOC_MEEDED REQUESTMAL.. REQUEST
MALLOC_PERF_Pay_BONDS_NI_TOT REQUESTMAL.. REQUEST
MALLOC_PERF_PaY_BONDS_NI_VAR REQUESTMAL. REQUEST

MALLOC_PREP_WORK_MI_TOT REQUEST.MAL.. REOQUEST

MALLOC_PREP_WORK_MI_VaR REQUEST.MAL.. REOQUEST

MALLOC_STORED_MI_TOT REQUEST.MAL.. REOQUEST

MALLOC_STORED_MI_WAR REQUEST Mal REQUEST

MaLLOC_SUB_DEDUCT_TOT REQUEST Mal REQUEST

MaLLOC_SUB_DEDUCT_WAR REQUEST Mal REQUEST -
Sort Fields [~ Matural Order
Field Aliaz Field SOL Alias Table SOL Alias Desc(z> a

IMV_NO REQUEST.IMY_.. REQUEST
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13.4 Step 3 - Create the CLIN query

For the CLIN query, we need to get the sum for the CLIN by adding up the activities linked to that
CLIN. This involves linking to the ACTIVITY_PAY_HISTORY_TABLE and ACTIVITY_DESC tables in
order to get the links we need. You could do this in the query designer, but lets use a view to make it
easier.

Switch to the data tab and select File > Create View
When the View Browser comes up, click on Add View. Here is the SQL for the view we want to create.

SELECT
B.CONTRACT _ID,
AH.INV_NO,
B.BID_NO,
B.BID_DS,
SUM(AH.ALLOW_AMT) V_AMT

FROM
BID B,
ACTIVITY_PAY_HISTORY AH,
ACTIVITY_DESC A

WHERE
A.CONTRACT_ID=B.CONTRACT_ID AND
A.BID_NO=B.BID_NO AND
AH.CONTRACT_ID=A.CONTRACT_ID AND
AH.ID=A.ID

GROUP BY
B.CONTRACT_ID,
AH.INV_NO,
B.BID_NO,
B.BID_DS
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Add / Edit View

Yiew Mame

Yiew Description

“iew to getthe pay history of a clin

SQL Editor

1 |SELECT

2 E.CONTRACT ID,

3 AH.INV NO,

1 E.BID NO,

= E.EID D&,

& SUM(AH. ALLOW_AMT) V_AMT
7 |FROM

= EID E,

2 ACTIVITY PAY HISTORY AH,
10 ACTIVITY DESC A

11 |WHERE

1z A.CONTRACT ID=E.CONTRACT ID AND
13 A.BID NC=E.EID NO AND

14 AH. CONTRACT ID=A.CONTRACT ID AND
13 AH.ID=A.ID

16 |GROUFP EY

17 E.CONTRACT ID,

18 AH.INV NO,

19 E.BID_ NO,
20 E.EID D3
21 -

Create Yiew

After you have created and saved your view, select File > New > Query Designer and then select your
new view RBVU_BID_PAY_HISTORY.

Add all of the fields to the selected list as shown here:
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R Query Designer

Tables Fields ]Calcs ] Groupl Search] Sart ] sS0L ]
[A Available Fields
Field Alias | Field SOL &as | Table SAL Alias |
Selected Fields Iv All Fields
Field Alias Field SOL Alias Table SGL Alias
BID_NO REVU_BID_P&..  RBYU_BID_PA..
CONTRACT_ID  REVWU_BID_PA..  REVU_BID_PA.. =
INV_NO REVU_BID_P4..  RBYU_BID_PA..
AT FEVU_BID_PA..  RBYU_BID_PA...
+
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R Query Designer

EBX

Tables Fields ]Calcs ] Groupl Search] Sart ] sS0L ]

[A Available Fields

Field Alias | Field SOL &as | Table SAL Alias |

Selected Fields

Field Alias Field SOL Alias Table SAL Alias

BID_DS REVU_BID_P&..  REVU_BID_Ph... *
BID_NO REVU_BID_P4..  REVU_EID_PA...

CONTRACT_ID  REMU_BID_PA..  REVU_BID_PA..

IMY_NO REVU_BID_P4..  REVU_EID_PA...

AT REVU_BID_P4..  REVU_EID_PA... L

Sort the dataview by INV_NO and BID_NO so it will come out on the report in CLIN order.
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R Query Designer

EEX

Tables] Fields ] Calcs ] Groupl Search Sort ]SQL ]

%l Available Fields

Field Alias | Field SOL &as | Table SAL Alias |

BID_DS REVU_BID_P&..  RBYU_BID_PA..

CONTRACT_ID  REVWU_BID_PA..  REVU_BID_PA..

Y_AMT REVU_BID_P4..  RBYU_BID_PA..
Sort Fields ™ Matural Order
Field Alias Field SOL Alias Table SGL Alias Desc(z> a]

INY_NO REVU_BID_P&..  RBYU_BID_PA..

BID_NO REVU_BID_P4..  RBYU_BID_PA.. =

|

13.5 Step 4 - Create the Activity Query

As with the BID query, it will be easier to get our activity history if we use a view.

Select File > Create View and create the following view for activity payment info

SELECT
AH.CONTRACT_ID,
AH.INV_NO,

AH.ID,
AH.ALLOW_AMT,
AD.BID_NO,
AD.DS

FROM
ACTIVITY_PAY_HISTORY AH,

ACTIVITY_DESC AD
WHERE

AD.CONTRACT_ID=AH.CONTRACT_ID AND
AD.ID=AH.ID
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Add / Edit View

Yiew Mame

Yiew Description

iew to link actvity pay to activity description

SQL Editor

=R
PR TV ' NS (- N NS 2% R R

1z

SELECT
AH. CONTRACT ID,
AH.INV HNO,
AH.ID,
AH.ALLOW AMT,
AD.EID NO,
AD.DS
FER.CM
ACTIVITY PAY HISTORY AH,
ACTIVITY DESC AD
WHERE
AD. CONTRACT ID=AH.CONTRACT ID AND
AD.ID=AH.ID

Create Yiew

Now, add a dataview that uses the new view. Set the fields as shown here:
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R Query Designer

Tables ]Calcs ] Groupl Search] Sart ] sS0L ]

[A Available Fields

Field Alias | Field SOL &as | Table SAL Alias |

Selected Fields Iv Al Fields
Field Alias Field SOL Alias Table SGL Alias

ALLOW_AMT REYU_ACTMIT... REVU_ACTMIT.. =
EID_NO REYU_ACTMIT... REVU_ACTMIT..

CONTRACT_ID REYU_ACTMIT... REVU_ACTMIT..

D5 REYU_ACTMIT... REVU_ACTMIT..

D REYU_ACTMIT... REVU_ACTMIT..

IMY_NO REYU_ACTMIT... REVU_ACTMIT.. »

And the sort as shown here
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R Query Designer

Tables] Fields ] Calcs ] Groupl Search Sort ]SQL ]
%l Available Fields

Field Alias | Field SOL &as | Table SAL Alias |
ALLOW_AMT REVU_ACTIMIT...  REVU_SCTIVT..
EID_ND REVU_ACTIMIT...  REVU_SCTIT..

CONTRACT_ID REYU_ACTMIT... REVU_ACTMIT..
REYU_ACTMIT... REVU_ACTMIT..
REYU_ACTMIT... REVU_ACTMIT..

Sort Fields ™ Matural Order
Field Alias Field SOL Alias Table SGL Alias Desc(z> a]
10} REVU_ACTIMIT...  REBVU_ACTIMIT...

7+ Link RBYU_ACTIVITY_PAY_HIST as Detail

Deetail - REVI_ACTIATY_Pay_HIST Master - |REVU_BID_Pay_HI |
ALLOW_AMT BID_NO

i CONTRACT ID

D

W_AMT

Linked Fields

COWNTRACT_ID - COWTRACT_ID
EID_MNO -: BID_MO
[MY_MO -» INY_MO

Clear

=)

1 Include only thoze records from REVI_BID_PaY_HISTORY for
':-vhich matching BEWVU_ACTIVITY_PaY_HIST records can be

£ Include all records from REVIL_BID_PAY_HISTORY. regardless of
wihether any matching REYU_ACTIVITY_PAY_HIST records can Cancel

Fj
[~

di
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13.6 Step 5- Link the queries
Now we need to link our four dataviews together in a chain like fashion. We want the REQUEST table
to be linked to CONTRACT and the CLIN table to be linked to the REQUEST table and finally, the
activity table to be linked to the CLIN table.

Set the links up as shown here:

Request to contract

> Link REQUEST as Detail

Detail - REQUEST Mazter - COMTRACT
[Hv_MO COWTRACT_ID
IMVOICE_DATE FMT_COMNTRACT_DELIVERY
Fay_alLLOWED PROJ_MAME

Linked Fields
COMTRACT_ID -» COMTRACT_ID

Clear

1 Include anly those records from CONTRACT far which matching
REGQUEST records can be found.

f+ g Include all records from COMTRALCT . regardless of whether any
matching REQUEST record: can be found. Cancel

di

Bid to Request
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Link RBYU_BID_PAY HISTORY as Detail

Linked Fields

Detail - REVU_BID_PAY_HISTORY Master-IFiEE!LlEST LI
BID_KNO MY _WO
W_AMT IMYOICE_DATE
P&y _ALLOWED

COMTRACT ID

[MNY_MO -» INY_MO
COWNTRACT_ID > CONTRACT_ID

Delete

Clear

REYU_BID_PaY_HISTORY records can be found.

% 2 Include all records from REQUEST, regardless of w
matching REVU_BID_PAY _HISTORY records can

" 1 Include only thoze records from REQIUEST far which matching

be found. Cancel

hether any |

Activity to Bid
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USACE

/= Link RBVU_ACTIVITY_PAY_HIST as Detail

Detail - REVU_ACT WM TY_PAY_HIST

ALLOW_&MT
0S
o

_ e |

Linked Fields

b azter -

- B

EID_MO
CONTRACT_ID
[MY_MO
V_aMT

CONTRACT_ID -» CONTRACT_ID
BID_NO - BID_ND
MY N - INVND

%)

Fj
-2

1 Include only thoze recards frarm REVI_BID_PAY _HISTORY far
which matching RBWVU_ACTIITY_PAY_HIST records can be

2 include all recards fram REYU_BID_PAY _HISTORY. reqardless of
whether any matching REWU_ACTPITY_PAY_HIST records can

Clear

Cancel

This is how the entire data scheme should look
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13.7

RMS Report Designer [ de_rms.world ]: InvoiceDriller

File

Data IEalc ]Das\gn] F‘lavlew}

EIB&

B Fme ¥4 8

[A) CONTRACT_ID Sting 25
[B) FMT_CONTRAC Sting 22
[ FROJ_NAME  Sting 40

oo

REQ nked to
L &0

LA INV_ND Double
[B) INVOICE_DATE DateTime
[ PAY_ALLOWED Dovble
[A) CONTRACT_| Stiing

25

[A] BID_NO

String

[ CONTRACT_| Sting 25

== 0 INV_ND

[HI _aMT

Double
Double

R EDETA L

Mame | Type | Size

[A] ALLOW_AMT  Double

= [ BID_ND Suing B
22 ] CONTRACT_I Suing 25

mos Sting 5
o Sting 10
2= INv_ND Double

Ready.

Step 6 - Add Contract Group

Now that the data is set, lets design the report.

First, add a group for the contract. Switch to the designer and select Report > Groups and add a

group as shown here:
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Groups g@

Groups | CONTRACT.CONTRACT_ID

Group[0JCOMTRACT. COMTRACT _[D

Inzert
Delete
Break On
{+ Data Field " Cuztom Field
On Group Change
[ Start new page
-

Mew page when less than D

[v K.eep group together

[w Reprint group headers on subzequent pages

k. Cancel

Drag the group header downward with your mouse to make room and format a group header as
shown here:
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RMS Report Designer [ de_rms.world ]: InvoiceDriller

File Edit View Report Help

Data | Calc  Design | Preview |

h | ABEnEEk G ATERTD®E AMRE
| [Aral =l

W E EaS Tad we: | WE

et |= ls 7

JErd-

| 0
b

US Army Corps
. of Engingers.. - -

 Header
” Group Heade[0} CONTRACT_ID

* Detail
* Group Footer 0} CONTRACT_ID

“ Footer

Left: 0 Top: O Width: 0 Height: 0 Y

Ready.

13.8 Step 7 - Add a SubReport

Now, we need to have a subreport for each section of our interactive report. One for the invoice data,
one for the CLIN data, and one for the activity data.

Add a subreport for the Invoice data
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13.9

RMS Report Designer [ de_rms.world ]: InvoiceDriller
File Edit View Report Help

Data | Calc  Design | Preview |

h | ABEnEEk G ATERTD®E AMRE

! | [[oa K| “|mz1o |====
88 (ow Esd Tes =i WE|(DSH USSR

[ R A A B S IO

US Army Corps
. ofEngingers. -

" Detail
" Gioup Footed(], CONTRACT_ID

“ Faoter

IMain: CONTRACT jSubReportl: Mo Data Fipeline Assigned

Object: SubRepart] JLeft: 0 Top: 0.0104 [width: 6 Height: 01973 /J

Step 8 - Design the Invoice subreport

Switch to the invoice subreport by clicking on the tab at the bottom of the designer.

The first thing to do on any subreport is to set the data pipeline. Select Report > Data and set this
subreport to use Request

Data X
[ ata Pipeline

REVL_ACTIMITY_Pax_HIST l_J
REVL_BID P&y HISTORY

]

Cancel |

Now, design the subreport. We don't need a title band or footer so turn off everything else except the
detail band (turn them off from the report pulldown menu).

Add DBText objects for the invoice Number, invoice date and amounts as shown.

Add a Label and change its color and make it underlined as shown so it looks like a clickable link and
change the text.

Click on this hyperlink label so it is selected and then select View > Toolbars > ReportTree
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With the hyperlink label selected, right click on it in the tree and change sits name to IbICLINDetail

Report Tree

Fepart Outline

= Mair: COMTRACT

-l SubReportl: REQUEST

= SubReport?: REYU_BID_PaY_HISTORY
SubReportd: REYU_ACTMITY_Pay_HIST

Dbject Dutline

=i Dretail
SubReport?
TA DEText3
CA DETextd
CA DETexts
A Label

£l Appearance
Border
Color
Transparent
Vizible
El Identity
IdzerM ame
B Layout
Height
Left
Top
"Width
B Layout - Dynamic
Anchors
AutoSize
Reprintdn0yverFlow
El Output - File
Save
Savelength
Savelrder
E Text
Angle
Caption
Charrap
Font

Froperties for IbICLIM D etail

[TppBarder)
[ chafhite
¥
¥

[BICLIMND etail
016670001
£.3333001
0.031 300001
1.5104001

[atLeft, atTop]

== A7

0

[Click for CLIMN Details]
r

[TppFont]

=l

Finally, add a subreport underneath the DBText objects - This will be the subreport for the CLIN

details
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RMS Report Designer [ de_rms.world ]: InvoiceDriller
Fils Edit Yisw Report Help

Dats | Cals  Desian | Preview |
i  AEEm@Ekl ao || AEEREReE | B0R E
IEE =l “|»zu | a2 - | $B %
5% | ow Pad [ Ten i | WE DSH wSR | 4 EB®
: IR SRR X

[ e B

* Detail

Main: CONTRACT ), SubReport: REQUEST {SubRepon: AU BI0_PAY_HISTORT {5ubRepartd: FEVL_ACTIVITY_FAY_HIST]

Ready. lLeft: 0 Top: 0 [width: 0 |Height: 0 /J

13.10 Setp 9 - Configure the Invocie Subreport for Drilldown

Making a subreport interactive is very easy. Just right click on the Invoice subreport and select
Drilldown so it is checked

"""" Bring to Fronk
Send to Back

v Child
Fixed
Section

v Dill Doy
Expand All
KeepTogether

v Parentiidch
Position. ..

ShiftR.elativeTa. .,
v Visible

When you make it DrillDown capable, it will ask you what control should act as the drilldown control.
For this report, select IbICLINDetail which is our hyperlink looking label
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13.12

Drill Down Component |E,

Select Orill Dovn Companient
|IbICLINDetail: [Click for CLIN Details) |

ok | Cancel |

13.11 Setp 10 - Design the CLIN subreport

Switch to the CLIN subreport and set the data pipeline to RBVU_BID_PAY_HISTORY.

Design the subreport as shown here including adding the hyperlink type label and the Activity
subreport.

Don't forget to set the subreport to DrillDown and link it to the hyperlink label

RMS Report Designer [ de_rms.world ]: InvoiceDriller

File Edit View Report Help

Dats | Cals  Desian | Preview |

i  AEEm@Ekl ao || AEEREReE | B0R E

| [ =l l[ezu | E - | G HE | B
= 5% | ow R2ad [ Ten i | WE  DSH ©

Ho ' S O T T S N R

Main: CONTRACT f SubReport: REGUEST ), SubRepont2: REYU_BI0_PAY_HISTORY {SubRepartd: REVL_ACTIVITY_FAY_HIST]

Ready. lLeft: 0 Top: 0 [width: 0 |Height: 0 /J

Setp 11 - Design the Activity subreport

Finally, design the activity subreport as shown here to complete the report.
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RMS Report Designer [ de_rms.world ]: InvoiceDriller

File Edit View Report Help

Dats | Cals  Desian | Preview |

i  AEEm@Ekl ao || AEEREReE | B0R E

I I s ==

-2 - | b @ T

e Ras [ Ton wE | WE| | DSH

3 [P

B @)

" Detail

Wain: CONTRACT f SubReport: REGUEST / SubRepon: REYUL BI0_PAY_HISTORT ) SubRepartd: REVL ACTIVITY_PAY_HIST/

Ready.

13.13 Summary

lLeft: 0 Top: 0 [width: 0 |Height: 0 /J

This interesting report shows how simple it is to make a report interactive by enabling drilldown on a
subreport. It also showed how to do nested subreports and how to chain together dataviews.
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14

14.1

14.2

Example 14 - Payment Obligation Crosstab

Overview

If you have numeric data that gets sliced in 2 dimensions and you want to see the details, you can use
a crosstab report component to build a report. This example shows a simple crosstab for the
payments on a contract and how each payment is split across obligation lines.

el

Ug Armny Corps
MEnglnoors,

Payment Obligation Crosstab 20-A0g-07

Sum of EARMINGES_US LIME_ITEM

INY_RO oot oooz 0003 0004 00os 0006 Grand Total
1 $&,700.00 F42,00000 [ $28,800.00 $7,200.00 F0.00 | $0.00 $a6,700.00
2 $2,175.00 $10,500.00 $7,200.00 $1,800.00 $41,250.00 | $0.00 $62,925.00
3 F0.00 2203200 F17E2560 F4,406 40 $391,070.00 | $0.00 $395,134.00
4 $0.00 $0.00 $0.00 $0.00 $456,215.00 | $0.00 Fas6,218.00
E] F0.00 F0.00 F0.00 F0.00 $203,652.00 | $0.00 F203 662.00
g $199,355.00 $0.00 $0.00 $0.00 $116,054.00 | $0.00 $315,439.00
7 $65,367.00 $30,150.00 | $163,32800| $40,332.00 $3,300.00 ( $0.00 $302,977.00
g $49,081.00 $1589,166.40 | $116,000.32 | $28,000.05 $10,450.00 | $0.00 $353,729.80
g $4 ,648.00 FE7975.25 | $31066464 | §77 6EE1G $0.00 | §0.00 $480,954 .05
10 F10,500.00 FI61,7E0.05 [ $167 57492 §41,89373 $0.00 | §0.00 381 ,737.70
11 $1.450.00 $196,856.00 | $54,81652) 15,704 63 $2,940.00 | $0.00 F229.771.15
12 $0.00 $181,143.00 $7,200.00 $1,800.00 $0.00 | $0.00 $190,143.00
13 $0.00 F99,065.00 [ $26,400.00 $0.00 F0.00 | $0.00 $125 486.00
14 $0.00 F$160,146.00 $0.00 $0.00 $0.00 | §0.00 F160,146.00
15 F0.00 F196,234.10 Fi4,800.00 F1,200.00 $0.00 | §0.00 20223410
16 $0.00 $130,347 6O $0.00 $0.00 F0.00 | $0.00 $130,347 6O
Grand Totsl $301 316.00 [ §1,467 40040 | $204 41200 | $218503.00 [ §1,184 86400 | $0.00 | $4,077 604 .40

Skills shown:

- Interactive subreports

- Creating a customized view
- Multi-chained queries

- Custom Report Views

- Nested subreports

Step 1 - Load the Landscape Template

Load the landscape template and set the title as shown here:
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14.3

RMS Report Designer [ de_rms.world ]: CrossTab

File Edit View Report Help

Data | Calc  Design | Preview |

h | ABEnEEk G ATERTD®E AMRE

I | “Arial EiE ERRE
Y w8 | oE BaS Tow | | lE |
B

u ==

o~

US Army Corps
. of Engingers.. - -

* Header
~ Detail

“ Footer

Left: 0 Top: O Width: 10,5 Height: 0,1979 Y

Ready.

Step 2 - Create the DataPipeline

Switch to the data tab, select File > New > Query Designer

Select the PAY_OBLI_HISTORY table and add the fields as shown here
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R Query Designer

Tables Fields ] Cales | Gioup | Search| son | soL |
LBl Available Fields
Field Alias | Field SOL s | Table SOL Alias | ~
APPROVAL_DATE Pay_0BLI_HIS... Pa&Y_OBLI_HIS..
CONTRACT_DELIVERY Fay_OBLI_HIS... PAY_OBLI_HIS..
COMTRACT_ID P& _OBLI_HIS..  PAY_DBLIHIS...
EARMINGS Fay_OBLI_HIS... PAY_OBLI_HIS..
EARMINGS_LESS_STORED Pav_OBELI_HIS.  PaY_0BLI_HIS..
EARNINGS_PAID Fay_0OBLI_HIS...  PAY_OBLI_HIS..
LIO_DAMAGE Pay_OBLI_HIS..  PaY_OBLI_HIS.
MALLOC_AVAILABLE Fay_0BLI_HIS...  PAY_OBLI_HIS..
MALLOC_EARMINGS PayY_OBLI_HIS...  PAY_OBLI_HIS..
MALLOC_PERF_PAY_BOM... Pay_OBLI_HIS.. PAY_0BLI_HIS..
MALLOC_PREP WORK_MI P&y _OBLI_HIS.  PaY_OBLLHIS..
MALLOC_STORED_NI Fay_0BLI_HIS...  PAY_OBLI_HIS..
MALLOC_SUB_DEDUCT Py _OBLLHIS.  P&Y_OBLLHIS.. —
OBLI_NO Fay_0BLI_HIS...  PAY_OBLI_HIS..
DBLI_P&Y_TERMS Py DELI_HIS..  PaY_OBLI_HIS...
OTHER Fay_0BLI_HIS...  PAY_OBLI_HIS..
Py _CALC Py DELI_HIS..  PaY_OBLI_HIS...
POSTING_DATE P&Y_OBLI_HIS..  P&Y_OBLI_HIS
PRE_EARMINGS Py DELI_HIS..  PaY_OBLI_HIS...
PRE_GROSS_OTHER PaY_OBLI_HIS..  P&Y_OBLI_HIS
PRE_GROSS_RETAINAGE P&y OBLIHIS.  PaY_OBLLHIS..
PRE_LD PaY_OBLI_HIS..  P&Y_OBLI_HIS 2
Selected Fields [~ Al Fields
Field Alias Field SOL Alias Table SOL Alias
INV_NO PaY_OBLI_HIS.. P&Y_OBLI_HIS
LINE_ITEM PaY_DBLI_HIS.. P&y OBLI_HIS... Y
EARNINGS_US PaY_OBLI_HIS.. P&Y_OBLI_HIS
|
Cancel

For now, set the report to work with just one contract by hard coding a contract id into the search field
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R Query Designer g@
Tables | Fields | Cales | Group  Search ]Son | saL |
G Awailable Fields

Field Alias | Field SOL Alias | Table SOL Alias ~
APPROVAL_DATE Paiy_DBLI_HIS..  PAY_OBLIHIS..
CONTRACT_DELIVERY Fair DBLI_HIS...  Pa&Y_OBLIHIS..
CONTRACT_ID Py DBLI_HIS...  PAY_OBLIHIS..
EARMINGS Fair DBLI_HIS...  Pa&Y_OBLIHIS..
EARMINGS_LESS_STORED  PAY_DBLI_HIS..  PAY_OBLIHIS..
EARNINGS_FAID Fair_DBLI_HIS..  P&Y_OBLLHIS..
EARMINGS_US Pty DBLI_HIS..  PAY_OBLIHIS..
INV_NO Faiv_DBLI_HIS..  P&Y_OBLLHIS..
LINE_ITEM Pty DBLI_HIS..  PAY_OBLIHIS..
LIG_DAMAGE Feir_OBLIHIS...  Pav_OBLLHIS..
MALLOC_ AVAILSELE Pty DBLI_HIS..  PAY_OBLIHIS..
MALLOC_EARMNINGS Faiv_DBLI_HIS..  P&Y_OBLLHIS.. —

MALLOC_PERF_PAY_BONDS.. Pay_OBLI_HIS.  PAY_OBLIHIS..
MALLOC_PREP_WORK_MI  PAY_OBLI_HIS.  PAY_OBLIHIS..

MALLOC_STORED_MI Pay_OBLI_HIS...  PAY_OBLI_HIS..

MALLOC_SUB_DEDUCT Fay_OBLI_HIS... PAY_OBLI_HIS..

OBLI_NO Pay_OBLI_HIS...  PAY_OBLI_HIS..

OBLI_Pay_TERMS Pay_OBLI_HIS Fay_OBLI_HIS

OTHER Pay_OBLI_HIS...  PAY_OBLI_HIS..

Pay_CaLC P&y _OBLI_HIS Py _OBLI_HIS

POSTING_DATE Pay_OBLI_HIS...  PAY_OBLI_HIS..

PRE_EARMINGS P&y _OBLI_HIS Py _OBLI_HIS A
Criteria

Field Operator Value AutoSearch | Mandatarp Show Al

Pay_OBLI_HIST.. = J3000256 J

Cancel

14.4 Step 3 - Add the crosstab component

Drag the header down a little to make room for a crosstab control and then drop a crosstab control
into the header band as shown here:

Shrink down the detail band as we will not have any details on this report.
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RMS Report Designer [ de_rms.world ]: CrossTab
File Edt View Report Help

Data | Calo  Desian | Preview|

| ABEmEE®| aox|AeaEmne®| | B0E
[Pa_oBLI_HISTORY | [aa ~|E offressTabonil] |

&8 | Wl | e ==

O e

I A B M

U Ariny Coips
of Enginears.

~ Footer

Left: O Top: 1.2187 ‘width: 10.5 Height: 0.197% Y

Objsct: CrossTabl

14.5 Step 4 - Configure the Crosstab Control

Click on the crosstab and make sure the datasource is set in the edit bar.

Right click on the crosstab and select configure.

Configure Crosstab |._||E||§|
% 1. Construct your crasstab by dragging fields from the figld list into the shaded celis
% - 2. Remove columns, rows or values by dragging from the diagram back. to the field list
L 3. Reorder columng, rows or values by dragging within the diagram
4. Format crosstab by selecting a row, column or valug and then wsing the toalbar or popup menu.
Fields Layout
EE=E |A-Z2-
= =

| Il o | 2L | Je =& = B zu

| new column
Ny Fow new value

Cancel |
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14.6

This is where you setup the rows, columns and values to display in the crosstab matrix.

Drag the INV_NO field from the left hand side and drop it onto the "new row" cell
Drag the LINE_ITEM field and drop it onto the "new column" cell

Drag the EARNINGS_US field onto the "new value" cell

Configure Crosstab

1. Congtruct your crosstab by dragging fields from the field list into the shaded cells
% A - 2. Remove columns, rows or values by dragging from the diagram back to the field list.

1 1 3. Reorder columns, rows or values by dragging within the diagram.

4. Format crosstab by selecting a row, column or value and then uzing the toolbar or popup menu.

CEX

Fields Layout
i EARMINGS_US [ =l [ial ~|[E =]
LIME_ITEM Grand Tatal
new column
Y O Sumn of EARMINGS_US
- new T 1000.00 1000.00
new valua
Grand Total 1000.00

o]

Cancel

That's all you have to do to configure the crosstab - the engine will take care of all of the horizontal

totals, vertical totals and grand totals for you.

Step 5 - Format the Crosstab Items

While in the crosstab configuration, you can control some of the display formatting. Here are a few

examples:

- Right click on the number in the cell and set the displayformat to a currency style:
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14.7

Configure Crosstab

% 1. Construct your crasstab by dragging fields from the figld list into the shaded celis
e - 9 .
& 2. Remove columns, rows or walues by dragaing from the diagram back to the field list.

3. Reorder columns, rows or values by dragging within the diagram.

4. Format crosstab by selecting a row, column or walug and then wsing the toalbar or popup menu.

Fieldz Layout

& EARNINGS_US 80 [l =l -l B I

LINE_ITEM Grand Tatal

=]
]
1]
Il
>
£

new column

Sum of EARNINGS_US

IO new row $1.000.00

newi value

Grand Total $1,000.00

oK | Cancel |

- If you didn't want grand totals for some reason, you can double click on the Grand Total label and
they will be removed - Double Click again and they come back.

- You cant change the labels, but you can change the fonts and colors
Step 6 - Pagination

Close the configuration screen and go back to the designer.

Right click on the crosstab and notice there are several options.

One important option is pagination. If your matrix is bigger than a page, then this will control how the
pages print. There are two options

Bring to Fronk
Send to Back

Configure. .. Page 1

v Draw

Paginakion 4 Across then Down

v Parentiidth w Daown then Across
Pasition, ..

ShiftRelativeTo...
¥ Stretch

Skvle 3
v Wisible

Across then down, or Down then across. These will control the behavior of the pages for big matrices.
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14.8 Summary

Its actually very easy to build crosstabs using Report Builder as this demo has shown.
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15

15.1

15.2

Example 15 - Office Workload by Fund Type (Piechart)

Overview

This report shows how to include a chart and how to link it to a datapipeline. For this example, we will
have a pie chart for each office and breakdown the sum of the contracts by Fund Type

=Y

US Armw Corps
of Englnoors.

Office Workload By Fund Type 20-8ug-07

W 11368 05 WiCA
B $1050,285 WA
[ $17271713 O

W ED 50,153 DTHA
T 70347 Nt

[ $12563 1420 MCAF
I 5.420,340 MAFR
B 54567240 OWAF

] 0

I B11 791598 FHA

[ #5,862,691 DOCh

B 574eT54 OMD

B $12.192 727 OV
30 O

[ $11.129 589 ONDF
B 31051591 NAFA

= 30 OWe|
[ §5.247,430 FCCRH
[ 92,485,176 SOSLG
] 53467734 S00TH

Skills shown:

- Using a chart

- Linking a chart to data in a pipeline
- Simple Subreport

- Simple Join

Step 1 - Load the Landscape Template

Load the standard Landscape template and change the title as shown here:
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15.3

RMS Report Designer [ de_rms.world ]: OfficeCustomerWorkload

File Edit View Report Help

Data | Calc  Design | Preview |

h | ABEnEEk G ATERTD®E AMRE

[Bffics Workload by Fund Tpe =iz S |Bru |==E== |A-2- | & @ 'El'!i|

&8 | Tl | o2 | ol E
; T e

DEeE wueRk tm@

(O e 8

[N

OO

“ Faoter

Object: Labely

Left: 1.2917 Top: 0.3125 Width: 2.6125 Height: 0,2125 Y

Step 2 - Create the Office Query
Switch to the data tab and select File > New > Query Designer

Select the offices table and select the following fields
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15.4

R Query Designer

B Available Fields

Tables Fields ]Calcs | Group | Search| ot | saL |

9((=]E

Field Alias [

| Table SOL Ales |

Field SGL Alias »
ADDRESST OFFICES.ADDR...  OFFICES
ADDRESS2 OFFICES.ADDR... OFFICES
ADDRESS3 OFFICES.ADDR...  OFFICES
BATCH_CEFMS... OFFICES.BATC.. OFFICES
BATCH_CEFMS... OFFICES.BATC.. OFFICES
BATCH_CEFMS... OFFICES.BATC.. OFFICES
BATCH_CEFMS... OFFICES.BATC.. OFFICES
BATCH_PZ_AFT.. OFFICES.BATC.. OFFICES
BATCH_P2_DATE OFFICES.BATC.. OFFICES
BATCH_Pz_Da&Y  OFFICES.BATC.. OFFICES
BATCH_P2_M0... OFFICES.BATC.. OFFICES
CEFMS_ORG_C.. OFFICES.CEFM.. OFFICES
DAYLIGHTSAYL.. OFFICES.DAYLL.. OFFICES
Fi OFFICES.Féx OFFICES
FL_CODE OFFICES.FL_C..  OFFICES —
MOD_PREFI= OFFICES.MOD_... OFFICES
OFFICE_FLAGS ~ OFFICES.OFFIC.. OFFICES
OFFICE_MaAMAG... OFFICES.OFFIC. OFFICES
OFFICE_SEGQLE.. OFFICES.OFFIC.. OFFICES
F2_DOWHLOA, OFFICES.F2_D OFFICES
PARENTSYMBOL OFFICES.PARE.. OFFICES
FHOME OFFICES.PHOME ~ OFFICES v
Selected Fields [~ Al Fields
Field Alias Field SOL Alias Table SOL Alias
FLHAME OFFICES.FLMA. OFFICES
FLSYMBOL OFFICES FLSY..  OFFICES ﬂ
DISPLAY_SYMBEOL OFFICES.DISPL OFFICES

|

Set the sort to OFFICE_SEQUENCE

Step 3 - Create the Contract Query

Cancel

For the contract query, we want to sum up the current contract amount by office and program type.

Select File > New > Query Designer

Select the contract table from the list

We also want to get the description of the fund type so, next select the FUNDTYPE table and do an

inner join.
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R Query Designer

- o)X
Tables IFieIds | Cales | Gioup | Search| son | soL |
Available Tables
Table | TableMame | Al
ACCIDEMT ACCIDEMT =
ACTMWITY_DESC  ACTMWITY_DESC =
ACTIMITY_Pay_HISACTWITY_PAY_HIL
ACTIVITY_CA ACTIWITY_QA
ACTIWITY_SCHEDUACTMITY_SCHEDL
AGEMCY AGEMCY
AGEMT AGEMT
AHA_HAZARD AHA_HAZARD
AHA_STEP AHA_STEP
ANT_WEATHER  ANT_WEATHER
APPYU_COMTRACIAPPYU_COMTRALC
APPYU_CONTRACIAPPYU_CONTRALC
APPYU_COMTRACIAPPYU_COMTRALC
BASELINE_LIBRAR BASELINE_LIERAR
BASELINE_OFFICE BASELINE_OFFICE
BID EID
BID_CHAMGE BID_CHANGE
BID_CHANGE_OBLIBID_CHANGE_OBL
BID_OBLI BID_OEBLI
CALEMDAR CALEMDAR
CATEGORIES CATEGORIES
CATEGORY CATEGORY |
Selected T ables | Distinct
Table | Table Name | SOL Alias | Jain Type
CONTRACT COMTRACT COMTRACT
FUNDTYPE FUNDTYPE FUNDTYPE Inner

Select the following fields

Cancel
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R Query Designer |-;||E|E‘
Tables ]Calcs ] Gloup] Search] Sart ] sOL ]

[A Awvailable Fields

Field Alias | Field SOL Alias | Table SOL Alias |

| >

ACO_AGENT_C.. CONTRACT.AC.. CONTRACT
ACTIATY_WARL. CONTRACTAC.. CONTRACT
ACT_PER COMTRACT.AC..  COMTRACT
ACT_PER_LESS.. CONTRACTAC.. CONTRACT
ACT_PLCMT COMTRACT.AC..  CONTRACT
ACT_TOT COWNTRACT.AC..  COMTRACT
AE_ADDRESST  CONTRACT.AE..  CONTRALCT
AE_ADDRESSZ  CONTRACT.AE.. CONTRACT
AE_ADDRESSZ  CONTRACT.AE..  CONTRALCT
AE_EVAL_ACT COWNTRACT.AE..  COMTRACT
AE_EVAL_RO COMTRACT.AE...  CONTRACT
AE_EVAL_SCH COWNTRACT.AE..  COMTRACT

AE_TITLE COMTRACT.AE..  CONTRACT
ALT_REF COWNTRACT.AL..  COMTRACT
ALT_REPZ COMTRACT.AL..  CONTRACT
ALT_REP3 COWNTRACT.AL..  COMTRACT

AwaR0_AE_DE  CONTRACT.A..  CONTRALCT
AwARD_ALLOC. . COMTRACT.A COMTRACT
AwAR0_APPR.. CONTRACT.A..  CONTRALCT
AWARD_AUTH.. CONTRACT.A COMTRACT
AwaRD_BID_O.. CONTRACT.A..  CONTRALCT
AWARD_BID_T.. CONTRACT.A COMTRACT

hd
Selected Fields [~ Al Fields
Field Alias Field SOL Alias Table SOL Alias
OFFICE_SYMBOL COMTRALCT.OF COMTRACT
FUND_TYPE CONTRACT.FU... COMTRALCT .
FUND_&BBREY  FUWNDTYPE.FU FUNDTYPFE
+|

Cancel

And add a calc to sum up the current contract amounts
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R Query Designer |-;||'E|E‘
Tables | Fields  Cales ] Group | Search| ot | saL |

@ Available Fields

Field Alias | Field SOL Alias | Table SOL Alias | ~

ACO_AGENT_C.. COMTRACT.AC.. COMTRACT

ACTITY WARL.. COMTRACT.AC.. CONTRACT 1
ACT_PER COMTRACT.AC..  COMTRACT

ACT_PER_LESS.. COMTRACT.AC.. CONTRACT

ACT_PLEMT COMTRACT.AC.. COMTRACT

ACT_TOT CONTRACT.AC..  COMTRALCT

AE_ADDRESS1  COMTRACT.AE.. COMTRACT

AE_ADDRESS2  COWTRACT.AE.. CONTRACT

AE_ADDRESS3  COMTRACT.AE.. COMTRACT

AE_EVAL_ACT COMTRACT.AE.. COMTRALCT

AE_EVAL_RO COMTRACT.AE.. COMTRALCT

AE_EWAL_SCH  COWTRACT.AE.. CONMTRACT

AE_TITLE CONTRACT.AE.. COMTRALCT

ALT_REP COMTRACT.AL..  COMTRALCT

ALT_REPZ CONTRACT.AL.. COMTRALCT

ALT_REF3 COMTRACT.AL..  COMTRALCT

AwitRD_AE_DE  COMTRACT.A.  CONTRACT

AwARD_ALLOC. . COMTRACT.A COMTRACT

AwitRD_APPR.. COMTRACT.A.  CONTRACT

AWARD_ALUTH COMTRALCT A COMTRACT

AwitRD_BID_0.. COMTRACT.A.  CONTRACT

AWARD_BID_T.. CONTRACT.A COMTRACT v
Calculations

Field Alias Field SOL Alias Table SOL Alias Function Expression

CURREMT_COMNTRACT SUM[CONTRACT CURRENT_COMTRACT) SUM CONTRACT Sumn

Y
|
Cancel

And finally, group as follows:
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R Query Designer |';||'E|E‘
Tables | Fields | Cales  Group | Search| Son | saL |
% Awailable Fields
Field Alias | Field SOL Alias | Table SOL Alias | ~
ACO_AGENMT_C.. COMTRACTAC.. COMTRACT
ACTMATY_VARL.. CONTRACTAC.. CONTRACT 0
ACT_PER COMTRACT.AC..  COMTRACT
ACT_PER_LESS.. CONTRACTAC.. COMTRACT
ACT_PLCMT COMTRACT AC..  COMTRACT
ACT_TOT COMTRACT AC..  COMTRACT
AE_ADDRESST  COMTRACTAE.. COMTRACT
AE_ADDRESS2  CONTRACTAE.. CONTRACT
AE_ADDRESSZ  COMTRACTAE.. COMTRACT
AE_EWAL_ACT  CONTRACTAE.. CONTRACT
AE_EMAL RO COMTRACTAE.. COMTRACT
AE_EWAL_SCH  CONTRACTAE.. CONTRACT
AE_TITLE COMTRACT AE... COMTRACT
ALT_REP CONTRACTAL..  COMTRACT
ALT_REP2 COMTRACTAL..  COMTRACT
ALT_REP3 CONTRACTAL..  COMTRACT
AwbRD_AE_DE  COMTRACT.A.  CONTRACT
AwARD_ALLOC. . COMTRACTA . CONTRACT
AwtRD_APPR.. COMTRACTA.  COMTRACT
HWARD_AUTH .. COMTRACTA . CONTRACT
AwtRD_BID_0.. COMTRACTA.  COMTRACT
HWARD_BID T COMTRACTA . CONTRACT 2
Group Fields
Field Alias Field SAL Alias Table SOL Alias
OFFICE_SYMEOL CONTRACT.OF.  COMTRACT
FUND_T'YPE CONTRACT.FU...  COMTRACT e
FUND_&BBREY  FUNDTYPEFU.  FUMDTYFE
=]
Cancel

15.5 Step 4 - Link the Contract Query

Set the linkage as shown here by dragging the office symbol from the contract query to the
FLSYMBOL of the offices query
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0 covtRacT linkedtooFFIces |
QR B20&ETQ 3 R 0@ Q:s #|
Mame | Type | Siee Hame | Type | Siee |
[F] FLMAME Sting 30 = [f OFFICE_SYMBOL Sting 15
[[] FLSYMBOL  Suing 15 L LAl FUND_TYPE Sting 2
[B) DISPLAY_SYME Sting 18 [ FUND_ABBREY Sting 5§
[l CURRENT_CONTRACT Double

15.6 Step 5 - Design the main report
Add DBText objects for the office symbol and the name as shown

Also, add a subreport for the actual chart - Put the subreport into the detail band:
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RMS Report Designer [ de_rms.world ]: OfficeCustomerWorkload
File Edit View Report Help
Data | Calc  Design | Preview |
h | ABEnEEk G ATERTD®E AMRE
I | [#a ~[© ~l|szu |
»-5-== 8 B8 |or Esd Taew o |  WE D@
o SIERLES] A SN NN LA NN L LN A
af UE Ay Corps. -
o o ofEngineers. .
T Header
0 BubRepart T CONTRACT & T T T D T
~ Detail
0
“ Faoter
Ready. JLeft: 0 [Top: 0 [width: 0 Height: 0 /J
15.7 Step 6 - Design the subreport and chart

Open the subreport (click on tab at bottom of designer) and condense down all of the sections except
the title.

Set the datapipeline to the contract query.
Stretch out the Title band and Add a DBChart to the title band.

Right click on the dbChart and select Edit Chart
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RMS Report Designer [ de_rms.world ]: OfficeCustomerWorkload
File Edit View Report Help

Data | Calc  Design | Preview |

h | ABEneai aeos | ARERa0e® 0B EH

T | | Al =] Slpsru s=== |A-2- | 30| OB
; | ® 88 | o E2a Taa wf | WE DH USSR | LBR@

"" ' ' R R B ' '

PO

| T e e e " e
o o o
[ Chart
-y M)
2
B o [} o
=
s
%
“ Title
~ Detail
“ Summary
L]
)\ Man OFFiCES (SRR e e e e e e e e
Object: DPTeeChartl lLeft: 2.1979  [Top: 0.9271 {Width: 3.6458  Height: 2,0833 /J

Click add series and select Piechart
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% | Editing ppDPTeeChartControll
l Series] Data ] E:-cpu:urt] Print ]
Sefies lEeneraI] Az ] Titles ] Legend] Panel ] F'aging] Walls ] ah ]

Help...

Cloze

Then click on Series on the top set of tabs
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% | Editing ppDPTeeChartControll

Chart  Sefies lData ] E:-cpu:urt] Print ]

Sernes] - 'ﬁ Pie: Sernesl
Formnat l Eircled] General] Marks] [rata Su:uuru:e]

Opticns l Group Slices] Colors ]

Explode biggest: |0 ﬂ [w Auto Mark Position

Total angle: [360 j W Dark 30

. ="
Diark Border: [0 — [ Pattemsz
Multiple Pies: Autamatic -

Shadamw... | 30 Gradient... | Border.. —

Help... Cloze

Click on the data subtab and set the datasource as shown here
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15.8

% | Editing ppDPTeeChartControll
Chart  Sefies lData ] E:-cpu:urt] Print ]

S CLIERENT COMTHACT

Sernes] - 'ﬁ Pie: Sernesl
Fu:urmat] Eircled] General] Marks [Data Source l
Drata Pipeline -
Data Fipeline COMTRACT - Apply
Labels: [FUMD_&BBREY ﬂ

[ DateTime

Help...

Cloze

Step 7 - Format the Chart

You can size and format the chart as needed. Here are a few examples:

- Under Panel you can select gradient, check the visible box and then pick an available gradient
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Editing ppDPTeeChartControll

Chant lSeries] Data ] E:-cpu:urt] Prirt ]

Series] General] iz ] Titlez ] Legend Fanel lF‘aging] Wwiallz ] 3D ]
Backgrnund] Borders  Gradient l Shaduw]

[v “izible Direction: Top Baotbam -
Default l Colars ] Dptinns]

Ace P

Caribe Sun
Clear day
Dezert
Farm
Funky
Golf

Hat
Might
Fasztel

R ainbiow
Sea
Seal
Space
Sunzet
Tropical

Help... Cloze

Under Series, General, you can control the display of the values and add commas or dollar signs as
you like:
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15.9

% | Editing ppDPTeeChartControll

Chart i Data ] E:-cpu:urt] Print ]
Sernes] - 'ﬁ Pie: Senies]
Fu:urmat] Circled General l M arks ] Data Su:uuru:e]
General:
[v Show n Legend
LCurzor: Default -
Depth: II:I—:I [w Auto
Farmats:

Walues: #.H#H#0 #i#H - .

Percents: |HHO# 3 Sort: Mone
[ £ DateTime

Help...

Cloze

Summary

This example showed how to build a simple pie chart for offices and how to format and stylize the

chart.
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16

16.1

Example 16 - Project Data Sheet with Image

Overview

This report shows how you might put together a full page data sheet for a contract. Its based on a
format from AED. We won't fill in every detail, but we will make it complete enough to serve as an
excellent example for constructing your own data sheet. As you can see, one of the highlights is that it
includes a photo which has been requested frequently by RMS users. This example will show how to
get the photo out of the database and display it in a report.

Honolulu Engineer District Project Data Sheet (PDS)
CIV-O&M Program

Report Date: 08/21/2007

PROJECT

Title: Ror Four Flood Cortl Prai, Isle of HI
Location: |zland of Havwaii, State of Hawwaii
Project Humber:

Fiscal Year 2002

Customer: CIVIL

PM: Stuart Fermahin

CONTRACT

Contract Humber: DACYWES-02-C-0004
Contractor: Sunetior Gunite

Type:  Firm Fixed Price

Ko

Contract Speciallist:

AreaResident Office Fort Shafter Area Office
(A Method:

FUNDING

Funids Source:

Program Amount: T0.00
Current Weorking Estimate: $5,030,337.00
Award Contract: F3.766.121.00
Current Contract Amount: $4.770107.00
Pending Mod Amount: $0.00
Expended/Accrued to Date:

Available Contingency: $260.230.00

SAFETY

Contractor man-hours worked:
Date of last lost work day accident:

SCHEDULE

RFP Issued:
Award Date: 92372002

HTP Date: 101772002

Contract Duration: 602

Contract Original Completion Date: 571452003
Contract Current Completion Date: 511002004
Estimate«d Completion Date: 4/30/2004

Days Ahead or Behind Schedule:

% Complete Scheduled:

% Complete Actual:

Beneficial Occupancy Date: 541172004

MNOTES:
= Dates in bold yndariine are actuaf dates; a5 otitars are planned
- liformation in red font indicates an update

SCOPE

Project invalves the repair of four (43 flood control projects on the |sland of Hawaii: AMenaio, Wiailoa and Wiaiakea Uka Flood Control Projects in the Hila
area; and the Pa'auau Flood Control Project in Pahala. Repair work includes debris remowal and rehabilitation and reconstruction of earthen lewees,
boulder concrete slape lining, concrete-lined channels thath invert and side slope), concrete rubble masonry floadwalls, and shotocrete-lined side walls.

STATUS

ISSUES - CUSTOMER

QA Rep: Steve Takeguchi (43812740 - Project phy=ical complete.
1. Pa'auau Site: Final Inspection held on 24 Jun 03,

2. Alenaio Site: Final Inspection held on 14 Ot O3,

3. Waiakea Uka Site: Final Inspection held on 10 Feb 04

4. Wailoa Site: Final Inspection held on 10 Jun 04,

Skills shown:
- Full page report
- Including an image in a report
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- Joining many tables

- Using multiple regions
- Stretching regions

- Shift relative

- Getting the District Name for a Report Header

16.2 Step 1 - Create the Contract Query

We need to get data from several tables for this report. They all need to reference back to the

contract. We will not be loading a template for this report, so just switch to the data tab and select File
> New > Query Designer

Select the following tables as shown here and join them as indicated. Note that they are all Left Outer
joins so that we will still get a contract record if one of the other tables is missing a matching row.

Select the contract table:

Next, select the CR_ATTACH table - It is the table that stores attachments. We want our progress

photo attachment so we will join the CR_ATTACH table by contract_id - Later we will limit it to just the
progress photo

Join Table
Jain Type Jain CR_ATTACH Table with
| Left Outer | CONTRACT
CR_ATTACH Field=s COMTRACT Fieldz
ATTACHMENT ~ ACO_AGEMT_CODE -
ATTACH_DATE ACTRTY WARIAMCE
COMTRACT_ID ACT_PER
CR_ATTACH_ID ACT_PER_LESS_STORED
DOC_TYPE ACT_PLCMT
FILE_ID ACT_TOT
FILE_Ma&kE AE_ADDRESST
REMARES AE_ADDRESSZ
TITLE b’ AE ADDRESS3 b/
Joined Fieldz
CR_ATTACH Field Operator COMTRACT Field
CR_ATTACH.COMTRACT _ID = COMTRACT.COMTRACT _ID

k. | Cancel

We need the contractor name, so next, select the KTR_DESC table and join it by contract_id also:
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Join Table Ed
Join Type Jein KTR_DESC T able with

|LeftEIuter ﬂ ] 52

KTR_DESC Fields CONTRACT Fields

ADDRESS] 3 ACO_AGENT_CODE 3
ADDRESS2 S ACTIITY _VARIANCE =
ADDRESS3 E ACT_PER

ADDRESS_CITY ACT_PER_LESS_STORED
ADDRESS_COUNTRY ACT_PLCAT

ADDRESS_STATE aCTTOT

ADDRESS STREET AE_ADDRESST
ADDRESS_ZIP_CODE AE_ADDRESS2

CCASS CONTRACTOR EMAL ¥ AE ADDRESS3 *

Jaoined Fields

ETR_DESC Field
KTR_DESC.CONTRACT_ID

Operator

CONTRACT Field
COMTRACT.COMTRACT_ID

OF. | Cancel |

Next select the CONTRACT_METHOD table so we can get a description of the contract method

Join Table

Join Type

| Left Outer ﬂ

CONTRACT_METHOD Fields

COWNT_METHOD
METHOD_TITLE
SHOw_RECORD

Joined Fields

[
[ s

%]

Join CONTRACT_METHOD T able with

COMTRACT Fields

ACO_AGENT_CODE
ACTRATY VARIANCE
ACT_PER
ACT_PER_LESS_STORED
ACT_PLCMT

ACT_TOT

AE_ADDRESST
AE_ADDRESS2

8] 3

AF ADDRESS3

[E4

CONTRACT_METHOD Field
COWTRACT_METHOD.COMT_METH...

Operator

COMTRACT Field
CONTRACT.COMT_METHOD

k. | Cancel
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Next up is the offices table - join it as shown here:

Join Table X

Jain Type Join OFFICES Table with

| Left Quter j ] 5

OFFICES Fields COMTRALCT Fields

ADDRESST - ACO_AGEMT_CODE A

ADDRESS2 3 ACTMITY WaRIANCE =

ADDRESS3 = ACT_PER

BATCH_CEFMS_AFTER ACT_PER_LESS_STORED

BATCH_CEFMS_DATE ACT_PLCMT

BATCH_CEFMS_DaAy ACT_TOT

BATCH_CEFMS_MOMTH AE_ADDRESST

BATCH_P2_AFTER AE_ADDRESS2

BATCH P2 DATE ¥ AE ADDRESS3 b
Joined Fields

OFFICES Field

Operator COMTRACT Field

OFFICES.FLSYMEOL = COMTRACT.OFFICE_S+MBOL

s | Cancel

We want the PM so join the PROJECT_DELIVERY_TEAM table as shown
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Join Tahle

Join Type

| Left Outer ﬂ

FROJECT_DELMERY_TEAM Fields

CONTRACT_ID
EMP_ID_NO
QavERSION
TITLE

Jaoined Fields

[ e
[

Join PROJECT_DELMERY_TEAM Table

COMTRACT Fields

AC0_AGEMT_CODE
ACTMITY _VARIAMCE
ACT_PER
&CT_PER_LESS_STORED
ACT_PLCMT

ACT_TOT

AE_ADDRESET
AFE_ADDRESSZ

&F ADDRESS3

8] 3

[

FROJECT_DELIERY_TEAM Field
PROJECT_DELMWERY_TEAM.CONTH...

Operator

CONTRACT Field
COMTRACT.COMTRACT_ID

o]

Cancel |

And, finally to get the full name of the PM instead of just the ID, join the staff table as shown here:

Join Table
Join Type Jair STAFF T able with
| Left Outer ﬂ
STAFF Fields FROJECT_DELMWERY_TE&AM Fields
CEFMS_EMP_ID_MNO FY COMTRACT_ID
DEFAULT_ROLE = EMP_ID_MO
[ln]s] — LAVERSION
EMAIL TITLE
EMPLOYEE
EMP_ID_MO
ExTH
FIRST_MakE
FLMARE b’
Joined Fields
STAFF Field Operator FROJECT _DELMERY _TEdAM Field

STAFF.EMP_ID_NOD

FROJECT_DELMWERY _TEAM.EMP..

Cancel
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The tables and joins should now look like this:

R Query Designer

E_Tablesj] Fields ] Calos ] Groupl Search] Sort ] SaL ]
Available Tables

Table Table Name

ACCIDENT ACCIDENT

ACTMATY_DESC  ACTIMTY_DESC
ACTRATY_PAY_HISACTIVITY_PAY_HIL

ACTIMTY_QA ACTIVITY_GQA
ACTRATY_SCHEDUACTIMTY_SCHEDL

AGENCY AGENCY
AGENT AGENT
AHA_HAZARD AHA_HAZARD
AHa&_STEP AHA_STEP

ANT_WEATHER  ANT_WEATHER
APPYU_CONTRACTAPPYU_CONTRAC
APPYU_CONTRACTAPPYU_CONTRAC
APPYU_CONTRACTAPPYU_CONTRAC
BASELINE_LIBRAR BASELINE_LIBRAR
BASELINE_OFFICE BASELINE_OFFICE
BID BID

BID_CHANGE BID_CHAMGE
BID_CHANGE_OBLIBID_CHAMGE_DBL

BID_OBLI BID_OBLI
CALENDAR CALENDAR
CATEGORIES CATEGORIES
CATEGORY CATEGORY

CEFMS_ACCRUAL CEFMS_ACCRUAL

CEFMS_INY_LINE_ICEFMS_INY_LINE_

CEFMS_INY_LINE_ICEFMS_INY_LINE_

CEFMS_INVOICE  CEFMS_INVOICE

CEFMS_INVOICE_E CEFMS_INVOICE_E

CEFMS_ORG CEFMS_ORG v

Selected Tables

I~ Distinct

Table Table Hame SOL Alias Join Type:
CONTRACT CONTRACT CONTRACT

CR_ATTACH CR_ATTACH CR_ATTACH Left Outer
KTR_DESC KTR_DESC KTR_DESC Left Duter
COMTRACT_ME... CONTRACT_M.. CONTRACT_M..  Left Outer
OFFICES OFFICES OFFICES Left Duter
PROJECT_DELI.. PROJECT_DELL.. PROJECT_DELL.. Left Outer
STAFF STAFF STAFF Left Outer

Cancel

Select the following fields
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R Query Designer

Tahbles Fields lEaIcs ] Group ] arch] Sort
[l Available Fields

|saL |

Field Aliag

| Field S0L Alias | Table SOL Alias |

ACO_AGEMNT_CODE
ACTIMITY_VARIANCE

COMTRACT.AC.. CONTRACT
CONTRACT.AC..  COMNTRACT

AT DCOD COMTOATT AT COKMTOATT

Selected Fields [~ &l Fields
Field Alias Field SOL Alias Table SOL Alias
PROJ_MAME COMTRACT.PR.. COMNTRACT
LOCATION CONTRACT.LO.. CONTRACT
Fr COMNTRACT FY CONTRACT
CUST_TYPE COMTRACT.CU... COMNTRACT
FMT_CONTRACT_DELIMVERY CONTRACT.FM... CONTRACT
OFFICE_SYMBEOL COMTRACT.OF.. COMTRACT
AwD_ACT COMTRACT.A..  COMTRACT
MNTP_ACT COMTRACT.NT.. CONTRACT
MTP_SCH CONTRACT.NT... CONMTRALCT
CURRENT_DURATION COWTRACT.CU... COMNTRACT
ORIGINAL_COMPLETION COMTRACT.OR... COMNTRACT
CURREMT_COMPLETION CONTRACT.CU... CONTRACT
CONST_COMP_SCH COWMTRACT.CO.. COMNTRACT
BOD_ACT COMTRACT.BO.. COMTRACT
BOD_SCH COMTRACT.BO.. CONTRACT
FROGRA&M_TYFE CONTRACT.PR... CONTRACT
PROJ_DS COMTRACT.PR.. COMTRACT
ISSUES_USACE COMTRACT.ISS.. COMNTRACT
ISSUES_CUSTOMER CONTRACT.ISS.. CONTRALCT
ATTACHMENT CR_ATTACHA..  CR_ATTACH
FULL_MAME KTR_DESC.FU.. KTR_DESC
REM&RKS CONTRACT.RE... CONTRALCT
METHOD_TITLE CONTRACT_M... CONTRALCT_M..
FLMAME OFFICES.FLMA...  OFFICES
W_PM STAFFFULL_M.. STAFF
CURREMT_COMTRACT CONTRACT.CU... CONTRACT
CURRENT_CONTINGEMCY COWTRACT.CU... COMNTRACT
CURRENT_CWE COMTRACT.CU... COMNTRACT
PROG_aMT CONTRACT.PR... CONTRACT
AwaRD_COMTRACT COMTRACT.A..  COMTRACT
MODE_AMT COMTRACT.MO... COMTRACT

And set these search conditions:

]

Cancel
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R Query Designer

Tables] Fields ] Calcs ] Group Search ]Sort ] SoL ]
Q& Available Fisids
Field Alias | Field SOL #ias | Table SOL Alias | -

ACO_AGENT_C.. COMTRACTAC. CONTRACT
ACTIMITY_WARIL.. COMNTRACT.AC. CONTRACT

ACT_PER COMTRACT.AC..  COMTRACT
ACT_PER_LESS.. COMTRACT.AC. CONTRACT
ACT_PLCMT COMTRACT.AC..  COMTRALCT
ACT_TOT COMTRACT.AC..  COMTRALCT

AF_ADDRESST  COMTRACT.AE.. COMTRACT
AF_ADDRESSZ  CONMTRACT.AE. COMTRACT
AF_ADDRESSE CONMTRACT.AE. COMTRACT
AF_FVal ACT COMTRACT.AE CONTRACT
AF_FVal RO COMTRACT.AE CONTRACT
AE_EVAL SCH COMTRACT.AE..  CONTRACT

AE_TITLE COMTRACT.AE..  CONTRACT
ALT_REP COMTRACT.AL..  CONTRALCT
ALT_REPZ COMTRACT.AL..  CONTRALCT
ALT_REP3 COMTRACT.AL..  CONTRALCT

AwBRD_AE_DE  CONTRACT.A..  CONTRACT
AwBRD_ALLOC.. CONTRACT.A..  CONTRACT
AwBRD_APFR..  CONTRACT.A..  CONTRACT
AwBRD_ALTH.. CONTRACTA..  CONTRACT
Aw/BRD_BID_O.. CONTRACT.A..  CONTRACT
Aw/BRD_BID_T.. CONTRACT.A..  COMTRACT
AwARD_BID_YV.. CONTRACT.A..  COMTRACT
AwBRD_CONTL.. CONTRACT.A..  CONTRACT
AwBRD_CONTL.. CONTRACT.A..  CONTRACT
AwARD_COMT.. COMTRACT.A..  CONTRACT
AwARD_COMT.. COMTRACT.A..  CONTRACT
AwsRD_CWE COMTRACT.A..  COMTRACT
AwBRD_EXCH.. COMTRACT.A..  CONTRACT
AwSRD_FUNDL.. COMTRACT.A..  CONTRACT
AwSRD_FUNDL.. COMTRACT.A..  CONTRACT
swsRD_FUNDL.. COMTRACT.A..  COMTRACT

A tADM O COKMTOACT A COMTDATT e’
Criteria

Field Operatar Walue AutoSearch | Mandatory Shaw All

CONTRACT.CONTRACT_ID = J3000256

CR_ATTACH.DOC_TYPE = J

KTR_DESC.P_S = P ﬂ
PROJECT_DELIERY_TEAM.TITLE[+] = Project Manager ﬂ

Cancel

The contract_id is just so we can work with a single contract while we are designing (pick a
contract_id of your own choosing)

The CR_ATTACH.DOC_TYPE of J is the indication of a progress photo (jpeg)

The KTR_DESC.P_S of type P is so we get the name of the Prime contractor

And, the TITLE of Project Manager is self explanatory. Notice, however, that you need to add the
outer join condition (+) to the TITLE fields here or you will filter out any contracts that do not have a

PM assigned.

You could sort the data in any way you choose, but we will just work on one contract.
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16.3 Step 2 - Create the Office Query

We want the district name in big bold letters at the top of the report so we need to go get it from the
office table.

Close your contract query and save it. Then, select File > New > Query Designer

R Query Designer E]@@

Tables ]F\e\ds | Cales | Group | Search| Sont | saL |
Aailable Tables

Table Table Name ~
ACCIDENT ACCIDENT

ACTMTY_DESC  ACTMTY_DESC

ACTMTY_PAY_HISACTITY_PAY_HIE

ACTMTY_0A ACTIMITY_QA

ACTMTY_SCHEDUACTIVITY_SCHEDL

AGENCY AGENCY
AGENT AGENT
AHA_HAZARD AHA_HAZARD
AHS_STER AHA_STER

ANT_WEATHER  ANT_WEATHER
APPYU_CONTRACIAPPVU_CONTRAC
APPYU_CONTRACIAPPVU_CONTRAC
APPYU_CONTRACIAPPVU_CONTRAC
BASELINE_LIBRAR BASELINE_LIERAR
BASELINE_OFFICE BASELINE_OFFICE
BID BID

BID_CHANGE  BID_CHANGE
BID_CHANGE_OBLIBID_CHANGE_0BL

BID_OBLI BID_OBLI
CALEMDAR CALEMDAR
CATEGORIES CATEGORIES
CATEGORY CATEGORY

CEFMS_ACCRUAL CEFMS_ACCRUAL
CEFMS_INY_LINE_ICEFMS_INV_LINE_
CEFMS_INY_LINE_ICEFMS_INV_LINE_
CEFMS_INVOICE  CEFMS_INVOICE
CEFMS_INVOICE_E CEFMS_INVOICE_E
CEFMS_ORG CEFMS_ORG

CEFMS_TREE  CEFMS_TREE

CHECKS CHECKS

CHECKS_M CHECKS_M

CHG_REO_DOC  CHG_REG_DOC 3
FAMETEAT FAMETEAT

Selected Tables [~ Distinct
Table Table Mame SOL Alias Join Tupe:

OFFICES OFFICES OFFICES

Cancel

Select the office fullname.
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R Query Designer

Tables Fields ]Calcs ] Groupl Search] Sart ] SoL ]
[ Availatle Fields

Field Alias | Field SOL #ias | Table SOL Alias | -
ADDRESS1 OFFICES.ADDR... OFFICES
ADDRESS2 OFFICES.ADDR... OFFICES
ADDRESS3 OFFICES.ADDR... OFFICES

EATCH_CEFMS.. OFFICES BATC.. OFFICES
EATCH_CEFMS.. OFFICES BATC.. OFFICES
EATCH_CEFMS.. OFFICES BATC.. OFFICES
EATCH_CEFMS.. OFFICES.BATC.. OFFICES
BATCH_PZ2_&FT... OFFICES.BATC.. OFFICES
EATCH_PZ2_DATE OFFICES.BATC.. OFFICES
BATCH_PZ2 DAY OFFICES BATL. OFFICES
BATCH_P2 MO.. OFFICES.BATL. OFFICES
CEFMS_ORG_C.. OFFICES.CEFM.. OFFICES
DAYLIGHTSAY].. OFFICES.DAYLL... OFFICES
DISPLAY_SYMB... OFFICES.DISFL.. OFFICES

Faix OFFICES. Fax OFFICES
FLSYMBOL OFFICES.FLSY.. OFFICES
FL_CODE OFFICES.FL_C.. OFFICES

MOD_PREFI= OFFICES.MOD_... OFFICES
OFFICE_FLAGS  OFFICES.OFFIC.. OFFICES
OFFICE_MANAG... OFFICES.OFFIC.. OFFICES
OFFICE_SEQUE... OFFICES.OFFIC.. OFFICES
Pz_DOWwWMLOA..  OFFICESPZ_D..  OFFICES
FPARENTSYMBOL OFFICES.PARE.. OFFICES
FPHONE OFFICES.PHOME ~ OFFICES
QALOCKDAYS OFFICES.GALO..  DFFICES
OaLOCKPOLICY  OFFICES.QALO..  OFFICES
GAVERSION OFFICES.GAVE..  DFFICES
G4 _COMMENT_.. OFFICES.QA_C.. OFFICES
ROUTE_ACD OFFICES.ROUT... OFFICES
ROUTE_CO OFFICES.ROUT... OFFICES
ROUTE_WOTE_... OFFICES.ROUT.. OFFICES
ROUTE_WOTE_... OFFICES.ROUT.. OFFICES

TIkdC ZMKIC MCCIECC TIkdC MCCIrCC b
Selected Fields [ AllFields
Field Alias Field SOL Alias Table SGL Alias
FLMAME OFFICES.FLMA..  OFFICES
|
|

Cancel

Finally, set the search to just the district office by checking the type_value.
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R Query Designer

Tables] Fields ] Calcs ] Group Search ]Sort ] SoL ]
Q& Available Fisids
Field Alias | Field SOL #ias | Table SOL Alias | -

BATCH_CEFMS...
BATCH_CEFMS...
BATCH_CEFMS...
BATCH_CEFMS ..
BATCH_P2 AFT..
BATCH_P2 DATE
BATCH_P2 DAY

OFFICE_MANAG...
OFFICE_SEQUE...

ADDRESET OFFICES.ADDR... OFFICES
ADDRESE2 OFFICES.ADDR... OFFICES
ADDRESEZ OFFICES.ADDR... OFFICES

OFFICES.BATC.. OFFICES
OFFICES.BATC.. OFFICES
OFFICES.BATC.. OFFICES
OFFICES.BATC.. OFFICES
OFFICES.BATC.. OFFICES
OFFICES.BATC.. OFFICES
OFFICES. BATL. OFFICES

BATCH_P2 MO.. OFFICES.BATL. OFFICES
CEFMS_ORG_C.. OFFICES.CEFM.. OFFICES
DAYLIGHTSAY].. OFFICES.DAYLL... OFFICES
DISPLAY_SYMB... OFFICES.DISFL.. OFFICES
Faix OFFICES. Fax OFFICES
FLMAME OFFICES.FLMA...  OFFICES
FLSYMBOL OFFICES.FLSY.. OFFICES
FL_CODE OFFICES.FL_C.. OFFICES
MOD_PREFI= OFFICES.MOD_... OFFICES
OFFICE_FLAGS  OFFICES.OFFIC.. OFFICES

OFFICES.OFFIC..  OFFICES
OFFICES.OFFIC..  OFFICES

P2_DOWwWMLOA..  OFFICES.P2_D..  OFFICES

FPARENTSYMBOL OFFICES.PARE.. OFFICES

FPHONE OFFICES.PHOME ~ OFFICES

QALOCKDAYS OFFICES.QALD..  OFFICES

OaLOCKPOLICY  OFFICES.QALO..  OFFICES

GAVERSION OFFICES.Q&VE..  OFFICES

04 _COMMENT_.. OFFICES.QA_C.. OFFICES

ROUTE_ACD OFFICES.ROUT... OFFICES

ROUTE_CO OFFICES.ROUT... OFFICES

ROUTE_WOTE_... OFFICES.ROUT.. OFFICES 2

oniTE WMNTC MACCICC ohlT MCCIrcc

Criteria

Field Operatar Yalue AutaSearch | Mandatary Show Al

OFFICES. TYPE_WaALUE = DISTRICT
|
|

Cancel

You should now have 2 dataviews as shown here - Note - they are not linked and that is the way we

want it.
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16.4

RMS Report Designer [ de_rms.world ]: StatusSheetWithimage

File
Data IEalc ]Das\gn] F‘lavlew}
[& mevQa| & &F
Mame | Type | Siee | A
[R) PROJ_NAME Sting 40
[R) LOCATION Sting B0
Ry Sting 4
LR CUST_TYPE Sting 8
[AIFMT_CONTRACT_DELMWERY  Sting 22
LA OFFICE_SYMBOL Sting 15
[A) AWD_ACT DateTims
LAl NTP_ACT DateTims - A
[AINTP_SCH DateTims & mEva _Zl
LA CURREMT_DURATION Doutle
7 DRIGINAL_COMPLETION DateTime [ FLNAME Swing 30
[RI CURRENT_COMPLETION DateTime
[RI COWST_COMP_SCH DateTime
[R] BOD_ACT DateTime
[RI BOD_SCH DateTime
[RI PROGRAM_TYPE Shing 8
[RI PROJ_DS Sting 2000
IRl 155UES_USACE BELOB
[RI1S5UES_CUSTOMER: BLOE
LRI ATTACHMENT BLOE
[R) FULL_MAME Sting B0
[R) REMARKS Sting T4
[ METHOD_TITLE Sting 40
[R) FLNAME Sting 30
LR v_FM Sting 30
LR CURREMT_CONTRACT Double
LR CURRENT_CONTINGENCY Double =
LR CURREMT_CWE Double
[R) PROG_AMT Double =
Ready.

Step 3 - Design the Report

Here is what the final design should look like in the designer. There are a lot of steps involved, but
they are all basic. The only new thing is the Image. Design your report to look just like the one shown

here. Here are a few highlighted steps:
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RMS Report Designer [ de_rms.world ]: StatusSheetWithimage
File Edit Yiew Report Help

Data | Cale  Design |Prewew|

h ABuBE{| ao= | ATEBLRS® EORE

| |[oe =Ip ZlBsru |==E- A-¢- VH | U%
B-d-m= 0w | mw ns a8 | Tod | | WE DSH | DSR | 1 RE
O R R e e Ee e S

[ATTACHMENT]

” Detail

- Get rid of everything except the header and detail section - we don't need a footer, summary or title.

- Use regions to control the flow of the report. In the design as shown, there are two regions dividing
the detail band in half for the upper data and then a new region for each of the lower sections.

- The DBImage (ATTACHMENT) is easy to setup, just grab the DBImage control and drop it into the
region and size it. Set it to use the CONTRACT pipeline and the ATTACHMENT field. Also, right click
on it and set the graphic type to JPEG.

- The small header blocks like PROJECT, CONTRACT, FUNDING are just regular labels with a blue
background. You can set the background by using the View > Toolbars > Report Data Tree and
setting the Color under Appearance to skyBlue.

- The Variable 1 and Variable 2 at the top of the page each have the following code set for them. You
access the code editor by right clicking on the variable and selecting calculations from the menu
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16.5

Variable 1:

R Calculations (=] [zl
Code Toolbox: Data

Value := OFFICES['FLMNAME'] + ' Project Data Sheet (PDS)': OFFICES
CONTRACT

\D ata #0bjects 4Language /
Cancel

Variable 2

R Calculations |Z||E|E|
Code Toolbox: Data

Valus := CONTRACT['PROGRAN TYFE'] + ' Frogram': OFFICES
CONTRACT

\Data #0hjects 4Language /
Cancel

Make sure to set the Stretch and ShiftRelative To on the Lower regions and the memos so that they
will stretch correctly

Summary

This rapid fire example showed how you can make up your own data sheet and how you can include
an image. You can easily select whatever fields you want to include and modify it for the needs of your
office.
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17 Example 17 - Contractor Evaluation Grades

17.1 Overview

This advanced report uses lots of RAP code including user defined functions and global variables. The
report finds all of the contracts for a given contractor by using the DUNS number. It summarizes and
averages the ratings from all of the evals for the given contractor.

Contractor Evaluation Grades

UE Army Coape

24-fug-07

of Eng haers:

Contractor: MNIKING CORPORATION
Duns Number: 007154818

Overall Ratings
01- UMEATISFACTORY
1 - MARGINAL
2- SATISFACTORY

3- ABOVE AVERAGE

4 - OUTSTANDIMNG

Number of Contracts
0 Contract(s)
1 Cantract(s)
3 Contract(s)

4 Contract(s)

2 Contract(s)

Contractor Evaluation

Overall Rating

Cality Control
Management
Timely Performance
Labor Standards
Safety Standards

Skills shown:

- Advanced RAP

- User defined functions
- Global variables

10 Contract(s)

Average Ratings

2.7

27
3.1
248
28
3.0
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17.2

17.3

Step 1 - Load the Portrait Template

Load the Standard Portrait Template and change the Title of the Report

RMS Report Designer. [ de_rms.world ]: Contractor, Evaluation Grades

File Edit View Report Help

Data | Cale  Design |F’review|
h  AdEzeEtel a0 AEER 0% B0 @
IContlactDrEvaIuatiDn Grades “IAriaI ;”13 LI | ’? Iru

== Bg =@ |88  Sn BaS  med | o

|
§' | Inl]l

N A R R

et P Tt

T | '

© | UE Army Coaps.
of Englhears.

* Detail

* Faoter

Ohject: Labels Left: 12917 Top: 03125 ‘width: 2,565 Height: 0,215 |

Step 2 - Create a View of DUNS numbers

Switch to the data tab and select File > Create View
MNew, ..
Close..,

Import...
Merge. ..
Export...

Import From File...
Export Ta File...

Launch ISQL

Creake View
Save Feport With Yiew Ta File
Load Report With Yiew From File

On the View Edit dialog, enter the SQL statement as shown.

select
DISTINCT(DUNS4) DUNS
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from form2626
where DUNS4 is not null

Add / Edit View

Yiew Mame
|HBUU_DI5TINET_KTH_DUNS4

Yiew Description

“iew for selecting a unigue contractor DUNS number,

SQL Editor

1 |zeleczt

2 DISTINCT (DUNS4) DUNS
3 |from formZEZé

4 |where DUNZ34 is not null

Cancel Create Yiew

17.4 Step 3 - Create the DUNS Query

Select File > New > Query Designer and then select the RBVU_DISTINCT_KTR_DUNSA4 table

USACE



234 RMS Report Writing

K Query Designer, |Z| |E| El

Tahhs] HEHS] Cdc&] Gmup] Semch] Sart ] SOL l
twvailable Tables
Table Table Mame -
ACCIDENT ACCIDEMT =
ACTMTY_DESC  ACTRATY_DESC
ACTMITY_PAY_HISACTIITY_PayY_HIS
ACTMTY QA ACTIMITY_QA
ACTMITY _SCHEDUACTIITY_SCHEDL
AGEMCY AGEMCY
AGENT AGEMT
AHA_HAZARD AHS_HAZARD
AHA STEP AHS_STEP
AMT_WEATHER  ANT_WEATHER
APPVU_CONTRACTAPPYU_COMTRALC
APPVU_CONTRACTAPPYU_COMTRALC
APPVU_CONTRACTAPPYU_COMTRALC
BASELIME_LIBRAR BASELIME_LIERAR
BASELIME_OFFICE BASELIME_OFFICE
BID BID
BID_CHAMGE BID_CHAMGE
BID_CHAMGE_OELIEID_CHAMGE_OBL “
Selected T ables [ Distinct
Table Table Mame SOL Aliaz Join Type
REYU_DISTIMCT_KTR_DUMNS4 REYU_DISTIMC... RBWU_DISTIMC...
Ok | Cancel

Select the DUNS field
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R Query Designer : Elgl
Tables Fields lCab&] Gmup] Semch] Sart ] SOL l

[A] Awvailable Fields

Figld Alias | Field SOL Alias | Table SOL Alias |

Selected Fields [v Al Fields

Field Aliaz Field SOL Aliaz Table SOL Aliaz

DUMS REVU_DISTINCT_KTR_DUMS4.DU...  REVU_DISTINCT_KTR_DUNS4

Ok | Cancel |

For testing/design purposes, set the DUNS to get only the single DUNS as shown here on the search
tab.
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K Query Designer, |;||E|E|
Tahhsl HEHS] Cdc&] Group Search lSoﬂ ]SQL l

(3 Awvailable Fields

Figld Alias | Field SOL Alias | Table SOL Alias |

DUNS REVU_DISTIMC... REVU_DISTIMC...

Critenia

Field Dperator W alue AutoSearch | Mandatom Show All
REWVU_DISTIMCT_KTR_DUMS4.DUNS = 007154818 e e

Ok | Cancel |

17.5 Step 4 - Create the Eval Query

Select File > New > Query Designer and then select the FORM2626 table. This is the table that has
the Evaluation data.
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K Query Designer,

Available T ables

Tables ] Fields | Cales | Group | Search| Sont | 0L |

B[=/Ey

Table
ACCIDENT
ACTMITY_DESC

ACTIITY_GQa&
ACTITY_SCHEDULE
AGEMCY

AGEMT

dHA_HAZARD
&HA_STER
ANT_WEATHER
APFYU_COMTRACT
&PPYU_COMTRACT_1
&PFYU_CONTRACT_2
BASELIME_LIBR&RY
BASELIME_OFFICE
BID

BID_CHAMGE
BID_CHAMGE_OBLI

Selected T ables

ACTIATY_Pay_HISTORY

Table Mame
ACCIDEMT
ACTMITY_DESC
ACTIVITY_Pas_HIE
ACTMITY_QA
ACTMITY_SCHEDL
AGEMCY
AGENT
AHA_HAZARD
AHA_STEP
ANT_WEATHER
APPYU_COMTRAL
APPYU_COMTRAL
APPYU_COMTRAL
BASELIME_LIBRAR
BASELIME_QFFICE
BID
BID_CHAMGE
BID_CHAMGE_QEL

12

W

[ Distinct

Table
FORMZ2E26

T able Mame SOL Aliaz
FORMZE26 FORMZ626

Jain Tupe

o |

Cancel

Select the following fields
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K Query Designer,

Tables Fields lCaIc& ] Gmup] Search] Sart ] SOL l

[A] Awvailable Fields

Field Alias | Field SOL Alias

| Table SOL Alias

| -
ACCEPTAMCE_ ... FORM2626ACC.. FORMZG26
ACO_PROGRA... FORMZE26.AC..  FORMZEZE
ADDED_DATE FORM2E26.40... FORM2E26
ADH_SCHD FORM2E26.40... FORM2E26
A0_SFPLAMN FORM2E26.40_... FORM2E26
A0_SITE FORM2E26.40_... FORM2E26
AOR_IMIT_DATE FORM2626.40... FORMZE26
AQ_FIMNAL_DATE FORM2626.40_.. FORMZE26
A0 RATE DATE FORM2626.A40 ... FORMZ2E26 v
Selected Fields [ Al Fields
Field Alias Field SOL Aliaz Table SOL Alias
DUMS4 FORMZEZE.DU...  FORMZEZE
COMPAMY_MAME FORMZEZE.CO... FORMZEZE
COMTRACT_ID FORMZEZE.CO... FORMZEZE
E'ié WO FORMZEZE.EVA... FORMZEZE
COMTRACT_SERIAL_MUMBER FORMZEZE.CO... FORMZEZE
COMTRACT_ACTIMITY FORMZEZE.CO... FORMZEZE ﬂ
COMTRACT_ORDER_MUMBER FORMZEZE.CO... FORMZEZE
AwtRD_VALLE FORMZEZE AW . FORMZEZE
EVaALATOR_MaAME FORMZEZE EVA. . FORMZEZE
EVaLATOR_ORGAMIZATION FORMZEZE EVA. . FORMZEZE
OVERALL_RATING FORMZEZE.0Y. . FORMZEZE
AwARD_DATE FORMZEZE AW . FORMZEZE ﬂ
COMPLETION_DATE FORMZEZECO..  FORMZEZE

Ok | Cancel

We need to get the location, so switch to the calc tab and add a calculated field using this expression

(SELECT CONTRACT.LOCATION FROM CONTRACT CONTRACT WHERE
CONTRACT.CONTRACT_ID = FORM2626.CONTRACT_ID)

USACE



Example 17 - Contractor Evaluation Grades

R Query Designer

239

Tahbsl Fields: Caleos lGrDup] Semchl Sort ] SOL

@ Available Fields

Field Alias | Field SOL Aliss | Table SOL Alias | A

ACCEPTAMCE_... FORMZ2B26.ACC.. FORMZB2E

ACH_PROGRA. .. FORMZ2B26.AC..  FORMZE2E

ADDED_DATE FORMZ2E26.4D...  FORMZB2E

ADH_SCHD FORMZ2E26.4D...  FORMZB2E

AD_SFPLAMN FORMZ2E26.40_... FORMZB2E

AD_SITE FORMZ2E26.40_... FORMZB2E

AOR_IMIT_DATE  FORMZ2B26.40...  FORMZE2E

AQ_FINAL _DATE  FORMZ2B26.40_... FORMZE2E

AQ_RATE_DATE FORMZ2B26.40_... FORMZE2E

ASBUILTS_aDE... FORMZ2B26.45B.. FORMZE2E

awsR0_DATE FORMZE2E6.2%/ .. FORMZE2E

awtRD_VallJE  FORM2B26.4%.. FORMZE2E

&_CLC_PLAM FORMZ2E26.4_C... FORMZE2E

&_MATERS FORM2E26.4_...  FORMZEZE

&_[CTEST FORMZ2E26.4_0... FORMZE2E

&_SPECHS FORMZ2E26.4_5... FORMZE2E

&_SUBMIT FORMZ2E26.4_5... FORMZE2E

CCaSS_Evall.. FORM2E626.CCA.. FORM2E2E

CITY FORMZE2E.CITY  FORMZE2E w

Calculations

Field Alias Field SOL Alias Table SOL Alias Function E xpreszion

COMTRACT_LOCATION  [SELECT COMTRACT.LO... FORMZEZE E=preszion [SELECT COMTRACT.LOCAT...
2|
=]

0K | Cancel |

Also, we only want the last evaluation. To handle that, enter this expression into the search criteria:

(select MAX(EVAL.EVA_NO) from form2626 EVAL where EVAL.CONTRACT_ID =
FORM2626.CONTRACT _ID)
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R Query Designer

S[=1E9

Tahbsl Hehsl Calcs lGrDup Search lSDﬂ ] SOL ]

(4, Available Fields

Field Alias | Field SOL Aliaz | Table SOL Alias -

ACCEPTAMCE_... FORMZ2B26.ACC.. FORMZB2E

ACH_PROGRA. .. FORMZ2B26.AC..  FORMZE2E

ADDED_DATE FORMZ2E26.4D...  FORMZB2E

ADH_SCHD FORMZ2E26.4D...  FORMZB2E

AD_SFPLAMN FORMZ2E26.40_... FORMZB2E

AD_SITE FORMZ2E26.40_... FORMZB2E

AOR_IMIT_DATE  FORMZ2B26.40...  FORMZE2E

AQ_FINAL _DATE  FORMZ2B26.40_... FORMZE2E

AQ_RATE_DATE FORMZ2B26.40_... FORMZE2E

ASBUILTS_aDE... FORMZ2B26.45B.. FORMZE2E

awsR0_DATE FORMZE2E6.2%/ .. FORMZE2E

awtRD_VallJE  FORM2B26.4%.. FORMZE2E

&_CLC_PLAM FORMZ2E26.4_C... FORMZE2E

&_MATERS FORM2E26.4_...  FORMZEZE

&_[CTEST FORMZ2E26.4_0... FORMZE2E

&_SPECHS FORMZ2E26.4_5... FORMZE2E

&_SUBMIT FORMZ2E26.4_5... FORMZE2E

CCaSS_Evall.. FORM2E626.CCA.. FORM2E2E

CITY FORMZE2E.CITY  FORMZE2E w

Criteria

Field Operator Walue AutoSearch | Mandaton Show All

FORMZE2E.EVa_ MO = [zelect Max[EVaL EVea_MNO] from...
2|
=]

0K | Cancel |

Finally set the sort order as shown here:
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17.6

R Query Designer

241

Tahlesl Fieldsz ] Calcs l Gmup] Search Sort ISQL ]
21 Available Fields
Field Alias | Field SOL Aliss | Table SOL Alias | A
ACCEPTAMCE_.. FORM2B26ACC.. FORMZ2B26
ACL_PROGRA.. FORMZ2B26AC.. FORMZ2B26
ADDED_DATE FORM2E26.40... FORMZE26
ADH_SCHD FORM2E26.40... FORMZE26
AD_SFPLAN FORM2E26.40_... FORMZE26
AD_SITE FORM2E26.40_... FORMZE26
ADR_IMIT_DATE FORM2B26.40... FORMZE26
AD_FIMAL_DATE  FORM2B26.40_... FORMZE26
AD_RATE_DATE FORM2B26.40_... FORMZE26
ASBUILTS_ADE... FORM2EB26.A5B... FORMZE2E
AwiARD_DATE  FORM2EB26.AW/ .. FORMZE2E
AwiARD_WVALUE  FORM2E26.4%/ .. FORMZE2E
&_COC_PLAN FORMZE2E.4_C... FORM2E25
& _MATERS FORMZE2E.A_... FORM2E25
&_[CTEST FORMZB26.4_0... FORMZE26
&_SPECMS FORMZE2E.4_5... FORM2E25
&_SUBMIT FORMZE2E.4_5... FORM2E25
CCASS_Evall.. FORMZE2B.CCA.. FORM2BZE
CITY FORMZEZE.CITY  FORM2E25 s
Sort Fields [ Matural Order
Field Alias Field SOL Alias Tahle SCIL Alias Desc [z > a)
CONTRALCT ACTMITY FORMZE25.C0..  FORM2526
CONTRACT SERIAL NUMBER FORMZE25.C0..  FORM2526 Y
COMTRACT_ORDER_MUMEBER FORMZEZE.CO... FORMZEZE
|
0K | Cancel |

Step 5 - Create the Eval Global Query

Now we will create a global eval query that we will use to do the actual calculations for the ratings and

averages.

Select File > New > Query Designer and select the FORM2626 table again
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R Query Designer

Fieldsz ] Calcs l Gmup] Sealchl Sort ] SOL ]
Available Tables

T able T able Mame -~
ACCIDEMT ACCIDENT

ACTMITY_DESC  ACTIMITY_DESC

ACTIMITY_PaY_HISACTIMITY _PAY_HIE

ACTIMITY_OA ACTIITY_QA

ACTMITY_SCHEDUACTMTY _SCHEDL

AEEMCY AGENCY
AGEEMT AGEMT
aHa_HAZARD AHé_HerARD
é&H&_STEF AHa_STEP

ANT_WEATHER  ANT_WEATHER
aPPYU_CONTRACTAPPYU_CONTRAC
aPPYU_CONTRACTAPPYU_CONTRAC
aPPYU_CONTRACTAPPYU_CONTRAC
BASELIME_LIBRAR BASELINE_LIERAR
BASELINE_OFFICE BASELINE_OFFICE
BID EID

BID_CHANGE BID_CHANGE
BID_CHAMGE_OBLIBID_CHANGE_OBL

BID_OBLI BID_OBLI w
Selected T ables [ Distifct
Tahble Tahle Mame SOL Alias Jaoin Type

FORMZEZE FORMZE2E FORM2E626

Ok, | Cancel

Select the following fields
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R Query Designer

Tableg Fields lEaIcs ] Gn:uup] Search] Sort ] S0l ]
[A] Awvailable Fields
Field Alias | Field SOL &lias | Table S0L Alias | -
ACCEPTAMCE ... FORMZBZEALCC.. FORM2EZE
ACO_PROGRA.. FORM2BZEALC..  FORM2EZE
ADDED_DATE FORMZE26.AD ...  FORMZE2E
ADH_SCHD FORMZE26.80... FORMZ2EZE "
Selected Fields [ All Fields
Field Alias Field SOL Aliaz Table SCL Alaz
COMTRACT_ID FORMZB26.C0... FORMZ2EB2E
OWERALL_RATING FORMZEZ26.00 ...  FORMZEZ6
DIMS4 FORMZE2E6.DU... FORMZEBZE
EVA_WNO FORMZB26.EVA.. FORMZEB2R
COMPAMY_MAME FORMZE26.C0... FORMZEZ6
WORK_CIUALITY_RATIMG FORMZE2E0... FORMZEZE
COC_ADEQUALCY_RATIMNG FORMZE2ZE.CL... FORMZEB2E
CAC_IMPLEMEMT_RATING FORMZB2E.CH... FORMZ2EB26
ASBUILTS_ADEQUALCY _RATING FORMZE26.45B... FORMZEZ6
CLEAMUP_aADEQUACY_RATING FORMZE26.CLE... FORMZEB2E
COOPERATIOM_RESPOMSE_RATING FORMZE2E.CO... FORMZEB26
DEF_wWORK_CORRECTION_RATIMG FORMZE26.0EF... FORMZEZ6
DELAY_RESOLUTIOMN_RATIMNG FORMZE26.DEL... FORMZEBZE
LABOR_COMPLIAMCE_RATIMNG FORMZEZE.LAR... FORMZEB2E
LABOR_DEFICIENCY _RATIMG FORMZB2E.LAB... FORMZ2EB26
LABOR_PAYROLLS_RATIMG FORMZE26.LAB... FORMZEZ6
Léw'S_REGS_COMPLIAMCE_RATIMG FORMZEZE.LA. .. FORMZEZE ﬂ
MATERIAL_ADEQUACY _RATIMG FORMZEZE M4,  FORMZEB2E
MATERIAL_STORAGE_RATING FORMZE26.MA... FORMZEZ6
PROFESSIOMNAL_COMDUCT_RATIMG FORMZEZE.PR... FORMZEBZE
FUMCHLIST _ITEMS_RATIMNG FORMZEZEPU... FORMZEB2E
QC_DOC_QUALITY _RATIMNG FORMZB26.QC_... FORMZ2EB26
QC_TEST_ADEQUALCY_RATIMG FORMZ626.0C_... FORMZG62E
REQD_DOCUMENTATION_RATIMNG FORMZ626.RE... FORMZEZE
RESOURCE_MAMAGEMEMT_RATING FORMZEZE.RE... FORMZEB2E
REVISED_SCHEDULE_RATIMNG FORMZB2E6.RE... FORMZEB2E
SAFETY_ADEQUACY_RATIMG FORMZE26.54F... FORMZEZE
SAFETY_DEFICIEMCY _RATIMG FORMZEZE.5AF... FORMZEB2E
SAFETY_IMPLEMENT_RATIMG FORMZB2E.5AF.. FORMZ2EB26
SCHEDULE_aDEQUACY _RATING FORMZE26.5C... FORMZG626 ﬂ
SCHEDULE_ADHEREMCE_RATIMNG FORMZE2E6.5C... FORMZEBZE
SITE_SUFPERYISIOM_RATING FORMZEZE.5IT... FORMZEB2E
SPECIFIED _MATERIALS_RATIMG FORMZB26.5PE... FORMZEB2E
SUBCOMTRACT_COMTROL_RATIMNG FORMZE26.510... FORMZEZ6
SUECOMTRACT_ISSUES_RATIMG FORMZE2E.5... FORMZEB26
SUBCONTRALCT _PLAM_RATIMNG FORMZB26.5... FORMZ2EB26
SUEMITTAL_ADEQUALCY_RATIMG FORMZE26.510... FORMZEZ6
Wit RRANTY_RESPOMSE_RATIMG FORMZEZE ...  FORMZEBZE
OF. | Cancel
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Set the search criteria as shown here using this oracle expression.

(select MAX(EVAL.EVA_NO) from form2626 EVAL where EVAL.CONTRACT_ID =
FORM2626.CONTRACT _ID)

R Query Designer.

Tables] Fields ] Calcs ] Group Search ]Su:urt ] SAL ]

) Awailable Fields

Field Alias | Field SOL &lias | Table 5L Alias | ”
ACCEPTANCE_.. FORM2E26ACC.. FORM2E2E -
4CO_PROGRA.. FORM2E264C.  FORMZ2E2E

4DDED_DATE  FORM26264D..  FORMZ2E2E

ADH_SCHD FORMZE26.40... FORM2B2E
A0 _SFPLaM FORMZ2626.40_... FORM2B2E
A0 SITE FORMZ626.40_... FORMZB2E

AOR_INIT_DATE  FORM2E26.40.. FORMZG626
A0_FIMAL_DATE FORM2626.40_... FORMZG626
A0 _RATE_DATE  FORM2B26.40_.. FORMZGE26
ASBUILTS_ADE.. FORM2B26.A5B.. FORMZE26

AwARD DATE FORMZE26.AW .. FORMZG26 b

Criteria

Field Operatar Walue AutoSearch | Mandatory Show Al

FORMZE2E.0UMNS4 Mot Blank,

FORMZ2E26.EVa_MO = [select Mas[EWAL EWA_ -
|

£ | >

()4 | Cancel |

Finally, sort by DUNS
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17.7

R Query Designer

Tables] Fields ] Calcs ] Gn:uup] Search Sort ISQL ]
21 wvaiable Fields

Field &lias | Field SOL &lias | Table 50L Alias | ”
ACCEPTANCE_. FORM2B2BACC.. FORM2526 3
ACO_PROGRA..  FORM2626AC..  FORMZG626
ADDED_DATE  FORM26264D..  FORM2526

ADH_SCHD FORMZ626.40... FORM2B2E
AD_SFPLAM FORM2E26.40_... FORM2B2E
ah_SITE FORMZ2626.4D_... FORM2BZE

AOR_INIT_DATE  FORM2B26.40.. FORMZGE26
A0_FIMAL_DATE FORM2626.40_.. FORMZGE26
&0_RATE_DATE FORM2E26.40_.. FORMZG26
ASBUILTS_ADE.. FORM2B26.45B.. FORMZGE26

AwARD DATE FORMZEZEAW...  FORMZE2E et
Sort Fields [ Matural Order
Field Alias Field SQL Aliaz Table SOL Alias Desc (2> a)
DUMNS4 FORMZEZE.DUNS4 FORMZEZE
2|
|

Ok | Cancel |

Step 5 - Link the FORM2626 to the RBVU_DISTINCT_KTR_DUNS4
query

Link the two dataviews as shown here by dragging the DUNS4 field from the FORM2626 to the
RBVU_DISTINCT_KTR_DUNS4 query
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RMS Report Designer [ de_rms.world ]: Contractor Evaluation Grades

File:

Data ]Calc I Deswgn} F‘review]

EEX

RB [ N KTR_DUN ORMZ626 linked to RB D N KTR_DUN
R B0 TFTQ 4| # G E2maE v & &
M anme Type Size M arne | Type | Size |
L2l e pUNSA Sting 13
[fl) COMPANY_MAME Sting 40
[ CONTRACT_ID Sting 25
[/ Eva_NO Double

[A] CONTRACT_SERIAL_MUMBE Sting 9

| EOE TQs | & &

MName | Type | Size |

[ COMTRACT_ID Sting 25
L[] OVERALL_RATING Sting 1
[ DUNS4 Sting 13
[ EvA_NO Double

[ COMPANY_NAME Sking 40

[IN[E3

| >

£

Ready.

Set the link settings as shown

/= Link FORM2626 as Detail

Detal - FORM 2626 h azter -
COMPANY_HARME ” DUWS
COMTRACT_ID —3
B MO

COMTRACT_SERIAL_MUME
COMNTRACT_ACTRATY
CONTRACT_ORDER_MUME
AiaRD_WAlLUE
EvALUATOR_MAME =
EvaLUATOR_ORGAMIZATIC
OVERALL_RATIMNG b

Linked Fields
DUMNS4 - DUNS

* 1 Include only those records from REVU_DISTINCT_KTR_DUMS4
for which matching FORM2E26 records can be found.
" 2 Include all records from REYU_DISTIMCT_ETR_DUMNSA,

[egarl;lless of whether any matching FORM 2626 records can be

Clear

Cancel
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17.8

Step 6 - Design the Report

On the design tab, layout your report as shown here.

RMS Report Designer [ de_rms.world ]: Contractor Evaluation Grades
File Edit ‘iew Report Help

Diata I Cale  Design | Previewl

h | AEEuEal Ao ATEELRG® EERE
| | [a ~]fio - Bzu A vE | S

N Dl  nsk | & &

N

...... A~

T . Ug Army Corps
- - -of Englneers.- - -

dbL5R ating . e

........................................................................................... |

% Main: REYU_DISTINCT_KTR DUNS4j{SubHepUrl1: FDHMZSZS}"

Ready, Left: 0 Top: O ‘Width: 0 Height: 0
A
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17.9 Step 7 - Refer to the finished example for RAP details

For learning purposes, refer to the completed example for all of the RAP coding that drives the report.
Explore the various coded events and global functions for some good examples on how to handle
some advanced RAP concepts.
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18

18.1

18.2

Example 18 - RMS Construction Calendar

Enter topic text here.

Overview

This report shows how to create a calendar of events. It uses an advanced SQL statement to create a
view with a row for every possible day. That view becomes the main query in the report and then all
other queries for actual events are simply linked to it.

RMS Calendar

UE Ay Corps

31-Aug-07

of Englneors-.

ks

Contract J3000554

Cantract WWia1284-04-D-0003 0002
Contract WWH1284-04-D-0003 0002
Contract DACAB3-03-D-0015 0005
Cantract WWa1284-04-D-0013 0001
Contract W31 284-04-D-0013 0001
Contract WWH1284-06-C-0001
Contract W31 284-06-P-0010

Scheduled Milestone
Scheduled Milestane
Scheduled Milestone
Scheduled Milestone
FPreparatory Scheduled for
Freparatory Scheduled for

Contract Award

Physical Completian
Contractor Evaluation Date
Transfer Document Date
16711

16710

FPayment Due Invoice Mo: 12

FPayment Due Invoice Mo: 1

Saturday February 3, 2007

Contract W31 28A-06-P-0027
Contract W1 28A-06-P-0027
Contract W1 28A-06-P-0027
Contract WW31284-06-0-0002 0001
Contract W31284A-06-0-0002 0001

Scheduled Milestone
Scheduled Milestone
Scheduled Milestone
Preparatory Scheduled for
Preparatory Scheduled for

DD2626 initiated

Contractor Evaluation Date
Physical Comnletion
ELECTRICAL, INTERIOR - ROUGH
CAULKING & SEALANTS

Sunday February 4, 2007

Skills shown:
- Advanced SQL (SQL unions)
- User create view

Step 1 - Add a view to create daily records

We will use some crossjoins to create numerous daily records within a view since we dont have a

table in RMS for every day avaialable.

Here is the SQL:

select trunc(sysdate-10000 + digit5.val + digit4.val + digit3.val + digit2.val + digitl.val) as v_date from

(select 0 val from dual union
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select 1 val from dual union
select 2 val from dual union
select 3 val from dual union
select 4 val from dual union
select 5 val from dual union
select 6 val from dual union
select 7 val from dual union
select 8 val from dual union
select 9 val from dual) digitl

Cross join
(select 0 val from dual union

select 10 val from dual union
select 20 val from dual union
select 30 val from dual union
select 40 val from dual union
select 50 val from dual union
select 60 val from dual union
select 70 val from dual union
select 80 val from dual union
select 90 val from dual) digit2

Cross join
(select 0 val from dual union

select 100 val from dual union
select 200 val from dual union
select 300 val from dual union
select 400 val from dual union
select 500 val from dual union
select 600 val from dual union
select 700 val from dual union
select 800 val from dual union
select 900 val from dual) digit3

Cross join
(select 0 val from dual union

select 1000 val from dual union
select 2000 val from dual union
select 3000 val from dual union
select 4000 val from dual union
select 5000 val from dual union
select 6000 val from dual union
select 7000 val from dual union
select 8000 val from dual union
select 9000 val from dual) digit4

Cross join
(select 0 val from dual union

select 10000 val from dual union
select 20000 val from dual union

select 30000 val from dual) digit5
order by v_date

251
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Add ! Edit View

Yiew Mame

Wiew Description

SQL Editar

1 |zelect trunec{sysdate-10000 + digit5.wal + digitd.wal + digit,*

2 |({selezt 0 wal from dual union

3 select 1 wal from dual union

& select 2 wal from dual union

= select 3 wal from dual union

& select 4 wal from dual union

7 select 5 wal from dual union

g select 6 wval from dual union

= select 7 wal from dual union

10 select 8 wal from dual union

11 select @ wal from dual) digitl

12 |zross join

13 |izelect O wal from dual union

14 select 10 wal from dual union

15 select 20 wal from dual union
mal amt A aral  Frcee diral 1ims o

Cancel Create Yiew

18.3 Step 2 - Configure the Queries
We will have six queries. The main one will use our view for the days.

Add a query for the days:
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R Query Designer

Tables l Fields ] Calcz ] Graup k earch] Sort ] SHL ]

Available Tables

Table T able Name ~
ACCIDENT ACCIDENT

ACTMITY_DESC  ACTMITY_DESC
ACTMTY_PAY_HISACTIMTY_PAY_HIS
ACTIMITY_QA ACTIMITY_QA

AGENT AGENT
AHA_HAZARD AHA_HAZARD
AHA_STEP AHA_STEP

ANT_WEATHER  ANT_WEATHER
APPYU_CONTRACIAPPYU_CONTRALC
APPYU_CONTRACIAPPYU_CONTRAL
APPYU_CONTRACIAPPYU_CONTRALC
BASELIME_LIBRARBASELIME_LIBRAR
BASELIME_OFFICE BASELINE_OFFICE
BID BID

BID_CHANGE BID_CHAMGE
BID_CHANGE_OBLIBID_CHAWGE_CBEL

BID_OBLI EID_OBLI
CALEMDAR CALENDAR
CATEGORIES CATEGORIES
CATEGORY CATEGORY

CEFMS_ACCRUAL CEFMS_ACCRUAL
CEFMS_INW_LINE_|CEFMS_IMY_LINE_

CEFMS_INY_LINE_ICEFMS_IMY_LINE _ v
Selected Tables [~ Distinct
Tahle Table Hame SOL Aliaz Join Type

REWU_ALL_DAY'S REWU_ALL DA  RBVU_ALL_Da...

113 | Cancel

Select all fields

Add an activity schedule query that joins to contract:
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R Query Designer
Tables l Fields ] Calcz Gmup] Search] Sort ] SHL ]
Available Tables

B=1E3

Table T able Name
ACCIDENT ACCIDENT
ACTMITY_DESC  ACTIMITY_DESC
ACTIMITY_PAY_HISACTIMITY_Pay_HI:
ACTIMITY_QA ACTIVITY_O&
ACTIMITY_SCHEDUACTIMITY_SCHEDL

AGEMCY AGEMCY
AGENT AGENT
AHA_HAZARD AHA_HAZARD
AHA_STEP AHA_STEP

ANT_WEATHER  ANT_WEATHER
APPYU_CONTRACIAPPYU_CONTRALC
APPYU_CONTRACIAPPYU_CONTRAL
APPYU_CONTRACIAPPYU_CONTRALC
BASELIME_LIBRARBASELIME_LIBRAR
BASELIME_OFFICE BASELINE_OFFICE
BID BID

BID_CHANGE BID_CHAMGE
BID_CHANGE_OBLIBID_CHAWGE_CBEL

BID_OBLI EID_OBLI
CALEMDAR CALENDAR
CATEGORIES CATEGORIES
CATEGORY CATEGORY

CEFMS_ACCRUAL CEFMS_ACCRUAL
CEFMS_INW_LINE_|CEFMS_IMY_LINE_
CEFMS_INV_LINE_ICEFMS_INv_LINE_

|

Select these fields

v
Selected Tables [~ Distinct
Tahle Table Name SOL Alias Jain Type:
ACTIMTY_SCHEDULE ACTMITY_SCH...  ACTIMITY_SCH..
COMTRACT COMTRACT COMTRACT Irner
113 | Cancel
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R Query Designer
Tahbles Fields lEaIcs ] Gmup] Search] Sort ] SaL ]
[B] Available Fields

Field &lias | Field SOL &lias | Table SOL Alias | ”~
CAL_CODE ACTITY_SCH..  ACTIATY_SCH...
EFDATE ACTIVITY_SCH...  ACTIATY_SCH... =
LFDATE ACTIVITY_SCH...  ACTIMTY_SCH...
LSDATE ACTIVITY_SCH...  ACTIMTY_SCH...
NAS_ACTF ACTIVITY_SCH...  ACTIATY_SCH...
NAS_ACTS ACTIVITY_SCH...  ACTIATY_SCH...

QAYERSION ACTMITY_SCH...  ACTMITY_SCH...
QCYERSION ACTMITY_SCH...  ACTMITY_SCH...
TOT_FLOAT ACTMITY_SCH...  ACTMITY_SCH...
ACD_AGEMT_C... CONTRACT.AC.. CONTRACT
ACTIATY_VARL. COWTRACT.AC.. CONTRACT

ACT_PER COWNTRACT.AC.. CONTRACT
ACT_PER_LESS.. COMNTRACT.AC.. CONTRACT
ACT_PLCMT CONTRACT.AC.. COMTRACT
ACT_TOT COWNTRACT.AC.. COMNTRACT

AE_ADDRESS1T  COWTRACT.AE..  CONTRACT
AE_ADDRESSZ  COMTRACT.AE.. CONTRACT
AE_ADDRESS3  CONTRACT.AE..  COMTRACT
AE_EVAL_ACT COWNTRACT.AE.. COMNTRACT
AE_EWaL_ RO COMTRACT.AE.. CONTRACT
AE_EVAL SCH CONTRACT.AE.. COMNTRACT

AE_TITLE CONTRALCT.AE... CONTRACT

ALT_REF CONTRALCT.AL.. CONTRACT

ALT_REPZ COMTRACT.AL.. CONTRACT

ALT_REP3 CONTRALCT.AL..  CONTRACT v

Selected Fields [~ &l Fields

Field Alias Field SOL Alias Table SOL Alias

CONTRACT_ID  ACTIWMITY_SCH..  ACTIMTY_SCH...

FMT_CONTRAC.. COMTRACT.FM.. CONTRACT ﬂ

1D ACTIMITY_SCH...  ACTMITY_SCH...

ESDATE ACTIMITY_SCH...  ACTMITY_SCH... J
+

113 | Cancel |

Add a request query that links to contract as shown here
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R Query Designer

Available Tables

lFieIds | Cales ] Gmup] Search] Sort ] SaL ]

Table T able Name
ACCIDENT ACCIDENT
ACTMITY_DESC  ACTIMITY_DESC
ACTIMITY_PAY_HISACTIMITY_Pay_HI:
ACTIMITY_QA ACTIVITY_O&
ACTIMITY_SCHEDUACTIMITY_SCHEDL

AGEMCY AGEMCY
AGENT AGENT
AHA_HAZARD AHA_HAZARD
AHA_STEP AHA_STEP

ANT_WEATHER  ANT_WEATHER
APPYU_CONTRACIAPPYU_CONTRALC
APPYU_CONTRACIAPPYU_CONTRAL
APPYU_CONTRACIAPPYU_CONTRALC
BASELIME_LIBRARBASELIME_LIBRAR
BASELIME_OFFICE BASELINE_OFFICE
BID BID

BID_CHANGE BID_CHAMGE
BID_CHANGE_OBLIBID_CHAWGE_CBEL

BID_OBLI EID_OBLI
CALEMDAR CALENDAR
CATEGORIES CATEGORIES
CATEGORY CATEGORY

CEFMS_ACCRUAL CEFMS_ACCRUAL
CEFMS_INW_LINE_|CEFMS_IMY_LINE_
CEFMS_INV_LINE_ICEFMS_INv_LINE_

And select these fields

v
Selected Tables [~ Distinct
Tahle Table Mame SOL Aliaz Join Type
REQUEST REGUEST REQUEST
COMTRACT COMTRACT COMTRACT Irner
113 | Cancel
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R QueryDesigner & EE

Tahbles Fields lEaIcs ] Gmup] Search] Sort ] SaL ]
[l Available Fields

Field &lias | Field SOL Alias | Table SOL Alias | ”~
ALLOWED_EARNINGS_CO.. REQUESTALL. REQUEST
APPROVER_NAME REQUEST.APP.. REGUEST 1
APPROVER_TITLE REQUEST.APP..  REGUEST
Ca_LIME_ITEM_AMT REQUEST.CAY.. REQUEST
CEFMS_APPROVAL_STATUS REQUEST.CEF.. REQUEST
CEFMS_CHANGES REQUEST.CEF.. REQUEST
CEFMS_COMPARE REQUEST.CEF.. REQUEST
CEFMS_EARNINGS REQUEST.CEF.. REGUEST
CONTRACT_SETTLEMENT.. REQUEST.COM.. REQUEST
CURRENT_DED REQUEST.CUR.. REQUEST
CURRENT_DEDUCTIONS ~ REQUEST.CUR.. REQUEST
CURRENT_EARNINGS REQUEST.CUR.. REQUEST

CURRENT_LIG_DAMAGE REQUEST.CUR.. REGUEST
CURRENT_OTHER_REFUMD REGUEST.CUR.. REGQUEST

CURRENT_PAYMENT REQUEST.CUR... REQUEST

CURRENT_PER_RETAINED  REQUEST.CUR.. REQUEST

CURREMT_REFUNDS REGQUEST.CUR... REQUEST

CURREMT_RETAIMED REQUEST.CUR... REQUEST

CURREMT_RETAIMN_REFUMD REGQUEST.CUR.. REGQUEST

DISCOUNT_DaAYS REGQUEST.DIS.. REQUEST

DISCOUNT_PERCENT REQUEST.DIS.. REQUEST

DUE_TEXT REQUEST.DUE... REQUEST

EARMINGS_WARIANCE REQUEST.EAR.. REQUEST

EMGS3 COMFLETE REGQUEST.ENG... REQUEST

ERRMSG REQUEST.ERR... REQUEST v
Selected Fields [~ &l Fields
Field Alias Field SOL Alias Table SOL Alias

CONTRACT_ID REQUEST.CON... REQUEST

INY_ND REQUEST.INV_... REQUEST ﬂ
DUEDATE REQUEST.DUE... REQUEST

FMT_CONTRACT_DELIMVERY COMTRACT.FM... COMTRALCT

PROJ_NAME CONTRALCT.PR... CONTRACT ﬂ

113 | Cancel |

Add an event query that links to contract as shown:
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R Query Designer

Available Tables

lFieIds ] Calcs ] Gmup1 Search] Sort ] SaL ]

Table T able Name
ACCIDENT ACCIDENT
ACTMITY_DESC  ACTIMITY_DESC
ACTIMITY_PAY_HISACTIMITY_Pay_HI:
ACTIMITY_QA ACTIVITY_O&
ACTIMITY_SCHEDUACTIMITY_SCHEDL

AGEMCY AGEMCY
AGENT AGENT
AHA_HAZARD AHA_HAZARD
AHA_STEP AHA_STEP

ANT_WEATHER  ANT_WEATHER
APPYU_CONTRACIAPPYU_CONTRALC
APPYU_CONTRACIAPPYU_CONTRAL
APPYU_CONTRACIAPPYU_CONTRALC
BASELIME_LIBRARBASELIME_LIBRAR
BASELIME_OFFICE BASELINE_OFFICE
BID BID

BID_CHANGE BID_CHAMGE
BID_CHANGE_OBLIBID_CHAWGE_CBEL

BID_OBLI EID_OBLI
CALEMDAR CALENDAR
CATEGORIES CATEGORIES
CATEGORY CATEGORY

CEFMS_ACCRUAL CEFMS_ACCRUAL
CEFMS_INW_LINE_|CEFMS_IMY_LINE_
CEFMS_INV_LINE_ICEFMS_INv_LINE_

And select these fields

v
Selected Tables [~ Distinct
Tahle Table Mame SOL Aliaz Join Type
EVENT EVENT EVENT
COMTRACT COMTRACT COMTRACT Irner
113 | Cancel

USACE



Example 18 - RMS Construction Calendar 259

R Query Designnkr E]E
Tahbles Fields lEaIcs ] Gmup] Search] Sort ] SaL ]
[l Available Fields

Field &lias | Field SOL &lias | Table SOL Alias | ”~
ACTITY_ID EVENTACTIVI..  EVENT
DATE_ACT EVENT.DATE_. EVENT =
DATE_ORG EVENT.DATE_. EVENT

DO_MOT_DEL EVENT.DO_MO.. EWENT
EVENT_CODE EVENT.EWENT.. EVENT

EVENT_ID EVENT EVEMT... EWENT
EVENT_RO EVEMT EWENT.. EVENT
EVENT_TIME EVENT EVEMT.. EWENT
LAG_LEAD EVENT.LAG_LE.. EWENT
LINE_EWEMT_C... EWENT.LINK_E.. EVENT
LINK_TPE EVEMT.LINK_T.. EWENT
MILESTOME_C... EVENWT.MILEST.. EVENT
MEEDTIME EVEMT.MNEEDTI.. EWENT
ORDER_NO EVEMT.ORDER.. EVENT
PHASE_ID EVENT. PHASE.. EVENT
SUBGROUP EVENT.SUBGR.. EWENT

TIME_MALLE EVENT.TIME_V.. EWENT

ACO_AGEMT_C.. CONTRACT.AC.. COMNTRACT
ACTRATY_VARL. COWTRACT.AC.. CONTRACT
ACT_PER COWNTRACT.AC.. COMNTRACT
ACT_PER_LESS.. CONTRACT.AC.. CONTRACT
ACT_PLCMT COWNTRACT.AC.. COMNTRACT

ACT_TOT CONTRALCT.AC.. CONTRACT
AE_ADDRESS COMTRACT.AE.. CONTRACT
AE_ADDRESS2  CONTRACT.AE.. CONTRACT v
Selected Fields [~ &l Fields
Field Alias Field SOL Aliaz Table SOL Alias
DATE_SCH EVENT.DATE_.. EVEMWT
CONTRALCT_ID EVENT.COMTR... EVENWT -
EVENT_DS EVENT.EVEMT... EVENWT
FMT_CONTRACT_DELIMVERY CONTRACT.FM... CONTRACT

+

113 | Cancel |

Add a feature_qa query that links to contract for the prep dates
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R Query Designer

Available Tables

lFieIds ] Calcs Gmup] Search] Sort ] SaL ]

Table T able Name
ACCIDENT ACCIDENT
ACTMITY_DESC  ACTIMITY_DESC
ACTIMITY_PAY_HISACTIMITY_Pay_HI:
ACTIMITY_QA ACTIVITY_O&
ACTIMITY_SCHEDUACTIMITY_SCHEDL

AGEMCY AGEMCY
AGENT AGENT
AHA_HAZARD AHA_HAZARD
AHA_STEP AHA_STEP

ANT_WEATHER  ANT_WEATHER
APPYU_CONTRACIAPPYU_CONTRALC
APPYU_CONTRACIAPPYU_CONTRAL
APPYU_CONTRACIAPPYU_CONTRALC
BASELIME_LIBRARBASELIME_LIBRAR
BASELIME_OFFICE BASELINE_OFFICE
BID BID

BID_CHANGE BID_CHAMGE
BID_CHANGE_OBLIBID_CHAWGE_CBEL

BID_OBLI EID_OBLI
CALEMDAR CALENDAR
CATEGORIES CATEGORIES
CATEGORY CATEGORY

CEFMS_ACCRUAL CEFMS_ACCRUAL
CEFMS_INW_LINE_|CEFMS_IMY_LINE_
CEFMS_INV_LINE_ICEFMS_INv_LINE_

And select these fields:

v
Selected Tables [~ Distinct
Tahle Table Mame SOL Aliaz Join Type
FEATURE_Q& FEATURE_GA FEATURE_Q&
FEATURE FEATURE FEATURE Irner
CONTRALCT COMTRALCT CONTRALCT Inner
113 | Cancel
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R Query Designer
Tahbles Fields lEaIcs ] Gmup] Searct 1 Sort ] SaL ]
[B] Available Fields

Field &lias | Field SOL &lias | Table SOL Alias | ”~
FEATURE_ID FEATURE_GA... FEATURE_GA
INIT_HELD FEATURE_GAL. FEATURE_GA E
INIT_SCHL FEATURE_GAI.. FEATURE_G&
INIT_TIME FEATURE_GAL. FEATURE_GA
PREP_HELD FEATURE_GA... FEATURE_GA
PREP_TIME FEATURE_GA.. FEATURE_GA

QAYERSION FEATURE_QA...  FEATURE_GA
QCYERSION FEATURE_QA...  FEATURE_GA
CONTRACT_ID FEATURE.COM.. FEATURE
FEATURE_ID FEATURE.FEA.. FEATURE
FINISHED FEATUREFINI..  FEATURE
FINISH_DATE FEATUREFINI..  FEATURE
FIRST_ACTDS FEATUREFIRS.. FEATURE
FIRST_ACTID FEATUREFIRS.. FEATURE
FOLLOW_COUMT FEATURE.FOLL.. FEATURE
GOW_STATUS FEATURE.GOY.. FEATURE
H&ZARD_ACCE.. FEATUREHAZ.. FEATURE
H&ZARD_ACCE.. FEATUREHAZ..  FEATURE
H&ZARD_COMP... FEATUREHAZ.. FEATURE
HAZARD_COMNT... FEATUREHAZ.. FEATURE
HAZARD_EGQUL. FEATUREHAZ.. FEATURE
HaZARD_EXPO.. FEATUREHAZ..  FEATURE
H&ZARD_GOY_.. FEATUREHAZ. FEATURE
HAZARD_GOY_.. FEATUREHAZ.. FEATURE

HAZARD_INSP... FEATUREHAZ.. FEATURE v
Selected Fields [~ &l Fields
Field Alias Field SOL Aliaz Table SOL Alias
PREP_SCHL FEATURE_QA... FEATURE_GQA
FEATURE FEATURE.FEA..  FEATURE -
CONTRACT_ID FEATURE_QA... FEATURE_QA
FMT_CONTRACT_DELIMVERY CONTRACT.FM... COMTRACT

+

113 | Cancel |

And for the last query, add a second query for FEATURE_QA for the initial inspections
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R Query Designer

Available Tables

lFieIds ] Calcs ] Gmup] Search] Sort ] SaL ]

Table T able Name
ACCIDENT ACCIDENT
ACTMITY_DESC  ACTIMITY_DESC
ACTIMITY_PAY_HISACTIMITY_Pay_HI:
ACTIMITY_QA ACTIVITY_O&
ACTIMITY_SCHEDUACTIMITY_SCHEDL

AGEMCY AGEMCY
AGENT AGENT
AHA_HAZARD AHA_HAZARD
AHA_STEP AHA_STEP

ANT_WEATHER  ANT_WEATHER
APPYU_CONTRACIAPPYU_CONTRALC
APPYU_CONTRACIAPPYU_CONTRAL
APPYU_CONTRACIAPPYU_CONTRALC
BASELIME_LIBRARBASELIME_LIBRAR
BASELIME_OFFICE BASELINE_OFFICE
BID BID

BID_CHANGE BID_CHAMGE
BID_CHANGE_OBLIBID_CHAWGE_CBEL

BID_OBLI EID_OBLI
CALEMDAR CALENDAR
CATEGORIES CATEGORIES
CATEGORY CATEGORY

CEFMS_ACCRUAL CEFMS_ACCRUAL
CEFMS_INW_LINE_|CEFMS_IMY_LINE_
CEFMS_INV_LINE_ICEFMS_INv_LINE_

Using these fields:

v
Selected Tables [~ Distinct
Tahle Table Mame SOL Aliaz Join Type
FEATURE_Q& FEATURE_GA FEATURE_Q&
FEATURE FEATURE FEATURE Irner
CONTRALCT COMTRALCT CONTRALCT Inner
113 | Cancel
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R Query Designer EE

Tahbles Fields lEaIcs ] Gmup] rch] Sort ] SEL ]
[l Available Fields

Field &lias | Field SOL &lias | Table SOL Alias | ”
INIT_HELD FEATURE_GAL. FEATURE_GA
INIT_TIME FEATURE_GAL. FEATURE_GA 3
PREF_HELD FEATURE_G4... FEATURE_G&
PREP_SCHL FEATURE_GA... FEATURE_GA
PREP_TIME FEATURE_GA... FEATURE_GA
QAVERSION FEATURE_GA.. FEATURE_GA
OCYERSION FEATURE_G4... FEATURE_G&
CONTRACT_ID  FEATURE.COM.. FEATURE
FEATURE_ID FEATUREFEA.. FEATLRE
FIMISHED FEATUREFIML..  FEATURE
FIMISH_DATE ~ FEATUREFINI.. FEATURE
FIRST_ACTDS  FEATUREFIRS.. FEATURE
FIRST_ACTID  FEATUREFIRS.. FEATURE
FOLLOW_COUNT FEATUREFOLL.. FEATURE
GOV_STATUS  FEATURE.GOV.. FEATURE
HAZARD_ACCE.. FEATUREHAZ. FEATURE
HAZARD_ACCE.. FEATUREHAZ. FEATURE
HAZARD_COMP.. FEATUREHAZ.. FEATURE
HAZARD_COMT.. FEATUREHAZ. FEATURE
HAZARD_EGUL. FEATUREHAZ.. FEATURE
HAZARD_EXPO.. FEATUREHAZ. FEATURE
HAZARD_GOV_.. FEATUREHAZ.. FEATURE
HAZARD_GOV_.. FEATUREHAZ. FEATURE
HAZARD_INSP.. FEATUREHAZ. FEATURE

HAZARD_TRAL.. FEATUREHAZ.. FEATURE v
Selected Fields [~ &l Fields
Field Alias Field SOL Alias Table SQL Alias

CONTRACT_ID FEATURE_QA...  FEATURE_GA

FEATURE_ID FEATURE_QA... FEATURE_OA -
INIT_SCHL FEATURE_QAI.. FEATURE_QA

FEATURE FEATURE.FEA.. FEATURE

FMT_COMTRACT_DELIVERY CONTRALCT.FM... CONTRACT ﬂ

113 | Cancel |

18.4 Step 3 - Link the queries using the dates

Link the queries as shown here using the date fields from each.

USACE



RMS Report Writing

RMS Report Designer [ rms.world 1*Calendar

CEX

File:

Data ICaIc | Design | Preview |

ACTIVITY_SCHEDULE linked to RBYU_ALL_DAYS

REVU_ALL_DAYS
A
YR R BDE TN &
Mame Type Size Name I Tupe I Size |
A _DATE DateTime L [l CONTRACT_ID Shing 5
_ NemiruT comToacT nelsere Shing 22
REQUEST linked to RBYU_ALL_D... Siting 1
[& | | @53 2l DateTime
pe
[l CONTRACT_ID Sting
[ INV_NO Double
[[|DUEDATE  DateTim
[l FMT_CONTRAC Sting 22
[QIPROJ_MNAME  Sting 40
EYENT linked to RE¥YU_ALL_DAYS
L 20DE T4 &
Mame I Type I S
. e —— [f] DATE_SCH DateTim
B ®@0E T Q8 R ®@O&E T4 [ EVENT_DS Sting 30
= T (T e Type | Size [l FMT_CONTRACT_DELIVERY Shing 22
[ CONTRACT_ID Sting 25 = [0l PREP_SCHL DateTim
I FEATUREID Sting 8 [BIFEATURE ~  Sting 30
o (g INIT_SCHL _ DateTim [QICONTRACT_ID Sing 25
I FATURE  Sung 30 [Q] FMT_CONTRAC String 22
£fl] FMT_CONTRAL String
£ I [E7]
Feady. Y

18.5 Step 4 - Design the Report

Deisgn the report using a region that contains subreports as shown here:
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RMS Report Designer [ rms.world ]: Calendar
File Edt View Report Help

Data I Calz  Design |F‘leview|

h | ABEnEEll aex AR RRe® EEA B

[ || [ = ~l| B r g|
B-d-m= B F mo |88 | s Es&d Toed wi WE DS

T A e T M [P R L B T B A

* Detal

~ Footer

Y Main: REVU_ALL_DAYS A SubReportl: ACTIVITY_SCHEDULE 4 SubReport2; EVEMT 4 SubReportd: FEATURE_GA A SubReportd: FEATURE_QAZ f SubRepont: REQUEST

Ready, Left: 0 [Top: 0 width: O Height: 0

Set the two dbtext objects at the top of the band to point to the V_DATE field. Set the display format of
the first one to dddd wich will print the day of the week and set the second one to mmmm d, yyyy
which will display the spelled out date of the year.

18.6 Step 5 - Design the Subreports

Design each subreport as shown. Make sure to configure the shiftrelative to values. You may have to
use the report tree to change the shiftrelative to since the subreports are within a region.
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RMS Report Designer [ rms.world ]: Calendar
File Edit View Report Help

Data | Cale Design | F‘reviewl
k| ABEnE@l a0 ARERELRE EERE
HMM| =z =l | [m|s g|

ew BaS Ted | wed WE | DS

O A e A N T B A B

\Main: REVL_ALL_DAYS A SubRepartl: ACTIVITY_SCHEDULE ‘ SubReport2: EVEMT ISubF!epoltS: FEATURE_QA Fy SubReportd: FEATURE_QA2 K SubReports: REQUEET 7

Ready. |Left: 0 [Top: 0 width: 0 Height: 0

RMS Report Designer [ rms.world ]: Calendar
File Edit

View Report  Help

Data | Cac  Desian | Preview |
h | AdEuEE|l aex AREERRG®  EORE
HMMI ]z ~] | 8|z g|

S Eas  Taw | g | WE DS

B

A AR

DAYS A SubReportl: ACTIVITY_SCHEDOULE ) SubReport2: EVEMT A SubReportd: FEATURE_GA § SubFeportd: FEATURE_QAZ A SubReportS: REQUEST

width: 0

Height: 0

RMS Report Designer [ rms.world ]: Calendar

File Edit View Report Help

Data |Ea\c Designlp,ewewl

b AR uEEt | @o®= | APE
I | [aia <[z
| a0

Fuhe® 20w @
~l||mlru

S | Tl | w2 | | E

& s -
ffo" " "' """

" -

* Detail

D@

|

13 ls" "

'\ FMain: REVI_ALL_DAvS f SubFeportl: ACTIFITY_SCHEDULE f SubReportz: EVERT A SubFeport: FEATURE, 34, {SubFepord: FEATURE_GA2 § SubFeports: REGIUEST /

Ready. Left: [Top: 0 [wiclth: 0 Height: 0
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RMS Report Designer [ rms.world ]: Calendar
File Edit View Report Help

Data |Ca\c DESiinF‘reviewl
h | ABEmEEf| Ao | AEEREL®®  EER @
[ HMM| =z =l | [m|s g|
: oW (Bad Ted | o | WME | DS

eI TR B R R TR B A B ¥ Y B M A B PR RO

|Left: 0 [Top: 0 width: 0 Height: 0

RMS Report Designer [ rms.world ]: Calendar
File Edit Yiew Report Help

Data | Calc DESIinPreviewl
h | AEEnm@Etel a9 [ATBEERLRE | BORE
HMMI ]z ~] | 8|z g|
BE w58 | or|Esd | Tad | we: WE | DS
N e

e I e A

Main: RBVU_ALL_DAYS 4 SubReportl: ACTIVITY_SCHEDULE 4 SubRepart2: EYENT 4 SubReport3: FEATURE_QA 4 SubFeportd: FEATURE_RA2 ) SubReports: REQUEST

width: 0 Height: 0
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19 Example 19 - Mail Merge

19.1 Overview

This example gives a quick demonstration of how the mailmerge features work through the RichEdit
Controls. This will allow you do do any type of form letter while still using all of the features of the
report designer such as subreports. The example shows how to mix a subreport in between two rich
edit controls.

. 1

Contract No: W0128A-06-D-0009 0001
Title:FY06 OMA Pkg A-022 Repan Bldg 405

This contract was awarded on 9/29/2006 for the award contract amount of $1,478.279.00,

The scope of work for said contract 1s:

Renowtimof BBy 405 hiohdes te desgm, den obiin, padrand upmede of offfes and w=tron =. The mnostin upmedes rouies oo plence w it
curenthiuibhg codes ard s, The soope of vak & pedon nently he hernreomsim of the sty portin of febuiHng phisoof AC and
nachrerms. Exenrwod hehdes e mn owlof metand paitng of he exethg sterr=tis, the pboanentof sn egerr feed meelbrerat
therof topAC Rom ard the mpbeamentofdemaged gberg an v idors. T Ethy me sty iepedrbey swee of he builng Enctpert
of hescopeof wok,. Fumniioe ot pertof hescope. Fumines v illbe mroosd by teGommmentand tetele by hecustmers om iecior.

Tlus contract currently has the following 23 features of work.
For the RMS center reference contract IDJ3000861

Award amount 15 $1.478,270.00

Ashestos Abaternent
Ceramic Tile Flooring
Dernalition

Door Hardware
Electrical

Fire Detection/Alarm
Firestopping
GlassiGlazing

Intarinr Qinnana

Skills shown:

- Basic Report Skills

- Using Richtext controls

- How to configure and use mailmerge tags

19.2 Step 1 - Configure a Contract Query

This report will not use a standard template. To begin, just create a query for the contract table as
shown here
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R Query Designer

lFieId » Calos ] Gmup] Search] Sort ] SaL ]
Available Tables

B=1E3

Table T able Name
ACCIDENT ACCIDENT
ACTMITY_DESC  ACTIMITY_DESC
ACTIMITY_PAY_HISACTIMITY_Pay_HI:
ACTIMITY_QA ACTIVITY_O&
ACTIMITY_SCHEDUACTIMITY_SCHEDL

AGEMCY AGEMCY
AGENT AGENT
AHA_HAZARD AHA_HAZARD
AHA_STEP AHA_STEP

ANT_WEATHER  ANT_WEATHER
APPYU_CONTRACIAPPYU_CONTRALC
APPYU_CONTRACIAPPYU_CONTRAL
APPYU_CONTRACIAPPYU_CONTRALC
BASELIME_LIBRARBASELIME_LIBRAR
BASELIME_OFFICE BASELINE_OFFICE
BID BID

BID_CHANGE BID_CHAMGE
BID_CHANGE_OBLIBID_CHAWGE_CBEL

BID_OBLI EID_OBLI
CALEMDAR CALENDAR
CATEGORIES CATEGORIES
CATEGORY CATEGORY

CEFMS_ACCRUAL CEFMS_ACCRUAL
CEFMS_INW_LINE_|CEFMS_IMY_LINE_
CEFMS_INV_LINE_ICEFMS_INv_LINE_

|

Get the following fields

v
Selected Tables [~ Distinct
Tahle Table Mame SOL Aliaz Join Type
CONTRACT COMTRACT CONTRACT
113 | Cancel
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R Query Designer
Tablez Fi3|d Calcs ] Gmup] Search] Sort ] SaL ]
LA Available Fields

Field &lias | Field SOL &lias | Table SOL Alias |
ACO_AGEMT_C.. CONTRACTAC. CONTRACT
ACTIVITY_VARI.. CONTRACTAC. CONTRACT

I8l 3

ACT_PER CONTRACT.AC.. COMTRACT
ACT_PER_LESS.. COWTRACT.AC.. COMNTRACT
ACT_PLCMT COWNTRACT.AC.. COMNTRACT
ACT_TOT COWNTRACT.AC.. COMNTRACT

AE_ADDRESST  CONTRACT.AE..  COMTRACT
AE_ADDRESSZ  COWTRACT.AE..  CONTRACT
AE_ADDRESS3  COWTRACT.AE..  CONTRACT
AE_EVAL ACT CONTRACT.AE.. COMNTRACT
AE_EVal_ RO COWNTRACT.AE.. COMNTRACT
AE_EMAL_SCH COWNTRACT.AE.. CONTRACT

AE_TITLE COMTRACT.AE.. COMNTRACT 2
Selected Fields [~ Al Fields
Field &lias Field SGL Alias Table 5OL Alias

FMT_COMTRACT_DELIWERY  COMTRACT.FM.. COMTRACT

AwARD_COMTRALCT COMTRACT.A..  COMNTRACT

AwD_ACT COMTRACT.A..  COMTRACT

PROJ_MAME COMTRACT.PR.. COMTRACT

PROJ_DS COMTRACT.PR.. COMTRACT

CONTRACT_ID COMTRACT.CO.. CONTRACT

COMST_COMP_SCH COMTRACT.CO.. COMNTRACT ﬂ

113 | Cancel |

Add a calculation using an expression to get the number of featues. We will create a mail merge tag
for it later. Name it and use the expression as shown here:
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R Query Designer k E]E
Tablez ] Figlds ~Cales l Group ] Search ] Sort ] SaL ]

@ Available Fields

Field &lias | Field SOL &lias | Table SOL Alias | ”~

ACO_AGEMT_C... COWTRACT.AC.. CONTRACT

ACTMITY_WaRIL., CONTRACT.AC. CONTRACT B

ACT_PER COWNTRACT.AC.. CONTRACT

ACT_PER_LESS.. CONTRACT.AC.. CONTRACT

ACT_PLCMT COMTRACT.AC.. CONTRACT

ACT_TOT COMTRACT.AC.. CONTRACT

AE_ADDRESST  COMNTRACT.AE.. CONTRACT

AE_ADDRESS2  COMTRACT.AE.. CONTRACT

AE_ADDRESS3 COMTRACT.AE.. CONTRACT

AE_EWAL_ACT COMNTRACT.AE.. COMNTRACT

AE_EWAL RO COMTRACT.AE.. CONTRACT

AE_EWAL_SCH COMTRACT.AE.. CONTRACT

AE_TITLE COMTRACT.AE.. CONTRACT

ALT_REP COWNTRACT.AL..  CONTRACT

ALT_REF2 COMTRACT.AL..  CONTRACT

ALT_REP3 COMTRACT.AL.. CONTRACT

AwdRD_&F DE COMTRACT.A.. COMTRACT

AwaRD_ALLOC., CONTRACT.A..  CONTRACT

AwARD_APPR... CONTRACT.A.  CONTRACT

AwdRD_&UTH... CONTRACT.A.. COMTRACT

&wARD_BID_0.. COMNTRACT.A..  CONTRACT

AwaRD_BID_T... COWNTRACT.A.  CONTRACT

AwARD_BID_V... CONTRACT.A.  CONTRACT

AwaRD_COMTI.. CONTRACT.A.. COMTRACT

AwARD_CONTI.. CONTRACT.A..  CONTRACT v
Calculations

Field Alias Figeld SOL ... | Table SOL Alias Function Expression

v_feature_count  [select couw..  COMTRACT Expression [select count(*] from feature where contract_id=contract, contract_id)

=]
3

19.3 Step 2 - Configure a Fetaure Query

o]

Cancel |

For demonstration, we will include a list of features of work in the report. Configure a second query

using the feature table.
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R Query Designer k BE

lFieIds ] Calcs ] Gmup] Search] Sort ] SaL ]
Available Tables

Table T able Name

ACCIDENT ACCIDENT

ACTMITY_DESC  ACTIMITY_DESC
ACTIMITY_PAY_HISACTIMITY_Pay_HI:

ACTIMITY_QA ACTIVITY_O&
ACTIMITY_SCHEDUACTIMITY_SCHEDL

|

AGEMCY AGEMCY
AGENT AGENT
AHA_HAZARD AHA_HAZARD
AHA_STEP AHA_STEP

ANT_WEATHER  ANT_WEATHER
APPYU_CONTRACIAPPYU_CONTRALC
APPYU_CONTRACIAPPYU_CONTRAL
APPYU_CONTRACIAPPYU_CONTRALC
BASELIME_LIBRARBASELIME_LIBRAR
BASELIME_OFFICE BASELINE_OFFICE
BID BID

BID_CHANGE BID_CHAMGE
BID_CHANGE_OBLIBID_CHAWGE_CBEL

BID_OBLI EID_OBLI
CALEMDAR CALENDAR
CATEGORIES CATEGORIES
CATEGORY CATEGORY

CEFMS_ACCRUAL CEFMS_ACCRUAL
CEFMS_INW_LINE_|CEFMS_IMY_LINE_

CEFMS_INY_LINE_ICEFMS_IMY_LINE _ v
Selected Tables [~ Distinct
Tahle Table Mame SOL Aliaz Join Type

FEATURE FEATURE FEATURE

113 | Cancel

Use these Fields
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R Query Designer

[B Awvailable Fields

Tahbles Fields lEaIcs ] Gmup] Search] Sort ] SaL ]

And sort by the feature title as shown here

Field Alias | Field SAL #lias | Table SOL Alas |

FEATURE_ID FEATURE.FEA.. FEATURE

FIMISHED FEATURE.FIMI... FEATURE

FIMISH_DATE FEATURE.FIMI... FEATURE

FIRST_ACTDS FEATURE.FIRS.. FEATURE

FIRST_aCTID FEATURE.FIRS.. FEATURE

FOLLOW _COUMT FEATURE.FOLL.. FEATURE

GOW_STATUS FEATURE.GOY.. FEATURE

HAZARD_ACCE.. FEATUREHAZ. FEATURE

HaZaRD_ACCE.. FEATURE.H&Z.. FEATURE

HAZARD_COMP.. FEATURE.HAZ.. FEATURE

HAZARD_COMT... FEATUREHAZ.  FEATURE

HAZARD_EQUI.. FEATUREHAZ. FEATURE

HaZaRD_EXPO... FEATURE.H&Z.. FEATURE

HAZARD_GOW_... FEATUREHAZ..  FEATURE

HAZARD_GOW_... FEATUREHAZ. FEATURE

H&ZaRD_INSP... FEATURE.H&Z.. FEATURE

H&ZaRD_TRAL. FEATUREH&Z.. FEATURE

IMIT_AFTER FEATURE.IMIT... FEATURE

IMIT_COUMNT FEATURE.IMIT... FEATURE

PREP_COUNT FEATURE.PRE.. FEATURE

GAYERSION FEATURE.Q&Y...  FEATURE

QCYERSION FEATURE.QCY.. FEATURE

STARTED FEATURE.STA.. FEATURE

START_DATE FEATURE.STA.. FEATURE

Selected Fields [ AllFields

Field Alias Field SOL Alias Table SOL Alias

FEATURE FEATURE.FEA.. FEATURE

COMTRACT_ID FEATURE.COM... FEATURE ﬂ

=]

Ok | Cancel |
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R Query Designer QE

Tables] Fields ] Calcs ] lk' p] Search Sort ISQL ]
£ twailable Fields

Field &lias | Field SOL Alias | Table SOL &lias |
CONTRACT_ID FEATURE.COM.. FEATLRE
FEATURE FEA..  FEATURE
FIMISHED FEATUREFINI.  FEATURE
FINISH_DATE FEATUREFINL.  FEATURE
FIRST_ACTDS FEATURE FIRS.. FEATLIRE
FIRST_ACTID FEATURE FIRS.. FEATLIRE
FOLLOW_COUNT FEATURE FOLL.. FEATURE
GOV_STATUS FEATURE GOV.. FEATURE

HAZARD_ACCEPTED  FEATUREHAZ..  FEATURE
HAZARD_ACCEPTED.. FEATUREHAZ.. FEATURE
HaZARD_COMPLETED FEATUREHAZ..  FEATURE
HAZARD_CONT_WER.. FEATUREHAZ.. FEATURE
HaZARD_EGQUIPMEMT  FEATURE HAZ..  FEATURE
HAZARD_EXPORTED  FEATUREHAZ..  FEATURE
H&ZARD_GOW_MEMO  FEATURE HAZ..  FEATURE
H&ZARD_GOY_WERS.. FEATUREHAZ. FEATURE
HAZARD_IMSPECTION FEATUREHAZ..  FEATURE
HAZARD_TRAIMING FEATUREHAZ..  FEATURE

INIT_AFTER FEATURE.INIT...  FEATURE

INIT_COUMNT FEATURE.IMIT... FEATURE

PREP_COUNT FEATURE.PRE... FEATURE

QaVYERSION FEATURE.Q&Y..  FEATURE

QCYERSION FEATURE.QCY.. FEATURE

STARTED FEATURE.STA..  FEATURE

START_DATE FEATURE.STA..  FEATURE

Sort Fields I~ Matural Order
Field Alias Field SOL Alias Table SOL Alias Desc(z > a)

FEATURE FEATURE.FEA..  FEATURE

-]
=]

113 | Cancel |

Finally link the two queries as shown here:
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File:
Data ICaIc: IDesignl F'reviewl
FEATURE linked to CONTRACT
b EmaTqs | 3 b @ mE T Qs
M ame | Type Type Size
LB FMT_COMTRACT_DELIVE Stritg FEATURE String a0
[[] &wARD_COWTRACT  Double 22 ([ COMTRACT_I Sting 25
[ &wD_ACT DateTime
Q] PROJ_NAME Shing
[[ PROJ_DS Shing
[[l] CONTRACT_ID String
[ CONST_COMP_SCH  DeteTime
LB v_Ffeature_count Couble
Ready. A
19.4 Step 3 - Configure the Design with Richtext and Subreport

controls

Switch to the design tab and put a richtext control at the top of the design band, then a subreport, then
another richtext control as shown here. Turn off all of the other bands.

Add a group (Report > Groups) by contract ID and set it to start on a new page. This will make each

form letter begin a new page.
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19.5

19.6

File Edit W%iew Report™ Help

Data ICaIc DESiinF'reviewl

h ABEuEdHfe)l Ao AEREELOG® EEME

| | [arial = ~ | B r u|

(-4 -==BE | mw 88 | ow Ba&sS | Tad | wei | WE
i N A S - R - S N R

D&

|7

DN

* Group Footed0]: CONTRACT_ID

< 1] ] )

% Main: CONTRACT 4 SubReportt FEATURE /

Ready, Left: 0 [Top: 0 [width: 0 Height: 0 4

Step 4 - Configure the Richtext controls for mailmerge, and
stretch and setup the shift relative to

Right click on each of the Richtext controls and turn on mailmerge. Also be sure to set stretch on and
finally configure the three design components to shoft relatice to each other appropriately.

Step 5 - Add Some Mail Merge Text

Right click on the first richtext control and select Edit. The richtext editor with mailmerge appears.
Enter some text as shown below to try out the mail merge options. Note that you can use the Fields
list on the right along with the displayformat and then click on add and the appropriate tag will be
added for you. You can also manually type the field name in with brackets.

You can use an valid richtext formatting including indenting, font size, bold, italics and color
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R Rich Text Editor (=13
Fie Edt 3
= B |Times Mew Roman j|12 i‘ B /7 U | = = £ iz [ il Merge
* i i i i i i i i 1 i i i i i i i |5 CONTRACT
FEATURE

Contract No: <Fi{T COMNTRACT DELIVERY=
Title:<PROJ_MNAME=

Fields far CONTRACT

Mame | Type
LB &WARD_CONTRACT Double

This contract was awarded on <AWD_ACT= for the award contract amount of <dbtext

datapipeline="COMNTRACT' displayformat="§0 00'=AWARD CONTEACT=/dbtext>. [ WD _ACT DateTime
(Bl COMST_COMP_SCH  DateTime
The scope of work for said contract is: [l COMTRACT_ID Shring
[BIFMT_CONTRACT_..  Sting
<PROJ_DS> [l PROJ_DS String
PROJ_MAME St
This contract currently has the following <V_FEATURE COUNT= features of worle, EE} v festure count D::Ele
£ | >
For the BIMS center reference contract [D<dbtext>CONTEACT ID</dbtext> = =
| Dizplay Farmat

Add Field

Row: 15 Coli 1 Modified

19.7 Step 6 - Configure the subreport
Configure the subreport to list out the features as shown here:

Make sure to set the data pipeline to FEATURE
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File Edit %ew Report Help

Data ICaIc DESiinF'reviewl

h ABEuEdHfe)l Ao AEREELOG® EEME

| | [arial = ~ | B r u|

(b -S-=m=|0E me |8 or|Ra&d Dok o | GWME DS
£ T 1 . I L S CRR

* Detai

= i ] 3
\Fain: CONTRALCT ) SubFeportl: FE."-\TUFEE,(
Ready, Left: 0 Top: 0 [width: 0 Height: 0 4

19.8 Step 7 - Add some Richtext for the summary section

Finally, to show how the subreport can be embedded in the middle of the formletter, add some richtext
for the second richtext control
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R Rich Text Editor 9((=(E3
Fle Edt 3
=EES B |TimesNewF|0man j|12 i‘ B /7 U | = = £ iz [ il Merge
— | | | | | | | : | | | | | | | = CONTRACT
| FEATURE
In summary, please follow all mstructions as included i the contract. Your contract completion date is
heduled for <dbtext displ =" d 2CONET COMP_SCHs</dbtext>.
scheduled for =dbtext displayformat="mmam d, yyyy - - ® Fields for CONTRACT
Mame | Type
[B &waRD_CONTRACT Double
[B) &wD_acT DateTime
(Bl COMST_COMP_SCH  DateTime
Bl COMTRACT_ID Shing
B FMT_CONTRACT_..  Shing
[Bl PROJ_DS Sting
LBl PROJ_MAME String
[l v_feature_count Double
4 | ¥

Dizplay Farmat

Add Field

Row: 1 Coli 1

19.9 Summary

This example shows how to use richtext and mailmerge. The mailmerge is a powerful feature that
gives you access to all fields. Also you can still mix in all of the other report designer options like
subreports.
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